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PREFACE

Approach Elementary Statistics: A Step by Step Approach was written as an aid in the beginning sta-
tistics course to students whose mathematical background is limited to basic algebra. The
book follows a nontheoretical approach without formal proofs, explaining concepts intu-
itively and supporting them with abundant examples. The applications span a broad range
of topics certain to appeal to the interests of students of diverse backgrounds, and they in-
clude problems in business, sports, health, architecture, education, entertainment, politi-
cal science, psychology, history, criminal justice, the environment, transportation, physi-
cal sciences, demographics, eating habits, and travel and leisure.

About ThlS While a number of important changes have been made in the ninth edition, the learning
system remains untouched and provides students with a useful framework in which to
BOOk learn and apply concepts. Some of the retained features include the following:

Elementary Statistics

Over 1800 exercises are located at the end of major sections within each chapter.
Hypothesis-Testing Summaries are found at the end of Chapter 9 (z, t, ¥, and
F' tests for testing means, proportions, and variances), Chapter 12 (correlation,
chi-square, and ANOVA), and Chapter 13 (nonparametric tests) to show students
the different types of hypotheses and the types of tests to use.

A Data Bank listing various attributes (educational level, cholesterol level, gender,
etc.) for 100 people and several additional data sets using real data are included and
referenced in various exercises and projects throughout the book.

An updated reference card containing the formulas and the z, 7, x*, and PPMC

tables is included with this textbook.

End-of-chapter Summaries, Important Terms, and Important Formulas give stu-

dents a concise summary of the chapter topics and provide a good source for quiz or

test preparation.

Review Exercises are found at the end of each chapter.

* Special sections called Data Analysis require students to work
with a data set to perform various statistical tests or procedures
and then summarize the results. The data are included in the Data
Bank in Appendix B and can be downloaded from the book’s

A STEP BY STEP APPROACH

website at www.mhhe.com/bluman.

* Chapter Quizzes, found at the end of each chapter, include
multiple-choice, true/false, and completion questions along with
exercises to test students’ knowledge and comprehension of
chapter content.

* The Appendixes provide students with extensive reference tables,
a glossary, and answers to all quiz questions and odd-numbered
exercises. New to this edition, the additional Online Appendixes
include algebra review, an outline for report writing, Bayes’
theorem, and an alternative method for using the standard normal
distribution. These can be found at www.mhhe.com/bluman.

* The Applying the Concepts feature is included in all sections
and gives students an opportunity to think about the new concepts
and apply them to examples and scenarios similar to those found
in newspapers, magazines, and radio and television news
programs.
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Changes in the Global Changes

Ninth Edition « Updated and redesigned the Technology Boxes to reflect the latest technology updates

* Over 60 new examples and more than 400 new exercises have been added or revised
throughout the book

* Design of graphs, photos and art has been revised for clarity
* New interior design was incorporated for ease of reading and flow

Matched the odd and even exercises

Chapter 1  Nearly 100 new section exercises have been added
Statistics Today updated
Added new material on sampling and the three types of observational studies

Chapter 2 New subsection on dotplots added
More material on class boundaries added
Statistics Today updated

Chapter 3 New Procedure Table for median added
New Procedure Table for variance and standard deviation added
Summary for Chebyshev’s Theorem added
New procedure Table for boxplots included

Chapter 4 New subsection for permutations with identical objects added
Chapter 5 New subsection on the geometric probability distribution added

Chapter 6 Improved flow with a shortened introduction
Added New Procedure Table for finding data values for specific probabilities

Chapter 7  Statistics Today updated
Included summary of the Characteristics of the Chi-Square Distribution

Chapter 8 Reorganized Section 8-1 for a better flow
Simplified diagram on stating the conclusion from a hypothesis test

Chapter 9  Expanded explanation of independent samples
Added 20 new exercises

Chapter 10 Statistics Today updated
Revised and Shortened Introduction
Added additional information on analyzing scatter plots
Included six new Procedure Tables

Chapter 11 Expanded explanation on finding expected frequencies

Chapter 12 Added additional material on the Computation of the F test
Added two new figures

Chapter 13 Boxed definitions and listed assumptions for the nonparametric tests
Added a new Procedure Table for finding and testing the significance of
the Spearman’s Rank Correlation Coefficient
Added a new Procedure Table for the runs test

Chapter 14 Added a formal definition for convenience sample
Improved definitions for systematic sampling and stratified sampling
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A STEP BY STEP APPROACH

Each chapter begins with an outline, a
list of learning objectives, and a feature
titled Statistics Today; in which a real-life
problem shows students the relevance of
the material. This problem is solved near
the end of the chapter using statistical
techniques presented in the chapter.

Confidence Intervals
and Sample Size

= STATISTICS TODAY
Stress and the College Student

A recent poll conducted by the mtvU/Associated Press found that
85% of college students reported that they experience stress daily.
The study said, “It is clear that being stressed is a fact of life on col-
lege campuses today.”

The study also reports that 74% of students’ stress comes from
school work, 71% from grades, and 62% from financial woes. The
report stated that 2240 undergraduate students were selected and
that the poll has a margin of error of +3.0%.

In this chapter you will learn how to make a true estimate of a
parameter, what is meant by the margin of error, and whether or not
the sample size was large enough to represent all college students.

See Statistics Today—Revisited at the end of this chapter for

OUTLINE

Introduction

71

7-2

7-3

7-4

Confidence Intervals for the Mean When
o Is Known

Confidence Intervals for the Mean When
o Is Unknown

Confidence Intervals and Sample Size for
Proportions

Confidence Intervals for Variances and
Standard Deviations

Summary

OBJECTIVES

After completing this chapter, you should be able to

Find the confidence interval for the mean
when o is known.

Determine the minimum sample size for
finding a confidence interval for the mean.

Find the confidence interval for the mean
when ¢ is unknown

Find the confidence interval for a proportion.
Determine the minimum sample size for
finding a confidence interval for a
proportion.

Find a confidence interval for a variance and
a standard deviation.
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Critical Thinking sections at the end of
each chapter challenge students to
apply what they have learned to new
situations while deepening conceptual
understanding.

Applying the Concepts are end-of-
section exercises that reinforce the con-
cepts explained in the section. They give 1. Hoy,
students an opportunity to think about
the concepts and apply them to hypo-
thetical examples similar to real-life ones.
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== Critical Thinking Challenges

The power of a test (I — 3) can be calculated when a
specific value of the mean is hypothesized in the alternative
hypothesis; for example, let Hy: w = 50 and let H: u = 52.
To find the power of a test, it is necessary to find the value
of B. This can be done by the following steps:

Step 1 For a specific value of « find the corresponding

2 raopinm

, Where w 1s the
a/Vn &
hypothesized value given in Hy. Use a right-tailed
test.

value of X, using z =

-

- p\e* oY
A o O

)

Using the value of X found in step 1 and the
value of u in the alternative hypothesis,
find the area corresponding to z in the

Step 2

Rommihy = 2l

ormulaz = ——~.

a/Vn

Subtract this area from 0.5000. This is the value
of B.

Subtract the value of B from 1. This will give you
the power of a test. See Figure 8—41.

Step 3

Step 4

Technology Step by Step
boxes instruct students how to
use Excel, TI-84 Plus graphing
calculators, and MINITAB to
solve the types of problems
covered in the section. Numer-
ous computer or calculator
screens are displayed as well
as numbered steps.
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Data Projects, which appear at the
end of each chapter, further chal-
lenge students’ understanding and
application of the material pre-
sented in the chapter. Many of
these require the student to gather,
analyze, and report on real data.
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- | Comqect sus. McGraw-Hill conducted in-depth research to create a new learning experience that meets
MATH the needs of students and instructors today. The result is a reinvented learning experience
A rich in information, visually engaging, and easily accessible to both instructors and

students.

* McGraw-Hill’s Connect is a Web-based assignment and assessment platform that
helps students connect to their coursework and prepares them to succeed in and
beyond the course.

» Connect enables math and statistics instructors to create and share courses and
assignments with colleagues and adjuncts with only a few clicks of the mouse.
All exercises, learning objectives, and activities are vetted and developed by math
instructors to ensure consistency between the textbook and the online tools.

* Connect also links students to an interactive eBook with access to a variety of
media assets and a place to study, highlight, and keep track of class notes.

To learn more, contact your sales rep or visit www.connectmath.com.

ALE I(S® ALEKS is a Web-based program that uses artificial intelligence to assess a student’s
knowledge and provide personalized instruction on the exact topics the student is most
ready to learn. By providing individualized assessment and learning, ALEKS helps stu-
dents to master course content quickly and easily. ALEKS allows students to easily move
between explanations and practice, and it provides intuitive feedback to help students cor-
rect and analyze errors. ALEKS also includes a powerful instructor module that simplifies
course management so instructors spend less time with administrative tasks and more
time directing student learning.

ALEKS 360 is a new cost-effective total course solution: fully integrated, interactive
A LE KS”‘"{'-,') eBook, including lecture and exercise videos tied to the textbook, combined with ALEKS
e personalized assessment and learning.
To learn more about ALEKS and ALEKS 360, contact your sales rep or visit
www.aleks.com.

BLEARNSMART Give students the tools they need. Right when they need them. McGraw-Hill
LearnSmart adaptively assesses students’ skill levels to determine which topics students
have mastered and which require further practice. Then it delivers customized learning
content based on their strengths and weaknesses. The result: students learn faster and
more efficiently because they get the help they need, right when they need it—instead of
getting stuck on lessons or being continually frustrated with stalled progress.

BSMARTBOOK" SmartBook is the first and only adaptive reading experience available for the higher
education market. Powered by the intelligent and adaptive LearnSmart engine, Smart-
Book facilitates the reading process by identifying what content a student knows and
doesn’t know. As a student reads, the material continuously adapts to ensure the student
is focused on the content he or she needs the most to close specific knowledge gaps.

t w  With McGraw-Hill Create™, you can easily rearrange chapters, combine material from
m Crea e other content sources, and quickly upload content you have written such as your course
syllabus or teaching notes. Find the content you need in Create by searching through

Xiv



Supplements XV

thousands of leading McGraw-Hill textbooks. Arrange your book to fit your teaching style.
Create even allows you to personalize your book’s appearance by selecting the cover and
adding your name, school, and course information. Assemble a Create book, and you’ll
receive a complimentary print review copy in 3-5 business days or a complimentary
electronic review copy (eComp) via email in minutes. Go to www.mcgrawhillcreate
.com today and experience how McGraw-Hill Create™ empowers you to teach your stu-
dents your way.

Instructor’s Testing and Resource Online

This computerized test bank, available online to adopting instructors, utilizes TestGen®
cross-platform test generation software to quickly and easily create customized exams.
Using hundreds of test items taken directly from the text, TestGen allows rapid test cre-
ation and flexibility for instructors to create their own questions from scratch with the
ability to randomize number values. Powerful search and sort functions help quickly
locate questions and arrange them in any order, and built-in mathematical templates let in-
structors insert stylized text, symbols, graphics, and equations directly into questions
without need for a separate equation editor.

MegaStat®

MegaStat® is a statistical add-in for Microsoft Excel, handcrafted by J. B. Orris of Butler
University. When MegaStat is installed, it appears as a menu item on the Excel menu
bar and allows you to perform statistical analysis on data in an Excel workbook. The
MegaStat plug-in can be purchased at www.mhhe.com/megastat.

MINITAB Student Release 14

The student version of MINITAB statistical software is available with copies of the text.
Ask your McGraw-Hill representative for details.

SPSS Student Version for Windows

A student version of SPSS statistical software is available with copies of this text. Con-
sult your McGraw-Hill representative for details.

MINITAB 14 Manual

This manual provides the student with how-to information on data and file management,
conducting various statistical analyses, and creating presentation-style graphics while fol-
lowing each text chapter.

TI-84 Plus Graphing Calculator Manual

This friendly, practical manual teaches students to learn about statistics and solve prob-
lems by using these calculators while following each text chapter.

Excel Manual

This workbook, specially designed to accompany the text, provides additional practice in
applying the chapter concepts while using Excel.

Instructor’s Solutions Manual (instructors only)

By Sally Robinson of South Plains College, this manual includes worked-out solutions to
all the exercises in the text and answers to all quiz questions. This manual can be found
online at www.mhhe.com/bluman.

Student’s Solutions Manual

By Sally Robinson of South Plains College, this manual contains detailed solutions to all
odd-numbered text problems and answers to all quiz questions.
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The Nature
of Probability
nd Statistics

= STATISTICS TODAY
Is Higher Education “Going Digital”?

Today many students take college courses online and use eBooks.
Also, many students use a laptop, smartphone, or computer tablet in
the classroom. With the increased use of technology, some ques-
tions about the effectiveness of this technology have been raised.
For example,

How many colleges and universities offer online courses?

Do students feel that the online courses are equal in value to
the traditional classroom presentations?

Approximately how many students take online courses now?

Will the number of students who take online courses increase
in the future?

Has plagiarism increased since the advent of computers and
the Internet?

Do laptops, smartphones, and tablets belong in the
classroom?

Have colleges established any guidelines for the use of laptops,
smartphones, and tablets?

To answer these questions, Pew Research Center conducted a
study of college graduates and college presidents in 2011. The pro-
cedures they used and the results of the study are explained in this
chapter. See Statistics Today—Revisited at the end of the chapter.

OUTLINE

Introduction

1-1
1-2
1-3
1-4
1-5

Descriptive and Inferential Statistics
Variables and Types of Data

Data Collection and Sampling Techniques
Experimental Design

Computers and Calculators

Summary

OBJECTIVES

After completing this chapter, you should be able to

© © 00 600 OO0

Demonstrate knowledge of statistical terms.

Differentiate between the two branches of
statistics.

Identify types of data.

Identify the measurement level for each
variable.

Identify the four basic sampling techniques.

Explain the difference between an
observational and an experimental study.

Explain how statistics can be used and
misused.

Explain the importance of computers and
calculators in statistics.



2 Chapter 1 The Nature of Probability and Statistics

IUnusual Stats

Of people in the United
States, 14% said that
they feel happiest in
June, and 14% said that
they feel happiest in
December.

Interesting Fact

Every day in the United
States about 120 golfers
claim that they made a
hole-in-one.

I Historical Note

A Scottish landowner and
president of the Board of
Agriculture, Sir John
Sinclair introduced the
word statistics into the
English language in

the 1798 publication of
his book on a statistical
account of Scotland. The
word statistics is derived
from the Latin word
Status, which is loosely
defined as a statesman.

Introduction

You may be familiar with probability and statistics through radio, television, newspapers,
and magazines. For example, you may have read statements like the following found in
newspapers.

* The FBI reported that violent crimes were down by 6.4% in 2011.

* USA TODAY reported that the average college graduate student loan debt was about
$19,000.

* The College Stress and Mental Illness Poll reported that 85% of college and
university students reported feeling stress daily; 77% reported stress from school
work, and 74% experienced stress from grades.

* The Occupational Outlook Handbook reported that the median hourly wage for a
registered nurse was $31.10 per hour.

* Reader’s Digest reported that the average cost of using a plasma television is
$0.1152 per hour.

* In 2013, the number of sales of smartphones is estimated to be 832.5 million units
globally.

Statistics is used in almost all fields of human endeavor. In sports, for example, a stat-
istician may keep records of the number of yards a running back gains during a football
game, or the number of hits a baseball player gets in a season. In other areas, such as pub-
lic health, an administrator might be concerned with the number of residents who contract
a new strain of flu virus during a certain year. In education, a researcher might want to
know if new methods of teaching are better than old ones. These are only a few examples
of how statistics can be used in various occupations.

Furthermore, statistics is used to analyze the results of surveys and as a tool in scien-
tific research to make decisions based on controlled experiments. Other uses of statistics
include operations research, quality control, estimation, and prediction.

Statistics is the science of conducting studies to collect, organize, summarize,
analyze, and draw conclusions from data.

Students study statistics for several reasons:

1. Like professional people, you must be able to read and understand the various sta-
tistical studies performed in your fields. To have this understanding, you must be
knowledgeable about the vocabulary, symbols, concepts, and statistical procedures
used in these studies.

2. You may be called on to conduct research in your field, since statistical procedures
are basic to research. To accomplish this, you must be able to design experiments;
collect, organize, analyze, and summarize data; and possibly make reliable predic-
tions or forecasts for future use. You must also be able to communicate the results
of the study in your own words.

3. You can also use the knowledge gained from studying statistics to become better
consumers and citizens. For example, you can make intelligent decisions about
what products to purchase based on consumer studies, about government spending
based on utilization studies, and so on.

These reasons can be considered some of the goals for studying statistics.
It is the purpose of this chapter to introduce the goals for studying statistics by
answering questions such as the following:

What are the branches of statistics?
What are data?

How are samples selected?
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Descriptive and Inferential Statistics

OBJECTIVE @

Demonstrate knowledge
of statistical terms.

I Historical Note

The 1880 Census had
S0 many questions on it
that it took 10 years to
publish the results.

I Historical Note

The origin of descriptive
statistics can be traced to
data collection methods
used in censuses taken
by the Babylonians and
Egyptians between 4500
and 3000 B.c. In addi-
tion, the Roman Emperor
Augustus (278.c.—A.D.17)
conducted surveys

on births and deaths

of the citizens of the
empire, as well as the
number of livestock each
owned and the crops
each citizen harvested
yearly.

OBJECTIVE @

Differentiate between the
two branches of statistics.

FIGURE 1-1
Population and Sample

Population

To gain knowledge about seemingly haphazard situations, statisticians collect informa-
tion for variables, which describe the situation.

A variable is a characteristic or attribute that can assume different values.

Data are the values (measurements or observations) that the variables can assume.
Variables whose values are determined by chance are called random variables.

Suppose that an insurance company studies its records over the past several years and de-
termines that, on average, 3 out of every 100 automobiles the company insured were involved
in accidents during a 1-year period. Although there is no way to predict the specific automo-
biles that will be involved in an accident (random occurrence), the company can adjust its
rates accordingly, since the company knows the general pattern over the long run. (That is, on
average, 3% of the insured automobiles will be involved in an accident each year.)

A collection of data values forms a data set. Each value in the data set is called a data
value or a datum.

In statistics it is important to distinguish between a sample and a population.

A population consists of all subjects (human or otherwise) that are being studied.

When data are collected from every subject in the population, it is called a census.

For example, every 10 years the United States conducts a census. The primary purpose
of this census is to determine the apportionment of the seats in the House of Representatives.

The first census was conducted in 1790 and was mandated by Article 1, Section 2 of the
Constitution. As the United States grew, the scope of the census also grew. Today the Census
limits questions to populations, housing, manufacturing, agriculture, and mortality. The Cen-
sus is conducted by the Bureau of the Census, which is part of the Department of Commerce.

Most of the time, due to the expense, time, size of population, medical concerns, etc.,
it is not possible to use the entire population for a statistical study; therefore, researchers
use samples.

A sample is a group of subjects selected from a population.

If the subjects of a sample are properly selected, most of the time they should possess
the same or similar characteristics as the subjects in the population. See Figure 1-1.

However, the information obtained from a statistical sample is said to be biased if the
results from the sample of a population are radically different from the results of a census
of the population. Also, a sample is said to be biased if it does not represent the popula-
tion from which it has been selected. The techniques used to properly select a sample are
explained in Section 1-3.

The body of knowledge called statistics is sometimes divided into two main areas,
depending on how data are used. The two areas are

1. Descriptive statistics
2. Inferential statistics

Descriptive statistics consists of the collection, organization, summarization, and
presentation of data.

In descriptive statistics the statistician tries to describe a situation. Consider the national
census conducted by the U.S. government every 10 years. Results of this census give you
the average age, income, and other characteristics of the U.S. population. To obtain this
information, the Census Bureau must have some means to collect relevant data. Once data
are collected, the bureau must organize and summarize them. Finally, the bureau needs a
means of presenting the data in some meaningful form, such as charts, graphs, or tables.

1-3
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I Historical Note

Inferential statistics
originated in the 1600s,
when John Graunt pub-
lished his book on popu-
lation growth, Natural
and Political Observa-
tions Made upon the
Bills of Mortality. About
the same time, another
mathematician/
astronomer, Edmond
Halley, published the first
complete mortality
tables. (Insurance
companies use mortality
tables to determine life
insurance rates.)

IUnusual ﬁ

Twenty-nine percent of
Americans want their
boss’s job.

The second area of statistics is called inferential statistics.

Inferential statistics consists of generalizing from samples to populations, perfor-
ming estimations and hypothesis tests, determining relationships among variables,
and making predictions.

Here, the statistician tries to make inferences from samples to populations. Inferential sta-
tistics uses probability, i.e., the chance of an event occurring. You may be familiar with
the concepts of probability through various forms of gambling. If you play cards, dice,
bingo, or lotteries, you win or lose according to the laws of probability. Probability
theory is also used in the insurance industry and other areas.

The area of inferential statistics called hypothesis testing is a decision-making
process for evaluating claims about a population, based on information obtained from
samples. For example, a researcher may wish to know if a new drug will reduce the num-
ber of heart attacks in men over age 70 years of age. For this study, two groups of men
over age 70 would be selected. One group would be given the drug, and the other would
be given a placebo (a substance with no medical benefits or harm). Later, the number of
heart attacks occurring in each group of men would be counted, a statistical test would be
run, and a decision would be made about the effectiveness of the drug.

Statisticians also use statistics to determine relationships among variables. For ex-
ample, relationships were the focus of the most noted study in the 20th century, “Smok-
ing and Health,” published by the Surgeon General of the United States in 1964. He
stated that after reviewing and evaluating the data, his group found a definite relationship
between smoking and lung cancer. He did not say that cigarette smoking actually causes
lung cancer, but that there is a relationship between smoking and lung cancer. This con-
clusion was based on a study done in 1958 by Hammond and Horn. In this study,
187,783 men were observed over a period of 45 months. The death rate from lung can-
cer in this group of volunteers was 10 times as great for smokers as for nonsmokers.

Finally, by studying past and present data and conditions, statisticians try to make
predictions based on this information. For example, a car dealer may look at past sales
records for a specific month to decide what types of automobiles and how many of each
type to order for that month next year.

EXAMPLE 1-1

Determine whether descriptive or inferential statistics were used.

Descriptive or Inferential Statistics

a. The average jackpot for the top five lottery winners was $367.6 million.

b. A study done by the American Academy of Neurology suggests that older people
who had a high caloric diet more than doubled their risk of memory loss.

c. Based on a survey of 9317 consumers done by the National Retail Federation, the
average amount that consumers spent on Valentine’s Day in 2011 was $116.

d. Scientists at the University of Oxford in England found that a good laugh signifi-
cantly raises a person’s pain level tolerance.

SOLUTION

a. Descriptive statistics were used because this is an average, and it is based on data
obtained from the top five lottery winners at this time.

b. Inferential statistics were used since this is a generalization made from a sample
to a population.

c. Descriptive statistics were used since this is an average based on a sample of
9317 respondents.

d. Inferential statistics were used since an inference is made from a sample to a
population.
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== Applying the Concepts 1-1

Attendance and Grades

Read the following on attendance and grades, and answer the questions.

A study conducted at Manatee Community College revealed that students who attended class
95 to 100% of the time usually received an A in the class. Students who attended class 80 to 90%
of the time usually received a B or C in the class. Students who attended class less than 80% of the
time usually received a D or an F or eventually withdrew from the class.

I_ — Based on this information, attendance and grades are related. The more you attend class, the more

Unusual Stat likely it is you will receive a higher grade. If you improve your attendance, your grades will probably
Only one-third of crimes improve. Many factors affect your grade in a course. One factor that you have considerable control
committed are reported over is attendance. You can increase your opportunities for learning by attending class more often.
to the police. 1. What are the variables under study?

2. What are the data in the study?

3. Are descriptive, inferential, or both types of statistics used?

4. What is the population under study?

5. Was a sample collected? If so, from where?

6. From the information given, comment on the relationship between the variables.

See page 39 for the answers.

1. Define statistics. 11. In 2011, there were 34 deaths from the avian flu.
(Source: World Health Organization)

2. What is a variable? 12. Based on a sample of 2739 respondents, it is
estimated that pet owners spent a total of 14 billion
3. What is meant by a census? dollars on veterinarian care for their pets.

(Source: American Pet Products Association, Pet
Owners Survey)

13. In 2011, 79% of U.S. adults used the Internet. (Source:
Pew Research Center)

4. How does a population differ from a sample?

5. Explain the difference between descriptive and inferen-
tial statistics. 14. In 2010, a total of 68,905 people died from diabetes.

6. Name two areas where probability is used (Source: Centers for Disease Control and Prevention)

15. In an online survey of 500 Virginia Tech students
between spring 2010 and spring 2011, 31% said that
they had missed class because of alcohol consumption.

7. Why is information obtained from samples used more
often than information obtained from populations?

8. What is meant by a biased sample? (Source: Center for Applied Behavior Systems at
Virginia Tech)
For Exercises 9—17, determine whether descriptive or
inferential statistics were used. 16. In 2008-20009, a total of 260,327 U.S. students were
studying abroad. (Source: Institute of International

9. Because of the current economy, 49% of 18 to 34 year-
olds have taken a job to pay the bills. (Source: Pew
Research Center) 17. Forty-four percent of the people in the United States

have type O blood. (Source: American Red Cross)

Education)

10. In 2025, the world population is predicted to be 8 billion
people. (Source: United Nations)
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== Extending the Concepts

18. Find three statistical studies and explain whether they 19. Find a gambling game and explain how probability was

used descriptive or inferential statistics. used to determine the outcome.

1-2

Variables and Types of Data

OBJECTIVE @
Identify types of data.

As stated in Section 1-1, statisticians gain information about a particular situation by col-
lecting data for random variables. This section will explore in greater detail the nature of
variables and types of data.

Variables can be classified as qualitative or quantitative.

Qualitative variables are variables that have distinct categories according to some
characteristic or attribute.

For example, if subjects are classified according to gender (male or female), then the vari-
able gender is qualitative. Other examples of qualitative variables are religious preference
and geographic locations.

Quantitative variables are variables that can be counted or measured.

For example, the variable age is numerical, and people can be ranked in order according
to the value of their ages. Other examples of quantitative variables are heights, weights, and
body temperatures.

Quantitative variables can be further classified into two groups: discrete and contin-
uous. Discrete variables can be assigned values such as 0, 1, 2, 3 and are said to be count-
able. Examples of discrete variables are the number of children in a family, the number of
students in a classroom, and the number of calls received by a switchboard operator each
day for a month.

Discrete variables assume values that can be counted.

Continuous variables, by comparison, can assume an infinite number of values in an
interval between any two specific values. Temperature, for example, is a continuous vari-
able, since the variable can assume an infinite number of values between any two given
temperatures.

Continuous variables can assume an infinite number of values between any two
specific values. They are obtained by measuring. They often include fractions and
decimals.

The classification of variables can be summarized as follows:

Variables

Qualitative Quantitative

Discrete Continuous
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Fifty-two percent of
Americans live within
50 miles of a coastal
shoreline.
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EXAMPLE 1-2 Discrete or Continuous Variables
Classify each variable as a discrete variable or a continuous variable.

a. The highest wind speed of a hurricane
b. The weight of baggage on an airplane
c. The number of pages in a statistics book

d. The amount of money a person spends per year for online purchases

SOLUTION

a. Continuous, since wind speed must be measured
b. Continuous, since weight is measured
c. Discrete, since the number of pages is countable

d. Discrete, since the smallest value that money can assume is in cents

Since continuous data must be measured, answers must be rounded because of the
limits of the measuring device. Usually, answers are rounded to the nearest given unit. For
example, heights might be rounded to the nearest inch, weights to the nearest ounce, etc.
Hence, a recorded height of 73 inches could mean any measure from 72.5 inches up to but
not including 73.5 inches. Thus, the boundary of this measure is given as 72.5-73.5 inches.
The boundary of a number, then, is defined as a class in which a data value would be
placed before the data value was rounded. Boundaries are written for convenience as
72.5-73.5 but are understood to mean all values up to but not including 73.5. Actual data
values of 73.5 would be rounded to 74 and would be included in a class with boundaries
of 73.5 up to but not including 74.5, written as 73.5-74.5. As another example, if a
recorded weight is 86 pounds, the exact boundaries are 85.5 up to but not including 86.5,
written as 85.5-86.5 pounds. Table 1-1 helps to clarify this concept. The boundaries of a
continuous variable are given in one additional decimal place and always end with the
digit 5.

TABLE 1-1 Recorded Values and Boundaries

Variable Recorded value Boundaries
Length 15 centimeters (cm) 14.5-15.5cm
Temperature 86 degrees Fahrenheit (°F) 85.5-86.5°F
Time 0.43 second (sec) 0.425-0.435 sec
Mass 1.6 grams (g) 1.55-1.65¢

EXAMPLE 1-3 Class Boundaries

Find the boundaries of each variable.

a. 8.4 quarts
b. 138 mmHg
¢. 137.63 mg/dL

a. 8.35-8.45 quarts

b. 137.5-138.5 mmHg

c. 137.625-137.635 mg/dL
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OBJECTIVE @

Identify the measurement
level for each variable.

IUnusual ﬁ

Sixty-three percent of us
say we would rather
hear the bad news first.

I Historical Note

When data were first
analyzed statistically

by Karl Pearson and
Francis Galton, almost all
were continuous data. In
1899, Pearson began to
analyze discrete data.
Pearson found that some
data, such as eye color,
could not be measured,
S0 he termed such data
nominal data. Ordinal
data were introduced by
a German numerologist
Frederich Mohs in 1822
when he introduced a
hardness scale for min-
erals. For example, the
hardest stone is the
diamond, which he
assigned a hardness
value of 1500. Quartz
was assigned a hardness
value of 100. This does
not mean that a diamond
is 15 times harder than
quartz. It only means that
a diamond is harder than
quartz. In 1947, a psy-
chologist named Stanley
Smith Stevens made a
further division of contin-
uous data into two cate-
gories, namely, interval
and ratio.

1-8

In addition to being classified as qualitative or quantitative, variables can be classified
by how they are categorized, counted, or measured. For example, can the data be organized
into specific categories, such as area of residence (rural, suburban, or urban)? Can the data
values be ranked, such as first place, second place, etc.? Or are the values obtained from
measurement, such as heights, IQs, or temperature? This type of classification—i.e., how
variables are categorized, counted, or measured—uses measurement scales, and four
common types of scales are used: nominal, ordinal, interval, and ratio.

The first level of measurement is called the nominal level of measurement. A sample
of college instructors classified according to subject taught (e.g., English, history, psy-
chology, or mathematics) is an example of nominal-level measurement. Classifying
survey subjects as male or female is another example of nominal-level measurement.
No ranking or order can be placed on the data. Classifying residents according to zip
codes is also an example of the nominal level of measurement. Even though numbers
are assigned as zip codes, there is no meaningful order or ranking. Other examples of
nominal-level data are political party (Democratic, Republican, Independent, etc.), reli-
gion (Christianity, Judaism, Islam, etc.), and marital status (single, married, divorced,
widowed, separated).

The nominal level of measurement classifies data into mutually exclusive (nonover-
lapping) categories in which no order or ranking can be imposed on the data.

The next level of measurement is called the ordinal level. Data measured at this level
can be placed into categories, and these categories can be ordered, or ranked. For exam-
ple, from student evaluations, guest speakers might be ranked as superior, average, or
poor. Floats in a homecoming parade might be ranked as first place, second place, etc.
Note that precise measurement of differences in the ordinal level of measurement does not
exist. For instance, when people are classified according to their build (small, medium, or
large), a large variation exists among the individuals in each class.

Other examples of ordinal data are letter grades (A, B, C, D, F).

The ordinal level of measurement classifies data into categories that can be
ranked; however, precise differences between the ranks do not exist.

The third level of measurement is called the interval level. This level differs from
the ordinal level in that precise differences do exist between units. For example, many stan-
dardized psychological tests yield values measured on an interval scale. IQ is an example
of such a variable. There is a meaningful difference of 1 point between an IQ of 109 and
an IQ of 110. Temperature is another example of interval measurement, since there is
a meaningful difference of 1°F between each unit, such as 72 and 73°F. One property is
lacking in the interval scale: There is no true zero. For example, IQ tests do not measure
people who have no intelligence. For temperature, 0°F does not mean no heat at all.

The interval level of measurement ranks data, and precise differences between
units of measure do exist; however, there is no meaningful zero.

The final level of measurement is called the ratio level. Examples of ratio scales are
those used to measure height, weight, area, and number of phone calls received. Ratio
scales have differences between units (1 inch, 1 pound, etc.) and a true zero. In addition,
the ratio scale contains a true ratio between values. For example, if one person can lift
200 pounds and another can lift 100 pounds, then the ratio between them is 2 to 1. Put
another way, the first person can lift twice as much as the second person.

The ratio level of measurement possesses all the characteristics of interval
measurement, and there exists a true zero. In addition, true ratios exist when the
same variable is measured on two different members of the population.
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Measurement Scales
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TABLE 1-2 Examples of Measurement Scales

Nominal-level data

Ordinal-level data

Interval-level data

Ratio-level data

Zip code

Gender (male, female)

Eye color (blue, brown,
green, hazel)

Political affiliation

Religious affiliation

Major field (mathematics,
computers, etc.)

Nationality

Grade (A, B, C,
D,F)
Judging (first place,
second place, etc.)
Rating scale (poor,
good, excellent)
Ranking of tennis
players

SAT score
0]
Temperature

Height
Weight
Time
Salary
Age

1. Nominal Level

Black

Automobile color

2. Ordinal Level

S

&>

Small Medium

Pizza size

3. Interval Level

()
\—/

Temperature

4. Ratio Level

=

6ft2”

Height

There is not complete agreement among statisticians about the classification of data
into one of the four categories. For example, some researchers classify 1Q data as ratio
data rather than interval. Also, data can be altered so that they fit into a different category.
For instance, if the incomes of all professors of a college are classified into the three
categories of low, average, and high, then a ratio variable becomes an ordinal variable.
Table 1-2 gives some examples of each type of data. See Figure 1-2.

EXAMPLE 1-4 Measurement Levels

What level of measurement would be used to measure each variable?

a. The ages of patients in a local hospital
b. The ratings of movies released this month

¢. Colors of athletic shirts sold by Oak Park Health Club
d. Temperatures of hot tubs in local health clubs
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SOLUTION

a. Ratio

b. Ordinal
c. Nominal
d. Interval

== Applying the Concepts

Fatal Transportation Injuries

1-2

Read the following information about the number of fatal accidents for the transportation industry

in 2010, and answer each question.

Industry Number of fatalities
Highway accidents 968
Railway accidents 44
Water vehicle accidents 52
Aircraft accidents 151

Source: Bureau of Labor Statistics.

1. Name the variables under study.

2. Categorize each variable as quantitative or qualitative.

3. Categorize each quantitative variable as discrete or continuous.

4. Identify the level of measurement for each variable.

5. The railroad has the fewest fatalities for 2010. Does that mean railroads have fewer accidents

than the other industries?

6. What factors other than safety influence a person’s choice of transportation?

7. From the information given, comment on the relationship between the variables.

See page 39 for the answers.

1. Explain the difference between qualitative variables and 8.

quantitative variables.

2. Explain the difference between discrete and continuous

variables.

3. Why are continuous variables rounded when they are

9.
10.

used in statistical studies?

4. Name and define the four types of measurement levels 12

used in statistics.

For Exercises 510, determine whether the data are

qualitative or quantitative.

11.

13.

14.

15.

5. Color of football uniforms

6. Pizza sizes (small, medium, and large)

7. Cholesterol counts for individuals 16.

1-10

Lightbulb wattage
Genders of movie stars

Ratings of teachers

For Exercises 11-16, determine whether the data are
discrete or continuous.

Number of text messages sent in a month

. Systolic blood pressure readings

Heights of basketball players on a local high school
team

Number of phone calls received during one day at a
poison control center

Number of students in the mathematics classes during
the fall semester at your school for a particular school
year

Temperatures at a seashore resort
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For Exercises 17-22, give the boundaries of each value. 25. Amounts of money spent on a medical

17. 7 feet

18. 6.3 millimeters
19. 143 miles

20. 3.25 pounds
21. 25.8 yards

22. 19 quarts

For Exercises 23-30, classify each as nominal-level,

checkup
26. Scores on a statistical final exam

27. Ratings of fiction books—excellent, good,
fair, poor

28. Blood types—O, A, B, AB
29. Online spending

30. Number of flowers in a bouquet

ordinal-level, interval-level, or ratio-level measurement.

23. Telephone numbers

24. Leap years: . .. 2008, 2012, 2016, . . .

1-3

Data Collection and Sampling Techniques

OBJECTIVE @

Identify the four basic
sampling techniques.

I Historical Note

A pioneer in census
taking was Pierre-Simon
de Laplace. In 1780, he
developed the Laplace
method of estimating the
population of a country.
The principle behind his
method was to take a
census of a few selected
communities and to de-
termine the ratio of the
population to the num-
ber of births in these
communities. (Good
birth records were kept.)
This ratio would be used
to multiply the number
of births in the entire
country to estimate the
number of citizens in
the country.

In research, statisticians use data in many different ways. As stated previously, data can be
used to describe situations or events. For example, a manufacturer might want to know
something about the consumers who will be purchasing his product so he can plan an
effective marketing strategy. In another situation, the management of a company might
survey its employees to assess their needs in order to negotiate a new contract with the
employees’ union. Data can be used to determine whether the educational goals of a
school district are being met. Finally, trends in various areas, such as the stock market,
can be analyzed, enabling prospective buyers to make more intelligent decisions concern-
ing what stocks to purchase. These examples illustrate a few situations where collecting
data will help people make better decisions on courses of action.

Data can be collected in a variety of ways. One of the most common methods is
through the use of surveys. Surveys can be done by using a variety of methods. Three of
the most common methods are the telephone survey, the mailed questionnaire, and the
personal interview.

Telephone surveys have an advantage over personal interview surveys in that they are
less costly. Also, people may be more candid in their opinions since there is no face-to-
face contact. A major drawback to the telephone survey is that some people in the popu-
lation will not have phones or will not answer when the calls are made; hence, not all
people have a chance of being surveyed. Also, many people now have unlisted numbers
and cell phones, so they cannot be surveyed. Finally, even the tone of voice of the inter-
viewer might influence the response of the person who is being interviewed.

Mailed questionnaire surveys
can be used to cover a wider geo-
graphic area than telephone surveys
or personal interviews since mailed
questionnaire surveys are less
expensive to conduct. Also, respon-
dents can remain anonymous if they
desire. Disadvantages of mailed
questionnaire surveys include a low
number of responses and inappro-
priate answers to questions. An-
other drawback is that some people
may have difficulty reading or un-
derstanding the questions.
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I Historical Note

The first census in the
United States was
conducted in 1790. Its
purpose was to ensure
proper Congressional
representation.

Personal interview surveys have the advantage of obtaining in-depth responses to
questions from the person being interviewed. One disadvantage is that interviewers must
be trained in asking questions and recording responses, which makes the personal inter-
view survey more costly than the other two survey methods. Another disadvantage is that
the interviewer may be biased in his or her selection of respondents.

Data can also be collected in other ways, such as surveying records or direct obser-
vation of situations.

As stated in Section 1-1, researchers use samples to collect data and information
about a particular variable from a large population. Using samples saves time and money
and in some cases enables the researcher to get more detailed information about a
particular subject. Remember, samples cannot be selected in haphazard ways because the
information obtained might be biased. For example, interviewing people on a street cor-
ner during the day would not include responses from people working in offices at that
time or from people attending school; hence, not all subjects in a particular population
would have a chance of being selected.

To obtain samples that are unbiased—i.e., that give each subject in the population
an equally likely chance of being selected—statisticians use four basic methods of
sampling: random, systematic, stratified, and cluster sampling.

Random Sampling

A random sample is a sample in which all members of the population have an equal
chance of being selected.

Random samples are selected by using chance methods or random numbers. One such
method is to number each subject in the population. Then place numbered cards in
a bowl, mix them thoroughly, and select as many cards as needed. The subjects
whose numbers are selected constitute the sample. Since it is difficult to mix the cards
thoroughly, there is a chance of obtaining a biased sample. For this reason, statisticians
use another method of obtaining numbers. They generate random numbers with a com-
puter or calculator. Before the invention of computers, random numbers were obtained
from tables.

Some two-digit random numbers are shown in Table 1-3. To select a random sample
of, say, 15 subjects out of 85 subjects, it is necessary to number each subject from 01 to 85.
Then select a starting number by closing your eyes and placing your finger on a number
in the table. (Although this may sound somewhat unusual, it enables us to find a starting
number at random.) In this case suppose your finger landed on the number 12 in the sec-
ond column. (It is the sixth number down from the top.) Then proceed downward until
you have selected 15 different numbers between 01 and 85. When you reach the bottom of
the column, go to the top of the next column. If you select a number greater than 85 or the
number 00 or a duplicate number, just omit it. In our example, we will use the subjects
numbered 12, 27, 75, 62, 57, 13, 31, 06, 16, 49, 46, 71, 53, 41, and 02. A more detailed
procedure for selecting a random sample using a table of random numbers is given in
Chapter 14, using Table D in Appendix A.

Systematic Sampling

A systematic sample is a sample obtained by selecting every k" member of the
population where k is a counting number.

Researchers obtain systematic samples by numbering each subject of the population and
then selecting every k™ subject. For example, suppose there were 2000 subjects in the



R
= SPEAKING OF STATISTICS The Worst Day for Weight Loss

Many overweight people have difficulty losing weight.
Prevention magazine reported that researchers from
Washington University School of Medicine studied the
diets of 48 adult weight loss participants. They used
food diaries, exercise monitors, and weigh-ins. They
found that the participants ate an average of 236 more
calories on Saturdays than they did on the other week-
days. This would amount to a weight gain of 9 pounds
per year. So if you are watching your diet, be careful on
Saturdays.

Are the statistics reported in this study descriptive
or inferential in nature? What type of variables are used
here?

population and a sample of 50 subjects was needed. Since 2000 <+ 50 = 40, then k£ = 40,
and every 40th subject would be selected; however, the first subject (numbered between
1 and 40) would be selected at random. Suppose subject 12 were the first subject selected;
then the sample would consist of the subjects whose numbers were 12, 52, 92, etc., until
50 subjects were obtained. When using systematic sampling, you must be careful about
how the subjects in the population are numbered. If subjects were arranged in a manner
such as wife, husband, wife, husband, and every 40th subject were selected, the sample
would consist of all husbands. Numbering is not always necessary. For example, a
researcher may select every 10th item from an assembly line to test for defects.

Stratified Sampling

A stratified sample is a sample obtained by dividing the population into subgroups
or strata according to some characteristic relevant to the study. (There can be sev-
eral subgroups.) Then subjects are selected from each subgroup.

1-13
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I Historical Note

In 1936, the Literary
Digest, on the basis of a
biased sample of its sub-
scribers, predicted that
Alf Landon would defeat
Franklin D. Roosevelt in
the upcoming presiden-
tial election. Roosevelt
won by a landslide. The
magazine ceased publi-
cation the following year.

Interesting Facts

Older Americans are
less likely to sacrifice
happiness for a higher-
paying job. According to
one survey, 38% of
those aged 18-29 said
they would choose more
money over happiness,
while only 3% of those
over age 65 would.

Samples within the strata should be randomly selected. For example, suppose the presi-
dent of a two-year college wants to learn how students feel about a certain issue. Further-
more, the president wishes to see if the opinions of first-year students differ from those of
second-year students. The president will randomly select students from each subgroup to
use in the sample.

Cluster Sampling

A cluster sample is obtained by dividing the population into sections or clusters
and then selecting one or more clusters and using all members in the cluster(s) as
the members of the sample.

Here the population is divided into groups or clusters by some means such as geographic
area or schools in a large school district. Then the researcher randomly selects some of
these clusters and uses all members of the selected clusters as the subjects of the samples.
Suppose a researcher wishes to survey apartment dwellers in a large city. If there are 10
apartment buildings in the city, the researcher can select at random 2 buildings from the
10 and interview all the residents of these buildings. Cluster sampling is used when the
population is large or when it involves subjects residing in a large geographic area. For ex-
ample, if one wanted to do a study involving the patients in the hospitals in New York
City, it would be very costly and time-consuming to try to obtain a random sample of pa-
tients since they would be spread over a large area. Instead, a few hospitals could be
selected at random, and the patients in these hospitals would be interviewed in a cluster.
See Figure 1-3.
The four basic sampling methods are summarized in Table 1-4.

Other Sampling Methods

In addition to the four basic sampling methods, researchers use other methods to obtain
samples. One such method is called a convenience sample. Here a researcher uses
subjects who are convenient. For example, the researcher may interview subjects entering
a local mall to determine the nature of their visit or perhaps what stores they will be pa-
tronizing. This sample is probably not representative of the general customers for several
reasons. For one thing, it was probably taken at a specific time of day, so not all customers
entering the mall have an equal chance of being selected since they were not there when
the survey was being conducted. But convenience samples can be representative of the
population. If the researcher investigates the characteristics of the population and deter-
mines that the sample is representative, then it can be used.

Another type of sample that is used in statistics is a volunteer sample or self-selected
sample. Here respondents decide for themselves if they wish to be included in the sample.
For example, a radio station in Pittsburgh asks a question about a situation and then asks
people to call one number if they agree with the action taken or call another number if
they disagree with the action. The results are then announced at the end of the day. Note
that most often, only people with strong opinions will call. The station does explain that
this is not a “scientific poll.”

Since samples are not perfect representatives of the populations from which they
are selected, there is always some error in the results. This error is called a sampling
error.

Sampling error is the difference between the results obtained from a sample
and the results obtained from the population from which the sample was
selected.
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FIGURE 1-3  Sampling Methods
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TABLE 1-4 Summary of Sampling Methods

Random Subjects are selected by random numbers.

Systematic Subjects are selected by using every kth number after the first subject is
randomly selected from 1 through k.

Stratified Subjects are selected by dividing up the population into subgroups (strata), and
subjects are randomly selected within subgroups.

Cluster Subjects are selected by using an intact subgroup that is representative of the
population.

For example, suppose you select a sample of full-time students at your college and find
56% are female. Then you go to the admissions office and get the genders of all full-time
students that semester and find that 54% are female. The difference of 2% is said to be due
to sampling error.

In most cases, this difference is unknown, but it can be estimated. This process is
shown in Chapter 7.

There is another error that occurs in statistics called nonsampling error.

A nonsampling error occurs when the data are obtained erroneously or the sample
is biased, i.e., nonrepresentative.

For example, data could be collected by using a defective scale. Each weight might be off
by, say, 2 pounds. Also, recording errors can be made. Perhaps the researcher wrote an in-
correct data value.

Caution and vigilance should be used when collecting data.

Other sampling techniques, such as sequential sampling, double sampling, and multi-
stage sampling, are explained in Chapter 14, along with a more detailed explanation of the
four basic sampling techniques.

EXAMPLE 1-5 Sampling Methods
State which sampling method was used.
a. Out of 10 hospitals in a municipality, a researcher selects one and collects records
for a 24-hour period on the types of emergencies that were treated there.

b. A researcher divides a group of students according to gender, major field,
and low, average, and high grade point average. Then she randomly selects
six students from each group to answer questions in a survey.

c. The subscribers to a magazine are numbered. Then a sample of these people is
selected using random numbers.

d. Every 10th bottle of Super-Duper Cola is selected, and the amount of liquid in the
bottle is measured. The purpose is to see if the machines that fill the bottles are
working properly.

SOLUTION

a. Cluster
b. Stratified
c¢. Random

d. Systematic
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== Applying the Concepts 1-3

American Culture and Drug Abuse

Assume you are a member of the Family Research Council and have become increasingly con-
cerned about the drug use by professional sports players. You set up a plan and conduct a survey on
how people believe the American culture (television, movies, magazines, and popular music) influ-
ences illegal drug use. Your survey consists of 2250 adults and adolescents from around the coun-
try. A consumer group petitions you for more information about your survey. Answer the following

questions about your survey.

1. What type of survey did you use (phone, mail, or interview)?

2. What are the advantages and disadvantages of the surveying methods you did not use?

3. What type of scores did you use? Why?

4.Did you use a random method for deciding who would be in your sample?

5. Which of the methods (stratified, systematic, cluster, volunteer, or convenience) did you use?

6. Why was that method more appropriate for this type of data collection?

7.1f a convenience sample were obtained consisting of only adolescents, how would the results

of the study be affected?

See pages 39-40 for the answers.

1. Name five ways that data can be collected.
2. What is meant by sampling error and nonsampling error?

3. Why are random numbers used in sampling, and how
are random numbers generated?

4. Name and define the four basic sampling methods.

For Exercises 5-10, define a population that may have been
used and explain how the sample might have been selected.

5. In 2011, 25% of people did not engage in regular physical
activity. (Source: SQL Server Reporting Services)

6. The number one automobile that vehicle thieves prefer
is the Honda Accord. (Source: LoJack Vehicle Theft
Recovery Report, 2010)

7. There are 78 million pet owners in the United States
who have dogs. (Source: American Pet Products
Association National Pet Owners Survey)

8. Adults aged 19-50 need 1000 milligrams of calcium per
day. (Source: Institute of Medicine Report)

9. Taking statins raises the risk of developing diabetes.
(Source: Journal of American Medical Association and
other sources)

10. The average January 2012 temperature in Boston
was 34.2°F. This was 5.2° higher than the normal
January average temperature. (Source:
AccuWeather.com)

For Exercises 11-16, indentify the sampling method that
was used.

11. To check the accuracy of a machine that is used for
filling ice cream containers, every 20th bottle is selected
and weighed.

12. To determine how long people exercise, a researcher
interviews 5 people selected from a yoga class, 5 people
selected from a weight-lifting class, 5 people selected
from an aerobics class, and 5 people from swimming
classes.

13. In a large school district, a researcher numbers all the
full-time teachers and then randomly selects 30 teachers
to be interviewed.

14. In a medical research study, a researcher selects a
hospital and interviews all the patients that day.

15. Customers in the Sunrise Coffee Shop are asked how
much they spend on coffee per week.

16. Ten counties in Pennsylvania are randomly selected to
determine the average county real estate tax that the
residents pay.
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1-4

Experimental Design

OBJECTIVE @

Explain the difference
between an observational
and an experimental study.

I Interesting Fact

The safest day of the
week for driving is
Tuesday.

Observational and Experimental Studies

There are several different ways to classify statistical studies. This section explains two
types of studies: observational studies and experimental studies.

In an observational study, the researcher merely observes what is happening or what
has happened in the past and tries to draw conclusions based on these observations.

For example, data from the Motorcycle Industry Council (USA TODAY) stated that
“Motorcycle owners are getting older and richer.” Data were collected on the ages and in-
comes of motorcycle owners for the years 1980 and 1998 and then compared. The find-
ings showed considerable differences in the ages and incomes of motorcycle owners for
the two years. In this study, the researcher merely observed what had happened to the
motorcycle owners over a period of time. There was no type of research intervention.

There are three main types of observational studies. When all the data are collected
at one time, the study is called a cross-sectional study. When the data are collected using
records obtained from the past, the study is called a retrospective study. Finally, if the
data are collected over a period of time, say, past and present, the study is called a
longitudinal study.

Observational studies have advantages and disadvantages. One advantage of an ob-
servational study is that it usually occurs in a natural setting. For example, researchers can
observe people’s driving patterns on streets and highways in large cities. Another advan-
tage of an observational study is that it can be done in situations where it would be uneth-
ical or downright dangerous to conduct an experiment. Using observational studies, re-
searchers can study suicides, rapes, murders, etc. In addition, observational studies can be
done using variables that cannot be manipulated by the researcher, such as drug users ver-
sus nondrug users and right-handedness versus left-handedness.

Observational studies have disadvantages, too. As mentioned previously, since the
variables are not controlled by the researcher, a definite cause-and-effect situation cannot
be shown since other factors may have had an effect on the results. Observational studies
can be expensive and time-consuming. For example, if one wanted to study the habitat of
lions in Africa, one would need a lot of time and money, and there would be a certain
amount of danger involved. Finally, since the researcher may not be using his or her own
measurements, the results could be subject to the inaccuracies of those who collected the
data. For example, if the researchers were doing a study of events that occurred in
the 1800s, they would have to rely on information and records obtained by others from a
previous era. There is no way to ensure the accuracy of these records.

The other type of study is called an experimental study.

In an experimental study, the researcher manipulates one of the variables and tries
to determine how the manipulation influences other variables.

For example, a study conducted at Virginia Polytechnic Institute and presented in
Psychology Today divided female undergraduate students into two groups and had the
students perform as many sit-ups as possible in 90 sec. The first group was told only to
“Do your best,” while the second group was told to try to increase the actual number of
sit-ups done each day by 10%. After four days, the subjects in the group who were given
the vague instructions to “Do your best” averaged 43 sit-ups, while the group that was
given the more specific instructions to increase the number of sit-ups by 10% averaged
56 sit-ups by the last day’s session. The conclusion then was that athletes who were given
specific goals performed better than those who were not given specific goals.

This study is an example of a statistical experiment since the researchers intervened
in the study by manipulating one of the variables, namely, the type of instructions given
to each group.
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The number of potholes
in the United States is
about 56 million.
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In a true experimental study, the subjects should be assigned to groups randomly.
Also, the treatments should be assigned to the groups at random. In the sit-up study, the
article did not mention whether the subjects were randomly assigned to the groups.

Sometimes when random assignment is not possible, researchers use intact groups.
These types of studies are done quite often in education where already intact groups are
available in the form of existing classrooms. When these groups are used, the study is said
to be a quasi-experimental study. The treatments, though, should be assigned at random.
Most articles do not state whether random assignment of subjects was used.

Statistical studies usually include one or more independent variables and one de-
pendent variable.

The independent variable in an experimental study is the one that is being manipu-
lated by the researcher. The independent variable is also called the explanatory
variable. The resultant variable is called the dependent variable or the outcome
variable.

The outcome variable is the variable that is studied to see if it has changed significantly
because of the manipulation of the independent variable. For example, in the sit-up study, the
researchers gave the groups two different types of instructions, general and specific. Hence,
the independent variable is the type of instruction. The dependent variable, then, is the re-
sultant variable, that is, the number of sit-ups each group was able to perform after four
days of exercise. If the differences in the dependent or outcome variable are large and other
factors are equal, these differences can be attributed to the manipulation of the independent
variable. In this case, specific instructions were shown to increase athletic performance.

In the sit-up study, there were two groups. The group that received the special instruc-
tion is called the treatment group while the other is called the control group. The treat-
ment group receives a specific treatment (in this case, instructions for improvement)
while the control group does not.

Both types of statistical studies have advantages and disadvantages. Experimental
studies have the advantage that the researcher can decide how to select subjects and how
to assign them to specific groups. The researcher can also control or manipulate the
independent variable. For example, in studies that require the subjects to consume a certain
amount of medicine each day, the researcher can determine the precise dosages and, if
necessary, vary the dosage for the groups.

There are several disadvantages to experimental studies. First, they may occur in un-
natural settings, such as laboratories and special classrooms. This can lead to several
problems. One such problem is that the results might not apply to the natural setting. The
age-old question then is, “This mouthwash may kill 10,000 germs in a test tube, but how
many germs will it kill in my mouth?”

Another disadvantage with an experimental study is the Hawthorne effect. This effect
was discovered in 1924 in a study of workers at the Hawthorne plant of the Western Elec-
tric Company. In this study, researchers found that the subjects who knew they were par-
ticipating in an experiment actually changed their behavior in ways that affected the results
of the study.

Another problem when conducting statistical studies is called confounding of vari-
ables or lurking variables.

A confounding variable is one that influences the dependent or outcome variable
but was not separated from the independent variable.

Researchers try to control most variables in a study, but this is not possible in some
studies. For example, subjects who are put on an exercise program might also improve
their diet unbeknownst to the researcher and perhaps improve their health in other ways
not due to exercise alone. Then diet becomes a confounding variable.
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IUnusual Stat

The chance that
someone will attempt to
burglarize your home

in any given year is

1in 20.
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When you read the results of statistical studies, decide if the study was observational
or experimental. Then see if the conclusion follows logically, based on the nature of these
studies.

Another factor that can influence statistical experiments is called the placebo effect.
Here the subjects used in the study respond favorably or show improvement due to the
fact that they had been selected for the study. They could also be reacting to clues given
unintentionally by the researchers. For example, in a study on knee pain done at the
Houston VA Medical Center, researchers divided 180 patients into three groups. Two
groups had surgery to remove damaged cartilage while those in the third group had sim-
ulated surgery. After two years, an equal number of patients in each group reported that
they felt better after the surgery. Those patients who had simulated surgery were said to
be responding to what is called the placebo effect.

To minimize the placebo effect, researchers use what is called blinding. In blinding,
the subjects do not know whether they are receiving an actual treatment or a placebo.
Many times researchers use a sugar pill that looks like a real medical pill. Often double
blinding is used. Here both the subjects and the researchers are not told which groups are
given the placebos.

Researchers use blocking to minimize variability when they suspect that there might
be a difference between two or more blocks. For example, in the sit-up study mentioned
earlier, if we think that men and women would respond differently to “Do your best” ver-
sus “Increase by 10% every day,” we would divide the subjects into two blocks (men,
women) and then randomize which subjects in each block get the treatment.

When subjects are assigned to groups randomly, and the treatments are assigned ran-
domly, the experiment is said to be a completely randomized design.”

Some experiments use what is called a matched-pair design. Here one subject is as-
signed to a treatment group, and another subject is assigned to a control group. But,
before the assignment, subjects are paired according to certain characteristics. In earlier
years, studies used identical twins, assigning one twin to one group and the other twin to
another group. Subjects can be paired on any characteristics such as ages, heights, and
weights.

Another way to validate studies is to use replication. Here the same experiment is
done in another part of the country or in another laboratory. The same study could also be
done using adults who are not going to college instead of using college students. Then the
results of the second study are compared to the ones in the original study to see if they are
the same.

No matter what type of study is conducted, two studies on the same subject some-
times have conflicting conclusions. Why might this occur? An article entitled “Bottom
Line: Is It Good for You?” (USA TODAY Weekend ) states that in the 1960s studies sug-
gested that margarine was better for the heart than butter since margarine contains less
saturated fat and users had lower cholesterol levels. In a 1980 study, researchers found
that butter was better than margarine since margarine contained trans-fatty acids, which
are worse for the heart than butter’s saturated fat. Then in a 1998 study, researchers found
that margarine was better for a person’s health. Now, what is to be believed? Should one
use butter or margarine?

The answer here is that you must take a closer look at these studies. Actually, it is not
the choice between butter and margarine that counts, but the type of margarine used. In
the 1980s, studies showed that solid margarine contains trans-fatty acids, and scientists
believe that they are worse for the heart than butter’s saturated fat. In the 1998 study, lig-
uid margarine was used. It is very low in trans-fatty acids, and hence it is more healthful
than butter because trans-fatty acids have been shown to raise cholesterol. Hence, the
conclusion is that it is better to use liquid margarine than solid margarine or butter.

Before decisions based on research studies are made, it is important to get all the facts
and examine them in light of the particular situation.

The purpose of a statistical study is to gain and process information obtained from
the study in order to answer specific questions about the subject being investigated.
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Explain how statistics can
be used and misused.
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Statistical researchers use a specific procedure to do statistical studies to obtain valid
results.
The general guidelines for this procedure are as follows:

1. Formulate the purpose of the study.

2. Identify the variables for the study.

3. Define the population.

4. Decide what sampling method you will use to collect the data.

S. Collect the data.

6. Summarize the data and perform any statistical calculations needed.

7. Interpret the results.

There is also a formal way to write up the study procedure and the results obtained.
This information is available on the online resources under “Writing the Research Report.”

EXAMPLE 1-6 Experimental Design

Researchers randomly assigned 10 people to each of three different groups. Group 1
was instructed to write an essay about the hassles in their lives. Group 2 was instructed
to write an essay about circumstances that made them feel thankful. Group 3 was asked
to write an essay about events that they felt neutral about. After the exercise, they were
given a questionnaire on their outlook on life. The researchers found that those who
wrote about circumstances that made them feel thankful had a more optimistic outlook
on life. The conclusion is that focusing on the positive makes you more optimistic about
life in general. Based on this study, answer the following questions.

a. Was this an observational or experimental study?

b. What is the independent variable?

c. What is the dependent variable?

d. What may be a confounding variable in this study?

e. What can you say about the sample size?

f- Do you agree with the conclusion? Explain your answer.

SOLUTION

a. This is an experimental study since the variables (types of essays written) were
manipulated.

b. The independent variable was the type of essay the participants wrote.
The dependent variable was the score on the life outlook questionnaire.

i

d. Other factors, such as age, upbringing, and income, can affect the results; how-
ever, the random assignment of subjects is helpful in eliminating these factors.
See the answer for the next question.

e. In this study, the sample uses 30 participants total.
f- Answers will vary.

Uses and Misuses of Statistics

As explained previously, statistical techniques can be used to describe data, compare two
or more data sets, determine if a relationship exists between variables, test hypotheses,
and make estimates about population characteristics. However, there is another aspect of
statistics, and that is the misuse of statistical techniques to sell products that don’t work
properly, to attempt to prove something true that is really not true, or to get our attention
by using statistics to evoke fear, shock, and outrage.

1-21
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Two sayings that have been around for a long time illustrate this point:

“There are three types of lies—Ilies, damn lies, and statistics.”
“Figures don’t lie, but liars figure.”

Just because we read or hear the results of a research study or an opinion poll in the
media, this does not mean that these results are reliable or that they can be applied to any
and all situations. For example, reporters sometimes leave out critical details such as the
size of the sample used or how the research subjects were selected. Without this informa-
tion, you cannot properly evaluate the research and properly interpret the conclusions of
the study or survey.

It is the purpose of this section to show some ways that statistics can be misused. You
should not infer that all research studies and surveys are suspect, but that there are many
factors to consider when making decisions based on the results of research studies and
surveys. Here are some ways that statistics can be misrepresented.

Suspect Samples The first thing to consider is the sample that was used in the re-
search study. Sometimes researchers use very small samples to obtain information. Sev-
eral years ago, advertisements contained such statements as “Three out of four doctors
surveyed recommend brand such and such.” If only 4 doctors were surveyed, the results
could have been obtained by chance alone; however, if 100 doctors were surveyed, the
results might be quite different.

Not only is it important to have a sample size that is large enough, but also it is
necessary to see how the subjects in the sample were selected. As stated previously,
studies using volunteers sometimes have a built-in bias. Volunteers generally do not
represent the population at large. Sometimes they are recruited from a particular so-
cioeconomic background, and sometimes unemployed people volunteer for research
studies to get a stipend. Studies that require the subjects to spend several days or weeks
in an environment other than their home or workplace automatically exclude people
who are employed and cannot take time away from work. Sometimes only college stu-
dents or retirees are used in studies. In the past, many studies have used only men, but
have attempted to generalize the results to both men and women. Opinion polls that
require a person to phone or mail in a response most often are not representative of the
population in general, since only those with strong feelings for or against the issue usu-
ally call or respond by mail.

Another type of sample that may not be representative is the convenience sample.
Educational studies sometimes use students in intact classrooms since it is convenient.
Quite often, the students in these classrooms do not represent the student population of
the entire school district.

When results are interpreted from studies using small samples, convenience sam-
ples, or volunteer samples, care should be used in generalizing the results to the entire
population.

Ambiguous Averages In Chapter 3, you will learn that there are four commonly
used measures that are loosely called averages. They are the mean, median, mode, and
midrange. For the same data set, these averages can differ markedly. People who know
this can, without lying, select the one measure of average that lends the most evidence to
support their position.

Changing the Subject Another type of statistical distortion can occur when differ-
ent values are used to represent the same data. For example, one political candidate who
is running for reelection might say, “During my administration, expenditures increased
a mere 3%.” His opponent, who is trying to unseat him, might say, “During my oppo-
nent’s administration, expenditures have increased a whopping $6,000,000.” Here both
figures are correct; however, expressing a 3% increase as $6,000,000 makes it sound
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like a very large increase. Here again, ask yourself, Which measure better represents the
data?

Detached Statistics A claim that uses a detached statistic is one in which no com-
parison is made. For example, you may hear a claim such as “Our brand of crackers has
one-third fewer calories.” Here, no comparison is made. One-third fewer calories than
what? Another example is a claim that uses a detached statistic such as “Brand A aspirin
works four times faster.” Four times faster than what? When you see statements such as
this, always ask yourself, Compared to what?

Implied Connections Many claims attempt to imply connections between variables
that may not actually exist. For example, consider the following statement: “Eating fish
may help to reduce your cholesterol.” Notice the words may help. There is no guarantee
that eating fish will definitely help you reduce your cholesterol.

“Studies suggest that using our exercise machine will reduce your weight.” Here the
word suggest is used; and again, there is no guarantee that you will lose weight by using
the exercise machine advertised.

Another claim might say, “Taking calcium will lower blood pressure in some people.”
Note the word some is used. You may not be included in the group of “some” people. Be
careful when you draw conclusions from claims that use words such as may, in some peo-
ple, and might help.

Misleading Graphs Statistical graphs give a visual representation of data that en-
ables viewers to analyze and interpret data more easily than by simply looking at num-
bers. In Chapter 2, you will see how some graphs are used to represent data. However, if
graphs are drawn inappropriately, they can misrepresent the data and lead the reader to
draw false conclusions. The misuse of graphs is also explained in Chapter 2.

Faulty Survey Questions When analyzing the results of a survey using question-
naires, you should be sure that the questions are properly written since the way ques-
tions are phrased can often influence the way people answer them. For example, the
responses to a question such as “Do you feel that the North Huntingdon School District
should build a new football stadium?” might be answered differently than a question
such as “Do you favor increasing school taxes so that the North Huntingdon School Dis-
trict can build a new football stadium?” Each question asks something a little different,
and the responses could be radically different. When you read and interpret the results
obtained from questionnaire surveys, watch out for some of these common mistakes
made in the writing of the survey questions.

In Chapter 14, you will find some common ways that survey questions could be
misinterpreted by those responding, and could therefore result in incorrect conclusions.

In summary then, statistics, when used properly, can be beneficial in obtaining much
information, but when used improperly, can lead to much misinformation. It is like your
automobile. If you use your automobile to get to school or work or to go on a vacation,
that’s good. But if you use it to run over your neighbor’s dog because it barks all night long
and tears up your flower garden, that’s not so good!

== Applying the Concepts 1-4

Just a Pinch Between Your Cheek and Gum

As the evidence on the adverse effects of cigarette smoke grew, people tried many different ways
to quit smoking. Some people tried chewing tobacco or, as it was called, smokeless tobacco. A
small amount of tobacco was placed between the cheek and gum. Certain chemicals from the
tobacco were absorbed into the bloodstream and gave the sensation of smoking cigarettes. This

1-23
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prompted studies on the adverse effects of smokeless tobacco. One study in particular used 40 uni-
versity students as subjects. Twenty were given smokeless tobacco to chew, and twenty given a
substance that looked and tasted like smokeless tobacco, but did not contain any of the harmful
substances. The students were randomly assigned to one of the groups. The students’ blood pres-
sure and heart rate were measured before they started chewing and 20 minutes after they had begun
chewing. A significant increase in heart rate occurred in the group that chewed the smokeless
tobacco. Answer the following questions.

1. What type of study was this (observational, quasi-experimental, or experimental)?
2. What are the independent and dependent variables?
3. Which was the treatment group?

4. Could the students’ blood pressures be affected by knowing that they are part of

a study?

5. List some possible confounding variables.

6. Do you think this is a good way to study the effect of smokeless tobacco?

See page 40 for the answers.

1.

Explain the difference between an observational and an
experimental study.

2. Name and define the three types of observational studies.

3. List some advantages and disadvantages of an observa-

tional study.

. List some advantages and disadvantages of an experi-

mental study.

. What is the difference between an experimental study

and a quasi-experimental study?

. What is the difference between independent variables

and dependent variables?

. Why are a treatment group and a control group used in a

statistical study?

8. Explain the Hawthorne effect.

11.
12.

13.

14.

. What is a confounding variable?

10.

Define the placebo effect in a statistical study.

What is meant by blinding and double-blinding?

Why do researchers use randomization in statistical
studies?

What is the difference between a completely random-
ized design and a matched-pair design?

Why is replication used in statistical studies?

For Exercises 15—18, determine whether an observational
study or an experimental study was used.

15.

Subjects are randomly assigned to three groups.
Group 1 receives a placebo daily, group 2 receives a
high dose of vitamin B daily, and group 3 receives a
multivitamin daily. After 3 months, each participant is
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16.

17.

18.

asked how many incidents of depression that she or he
had, and the occurrences were compared.

In a large city, a researcher decides to check the police
department records for 2 months to determine what
types of vehicles were stolen.

In a public park, visitors were asked how many minutes
a day they walked their dogs.

Subjects were randomly divided into two groups. One
group was permitted 4 hours of sleep each night for
one week. The other group was allowed to sleep at least
8 hours each night for one week. The blood pressures
of both groups were taken at the end of the week and
compared.

In Exercises 19-22, identify the independent variable and
the dependent variable.

19.

20.

21.

22.

According to the British Journal of Sports Medicine, a
regular 30-minute workout could slash your risk of catch-
ing a cold by 43%.

The Journal of Behavioral Medicine reported that
sharing a hug and holding hands can limit the physical
effects of stress such as soaring heart rate and elevated
blood pressure.

A research study stated that meditation helps people
make more-rational decisions.

A researcher found that the number of times people
visited fast-food restaurants increased with increasing
income. (Source: healthland.time.com)



Fo

r Exercises 23-26, suggest some confounding variables

that the researcher might want to consider when doing a
study.

23

24.

25.

26.

Fo

. Psychology Today magazine reports that the more intelli-
gent a person is (based on 1Q), the more willing the per-
son is to make a cooperative choice rather than a selfish
one.

The New England Journal of Medicine reported that
when poor women move to better neighborhoods, they
lower the risk of developing obesity and diabetes.

A researcher from the University of California found
that gratitude can produce positive emotions that can
lead to a longer, healthier life.

York University in Toronto, Canada, stated that people
who had suffered from fibromyalgia were able to
reduce their pain by participating in twice-weekly yoga
sessions.

r Exercises 27-31, give a reason why the statement made

might be misleading.
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28.

29.

30.

31.

32.

33.

34.

. Our product will give you the perfect body.
Here is the whole truth about back pain.

Our pain medicine will give you 24 hours of pain
relief.

By reading this book, you will increase your IQ by
20 points.

Eating 21 grams of fiber may help you to lose weight.

List the steps you should perform when conducting a
statistical study.

Beneficial Bacteria According to a pilot study of

20 people conducted at the University of Minnesota,
daily doses of a compound called arabinogalactan over a
period of 6 months resulted in a significant increase in
the beneficial lactobacillus species of bacteria. Why
can’t it be concluded that the compound is beneficial for
the majority of people?

Comment on the following statement, taken from a
magazine advertisement: “In a recent clinical study,
Brand ABC (actual brand will not be named) was
proved to be 1950% better than creatine!”

35.

36.

37.

38.

39.

40.

41.

42,
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In an ad for women, the following statement was made:
“For every 100 women, 91 have taken the road less
traveled.” Comment on this statement.

In many ads for weight loss products, under the product
claims and in small print, the following statement is
made: “These results are not typical.” What does this
say about the product being advertised?

In an ad for moisturizing lotion, the following claim is
made: “. . . it’s the number 1 dermatologist-recommended
brand.” What is misleading about this claim?

An ad for an exercise product stated: “Using this
product will burn 74% more calories.” What is
misleading about this statement?

“Vitamin E is a proven antioxidant and may help in
fighting cancer and heart disease.” Is there anything
ambiguous about this claim? Explain.

“Just 1 capsule of Brand X can provide 24 hours of acid
control.” (Actual brand will not be named.) What needs
to be more clearly defined in this statement?

“. .. Male children born to women who smoke during
pregnancy run a risk of violent and criminal behavior
that lasts well into adulthood.” Can we infer that
smoking during pregnancy is responsible for criminal
behavior in people?

Caffeine and Health In the 1980s, a study linked
coffee to a higher risk of heart disease and pancreatic
cancer. In the early 1990s, studies showed that
drinking coffee posed minimal health threats.
However, in 1994, a study showed that pregnant
women who drank 3 or more cups of tea daily may be
at risk for spontaneous abortion. In 1998, a study
claimed that women who drank more than a half-cup
of caffeinated tea every day may actually increase their
fertility. In 1998, a study showed that over a lifetime,
a few extra cups of coffee a day can raise blood
pressure, heart rate, and stress (Source: “Bottom Line:
Is It Good for You? Or Bad?” by Monika Guttman,
USA TODAY Weekend ). Suggest some reasons why
these studies appear to be conflicting.

== Extending the Concepts

43

. Find an article that describes a statistical study, and
identify the study as observational or experimental.

44.

For the article that you used in Exercise 43, identify the
independent variable(s) and dependent variable for the
study.

1-25
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45. For the article that you selected in Exercise 43, suggest
some confounding variables that may have an effect on
the results of the study.

46. Select a newspaper or magazine article that involves a
statistical study, and write a paper answering these
questions.

a.

b.

OBJECTIVE @

Explain the importance of
computers and calculators
in statistics.

Is this study descriptive or inferential? Explain your
answer.

What are the variables used in the study? In your

opinion, what level of measurement was used to
obtain the data from the variables?

1-5 Computers and Calculators

. Does the article define the population? If so, how is

it defined? If not, how could it be defined?

. Does the article state the sample size and how

the sample was obtained? If so, determine the
size of the sample and explain how it was
selected. If not, suggest a way it could have
been obtained.

. Explain in your own words what procedure (survey,

comparison of groups, etc.) might have been used
to determine the study’s conclusions.

Do you agree or disagree with the conclusions?
State your reasons.

In the past, statistical calculations were done with pencil and paper. However, with the
advent of calculators, numerical computations became much easier. Computers do all
the numerical calculation. All one does is to enter the data into the computer and use
the appropriate command; the computer will print the answer or display it on the
screen. Now the TI-84 Plus graphing calculator accomplishes the same thing.

There are many statistical packages available. This book uses Microsoft Excel and
MINITAB. Instructions for using the TI-84 Plus graphing calculator, Excel, and MINITAB
have been placed at the end of each relevant section, in subsections entitled Technology

Step by Step.

You should realize that the computer and calculator merely give numerical answers
and save the time and effort of doing calculations by hand. You are still responsible for un-
derstanding and interpreting each statistical concept. In addition, you should realize that
the results come from the data and do not appear magically on the computer. Doing cal-
culations by using the procedure tables will help you reinforce this idea.

The author has left it up to instructors to choose how much technology they will in-

corporate into the course.

== Technology BRG]

T1-84 Plus
Step by Step

1-26

General Information

To turn calculator on:

Press ON key.

To turn calculator off:

Press 2nd [OFF].

To reset defaults only:
1. Press 2nd, then [MEM].
2. Select 7, then 2, then 2.

The TI-84 Plus graphing calculator can be used for a variety of statistical graphs and tests.

Optional. To reset settings on calculator and clear memory (note: this will clear all settings and

programs in the calculator’s memory):

Press 2nd, then [MEM]. Then press 7, then 1, then 2.
(Also, the contrast may need to be adjusted after this.)

To adjust contrast (if necessary):

Press 2nd. Then press and hold A to darken or Y to lighten contrast.



Section 1-5 Computers and Calculators 27

To clear screen:

Press CLEAR.

(Note: This will return you to the screen you were using.)

To display a menu:

Press appropriate menu key. Example: STAT.

To return to home screen:

Press 2nd, then [QUIT].

To move around on the screens:

Use the arrow keys.

To select items on the menu:

Press the corresponding number or move the cursor to the item, using the arrow keys. Then
press ENTER.

(Note: In some cases, you do not have to press ENTER, and in other cases you may need to
press ENTER twice.)

Entering Data
To enter single-variable data (clear the old list if necessary, see “Editing Data”):
1. Press STAT to display the Edit menu.
2. Press ENTER to select 1:Edit.
3. Enter the data in Ly and press ENTER after each value.
4. After all data values are entered, press STAT to get back to the Edit menu or 2nd [QUIT] to end.

Example TI1-1
Enter the following data values in Lq: 213, 208, 203, 215, 222.
To enter multiple-variable data: Output
The TI-84 Plus will take up to six lists designated L1 Lz Lz i
Ly, Lo, L, Ly, Ls, and Le. XN I
cig
1. To enter more than one set of data values, complete the 2z
preceding steps. Then move the cursor to L, by 1t
pressing the P key. a
2. Repeat the steps in the preceding part. L‘I-IZ-E;-—“

Editing Data
To correct a data value before pressing ENTER, use < and retype the value and press ENTER.
To correct a data value in a list after pressing ENTER, move the cursor to the incorrect value in
list and type in the correct value. Then press ENTER.
To delete a data value in a list:
Move the cursor to a value and press DEL.
To insert a data value in a list:
1. Move cursor to position where data value is to be inserted; then press 2nd [INS].
2. Type data value; then press ENTER.

To clear a list:

1. Press STAT, then 4.
2. Enter list to be cleared. Example: To clear L4, press 2nd [L1]. Then press ENTER.

(Note: To clear several lists, follow Step 1, but enter each list to be cleared, separating them
with commas. To clear all lists at once, follow Step 1; then press ENTER.)

Sorting Data
To sort the data in a list:

1. Enter the data in L4.
2. Press STAT 2 to get SortA to sort the list in ascending order.
3. Then press 2nd [L1] ENTER.
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EXCEL
Step by Step

Excel’'s Analysis
ToolPak Add-In

1-28

The calculator will display Done. Output
4. Press STAT ENTER to display the sorted list. L1 Le Ls 1
(Note: The SortD or 3 sorts the list in descending order.) %33 """"""
cl:
Example TI1-2 ik
Sort in ascending order the data values entered in m
Example TI1-1.
Litai=

General Information

Microsoft Excel 2010 has two different ways to solve statistical problems. First, there are
built-in functions, such as STDEV and CHITEST, available from the standard toolbar by

clicking Formulas, and then selecting the Insert Function icon g‘- Another feature of Excel that

is useful for calculating multiple statistical measures and performing statistical tests for a set of

data is the Data Analysis command found in the Analysis ToolPak Add-in.
To load the Analysis ToolPak:

Click the File tab in the upper left-hand corner of an Excel workbook, then select Options in

the left-hand panel.

ey B
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O e
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1. Click Add-Ins, and then click the Go button at the bottom of the Excel Options page to the

right of the Manage tool.
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2. Check the Analysis ToolPak Add-in and click OK.

Add-Ins available:
Analysis ToolPak

|| Analysis ToolPak - VBA
Euro Currency Tools
[T solver Add-in

3. Click the Data Tab. The Analysis ToolPak will appear in the Analysis group.
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MegaStat

Later in this text you will encounter a few Excel Technology Step by Step operations that
will require the use of the MegaStat Add-in for Excel. MegaStat can be purchased from
www.mhhe.com/megastat.

29

1. Save the Zip file containing the MegaStat Excel Add-in file (MegaStat.xls) and the associated

help file on your computer’s hard drive.
2. Open the Excel software.

3. Click the File tab and select Options (as before with the installation of the Analysis
ToolPak).

4. Click the Add-Ins button. MegaStat will not appear as an Application until first installation.

5. Click Go button next to the Manage (Add-Ins) Tool at the bottom of the Excel Options
window.

6. Once the Add-Ins Checkbox appears, click Browse to locate the MegaStat.xla file on your
computer’s hard drive.
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7. Select the MegaStat.xla file from the hard drive; click the Checkbox next to it and click OK.

Add-Ins available;

Analysis ToolPak
[7] Analysis ToolPak - VBA
Euro Currency Tools

Solver Add-in

8. The MegaStat Add-in will appear when you select the Add-Ins tab in the Toolbar.

T = &
M Insert Page Layout Formulas Data Review View | Addlns '

MegaStat -

Menu Commands |
NS - (@ |
A | B ¢ g F G H | 1

}a|wim|»—n

Entering Data

1. Select a cell at the top of a column on an Excel worksheet where you want to enter data.
When working with data values for a single variable, you will usually want to enter the val-
ues into a single column.

2. Type each data value and press [Enter] or [Tab] on your keyboard.

You can also add more worksheets to an Excel workbook by clicking the Insert Worksheet
icon %4 Jocated at the bottom of an open workbook.

Example XL1-1: Opening an existing Excel workbook/worksheet
1. Open the Microsoft Office Excel 2010 program.
2. Click the File tab, then click Open.

3. Click the name of the library that contains the file, such as My documents, and then click
Open.

4. Click the name of the Excel file that you want to open and then click Open.

Note: Excel files have the extension .xls
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General Information

MINITAB statistical software provides a wide range of statistical analysis and graphing capabilities.

Take Note

In this text you will see captured MINITAB images from Windows computers running MINITAB
Release 16. If you are using an earlier or later release of MINITAB, the screens you see on your
computer may bear slight visual differences from the screens pictured in this text.

Start the Program
1. Click the Windows Start Menu, then All Programs.

2. Click the MINITAB folder and then click 7'/ Minitab 16, the program icon. The program screen
will look similar to the one shown here. You will see the Session Window, the Worksheet
Window, and perhaps the Project Manager Window.

3. Click the Project Manager icon on the toolbar to bring the project manager to the front.

> MINITAB - Untitled
o Edt Data Calc Stt Grach Editr Tools Window Heb
=6 & BRloc B iARQYd ABERDIEN. DR

& Worksheat 1 ***

W e -

[Mabko tho Project Manager activ 218

To use the program, data must be entered from the keyboard or from a file.

Entering Data from the Keyboard

In MINITAB, all the data for one variable are stored in a column. Step by step instructions for
entering these data follow.

Data
213 208 203 215 222

1. Click in row 1 of Worksheet 1***. This makes the worksheet the active window
and puts the cursor in the first cell. The small data entry arrow in the upper il M
left-hand corner of the worksheet should be pointing down. If it is not, click it Tﬂ"‘_
to change the direction in which the cursor will move when you press the 1

[Enter] key. 3|
1
2. Type in each number, pressing [Enter] after each entry, including the last ; :z:

number typed.
3. Optional: Click in the space above row 1 to type in Weight, the column label.
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Save a Worksheet File

4. Click on the File Menu. Note: This is not the same as clicking the disk icon =

5. Click Save Current Worksheet As . . .
6. In the dialog box you will need to verify three items:

a) Savein: Click on or type in the disk drive and directory where you will store your
data. This may be a thumb drive such as E:\ or a hard-drive folder such as

C:\MinitabData.

b) File Name: Type in the name of the file, such as MyData.

c) Save as Type: If using the Student Edition, we would need to use the portable file
format. The default here is MINITAB. An extension of mtw is added to

the name.

Click [Save]. The name of the worksheet will change from Worksheet 1*** to MyData.
MTP***. The triple asterisks indicate the active worksheet.

Open the Databank File

The raw data are shown in Appendix B. There is a row for each person’s data and a column for
each variable. MINITAB data files comprised of data sets used in this book, including the
Databank, are available at www.mhhe.com/bluman. Here is how to get the data from a file into

a worksheet.

1. Click File>Open Worksheet. A sequence of menu instructions will be shown this way.

Note: This is not the same as clicking the file icon & . If the dialog box says Open Project
instead of Open Worksheet, click [Cancel] and use the correct menu item. The Open
Worksheet dialog box will be displayed.

. You must check three items in this dialog box.

a) The Look In: dialog box should show the directory where the file is located.
b) Make sure the Files of Type: shows the correct type, MINITAB [*.mtp].

¢) Double-click the file name in the list box Databank.mtp. A dialog box may inform you
that a copy of this file is about to be added to the project. Click on the checkbox if you do
not want to see this warning again.

. Click the [OK] button. The data will be copied into a second worksheet. Part of the worksheet

is shown here.

T8 Databank. MTW ***
: c1 [+] a 7] [ 3 c 8 © co CnT cizT ~
D.NUMBER] AGE ED.LEVEL SMOKING EXERCISE WEIGHT SERUM. SYSTOLIC 10 SODIUM GENDER MARITAL.ST
1 1 2 1 1 120 193 126 na 136 F L
2 2 18 1 0 1 15 20 120 105 137 M s
3 3 R 2 0 0 18 1% 128 15 15 F M

a) You may maximize the window and scroll if desired.

b) C12-T Marital Status has a T appended to the label to indicate alphanumeric data.
MyData.MTW is not erased or overwritten. Multiple worksheets can be available;
however, only the active worksheet is available for analysis.

. To switch between the worksheets, select Window>MyData.MTW.
. Select File>Exit to quit. To save the project, click [Yes].
. Type in the name of the file, Chapter01. The Data Window, the Session Window, and

settings are all in one file called a project. Projects have an extension of mpj instead of mtw.
Clicking the disk icon Q on the menu bar is the same as selecting File>Save Project.
Clicking the file icon & is the same as selecting File>Open Project.

. Click [Save]. The mpj extension will be added to the name. The computer will return to the

Windows desktop. The two worksheets, the Session Window results, and settings are saved
in this project file. When a project file is opened, the program will start up right where you
left off. -
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*The numbers in parentheses indicate the chapter section where the material is explained.

The two major areas of statistics are descriptive
and inferential. Descriptive statistics includes the
collection, organization, summarization, and
presentation of data. Inferential statistics includes
making inferences from samples to populations,
estimations and hypothesis testing, determining
relationships, and making predictions. Inferential
statistics is based on probability theory. (1-1)"

Data can be classified as qualitative or
quantitative. Quantitative data can be either
discrete or continuous, depending on the values
they can assume. Data can also be measured by
various scales. The four basic levels of
measurement are nominal, ordinal, interval, and
ratio. (1-2)

Since in most cases the populations under study
are large, statisticians use subgroups called
samples to get the necessary data for their studies.
There are four basic methods used to obtain
samples: random, systematic, stratified, and
cluster. (1-3)

There are two basic types of statistical studies:
observational studies and experimental studies.
When conducting observational studies,
researchers observe what is happening or what has
happened and then draw conclusions based on
these observations. They do not attempt to
manipulate the variables in any way. (1-4)

When conducting an experimental study,
researchers manipulate one or more of the
independent or explanatory variables and see how
this manipulation influences the dependent or
outcome variable. (1-4)

* Finally, the applications of statistics are many

and varied. People encounter them in everyday
life, such as in reading newspapers or magazines,
listening to an MP3 player, or watching
television. Since statistics is used in almost every
field of endeavor, the educated individual should
be knowledgeable about the vocabulary,
concepts, and procedures of statistics. Also,
everyone should be aware that statistics can

be misused. (1-4)

Today, computers and calculators are used
extensively in statistics to facilitate the
computations. (1-5)

LAFF - A - DAY

“We’ve polled the entire populace, Your
Majesty, and we’ve come up with
exactly the results you ordered!”

© Dave Whitehead. King Features Syndicate.

== Important Terms

blinding 20

continuous variables 6

blocks 20 control group 19
boundary 7 convenience sample 14
census 3 cross-sectional study 18
cluster sample 14 data 3

dataset 3

completely randomized
design 20

confounding variable 19

data value or datum 3

dependent variable 19

descriptive statistics 3
discrete variables 6
double blinding 20
experimental study 18
explanatory variable 19
Hawthorne effect 19
hypothesis testing 4

independent variable 19

inferential statistics 4

interval level of
measurement 8

longitudinal study 18
matched-pair design 20
measurement scales 8

nominal level of
measurement 8
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nonsampling error 16 probability 4 ratio level of stratified sample 13
measurement 8

observational study 18 qualitative variables 6 systematic sample 12
ordinal level of quantitative variables 6 replication 20 treatment group 19
measurement 8 quasi-experimental retrospective study 18 variable 3

outcome variable 19 study 19 sample 3 volunteer sample 14
placebo effect 20 random sample 12 sampling error 14

population 3 random variable 3 statistics 2

= Review Exercises

Section 1-1 18. Categories of magazines in a physician’s office (sports,

. L . . women’s, health, men’s, news).
For Exercises 1-8, state whether descriptive or inferential )

statistics has been used. For Exercises 19-26, classify each variable as qualitative or

1. By 2040 at least 3.5 billion people will run short of quantitative.

water (World Future Society). 19. Marital status of nurses in a hospital.

2. In a sample of 100 on-the-job fatalities, 90% of the 20. Time it takes to run a marathon.
victims were men. . . .
21. Weights of lobsters in a tank in a restaurant.
3. In a survey of 1000 adults, 34% said that they posted

notes on social media websites (Source: AARP Survey). 22. Colors of automobiles in a shopping center parking

lot.
4. In a poll of 3036 adults, 32% said that they got a flu 23. Ounces of ice cream in a large milkshake.
shot at a retail clinic (Source: Harris Interactive Poll). 24. Capacity of the NFL football stadiums.
25. Ages of people living in a personal care
5. Allergy therapy makes bees go away (Source: home.
Prevention). 26. Different vitamins taken.

6. Drinking decaffeinated coffee can raise cholesterol

levels by 7% (Source: American Heart Association). For Exercises 27-34, classify each variable as discrete or

continuous.

7. T'he average stay in a hospital for 2000 patients who had 27. Number of pizzas sold by Pizza Express each day.
circulatory system problems was 4.7 days.
28. Relative humidity levels in operating rooms at local

8. Experts say that mortgage rates may soon hit bottom hospitals.

(Source: USA TODAY).
29. Number of bananas in a bunch at several local super-
markets.

Section 1-2
. ) ) . 30. Lifetimes (in hours) of 15 iPod batteries.
For Exercises 9—18, classify each as nominal-level, ordinal- .
level, interval-level, or ratio-level measurement. 31. Weights of the backpacks of first-graders on a

. . school bus.
9. Pages in the 25 best-selling mystery novels.

10. Ranki £ oolfers i 32. Number of students each day who make appointments
- Rankings of golfers in a tournament. with a math tutor at a local college.

11. Temperatures inside 10 pizza ovens. 33. Blood pressures of runners in a marathon.

12. Weights of selected cell phones.
13. Salaries of the coaches in the NFL.

34. Ages of children in a preschool.

For Exercises 35-38, give the boundaries of each value.
35. 36 inches.

14. Times required to complete a chess game.

15. Ratings of textbooks (poor, fair, good,

excellent). 36. 105.4 miles.
16. Number of amps delivered by battery chargers. 37. 72.6 tons.
17. Ages of children in a day care center. 38. 5.27 centimeters.
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Section 1-3

For Exercises 39-44, classify each sample as random, sys-
tematic, stratified, cluster, or other.

39.

40.

41.

42.

43.

44.

In a large school district, all teachers from two buildings
are interviewed to determine whether they believe the
students have less homework to do now than in previous
years.

Every seventh customer entering a shopping mall is
asked to select her or his favorite store.

Nursing supervisors are selected using random numbers
to determine annual salaries.

Every 100th hamburger manufactured is checked to de-
termine its fat content.

Mail carriers of a large city are divided into four
groups according to gender (male or female) and
according to whether they walk or ride on their routes.
Then 10 are selected from each group and interviewed
to determine whether they have been bitten by a dog in
the last year.

People are asked to phone in their response to a survey
question.

Section 1-4

For Exercises 45-48, identify each study as being either
observational or experimental.

45.

46.
47.

48.

Is Higher
Education
“Going Digital™?
—Revisited

Subjects were randomly assigned to two groups, and one
group was given an herb and the other group a placebo.
After 6 months, the numbers of respiratory tract infec-
tions each group had were compared.

A researcher stood at a busy intersection to see if the
color of the automobile that a person drives is related
to running red lights.

A researcher finds that people who are more hostile
have higher total cholesterol levels than those who are
less hostile.

Subjects are randomly assigned to four groups. Each
group is placed on one of four special diets—a low-fat
diet, a high-fish diet, a combination of low-fat diet and
high-fish diet, and a regular diet. After 6 months, the
blood pressures of the groups are compared to see if
diet has any effect on blood pressure.

STATISTICS TODAY

Review Exercises 35

For Exercises 49-52, identify the independent and depend-
ent variables for each study.

49.

50.

51.

52.

Various types of coffees are selected from local coffee
shops, and the number of milligrams of caffeine per
ounce is determined.

People who walk at least 3 miles a day are randomly

selected, and their blood triglyceride levels are meas-
ured in order to determine if the number of miles that
they walk has any influence on these levels.

In an article in the British Journal of Nutrition, two
types of mice were randomly selected. One group
received a thyme supplement for a specific time,
while another group was used as a control group
and received no supplements. The brains of the mice
were then analyzed, and it was found that the brains
of the group of mice that received the thyme supple-
ments had antioxidant levels similar to those of
younger mice. It was concluded that the thyme
supplement increased the antioxidants in the brains
of the mice.

It was found that laughing can reduce your aches and
pains as much as taking a pain pill.

For Exercises 53-58, explain why the claims of these
studies might be suspect.

53.

54.
5S.

56.

57.

58.

Based on a recent telephone survey, 72% of those
contacted shop online.

In Greenville County there are 8324 deer.

Nursing school graduates from Fairview University earn
on average $33,456.

Only 5% of men surveyed said that they liked “chick
flicks.”

A recent study shows that high school dropouts spend
less time on the Internet than those who graduated;
therefore, the Internet raises your IQ.

Most shark attacks occur in ocean water that is 3 feet
deep; therefore, it is safer to swim in deep water.

Researchers at the Pew Research Center used a telephone survey of 2142 graduates
and an online survey of 1055 college and university presidents of two-year and four-
year public and private colleges to ascertain their findings.

They found out that approximately 89% of public colleges and universities offer
online classes while 60% of four-year private colleges offer them. About 23% of the
graduates said that they have taken an online course. The college presidents predict

that in 10 years, most of their students will have taken an online course.
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As to the value of the online courses, 51% of the college presidents say that on-
line courses are of equal value to classroom courses, but only 29% of the graduates

say that they are of equal value.

Fifty-five percent of the college presidents said that plagiarism has increased over
the last 10 years, and 89% said that the use of computers and the Internet have con-

tributed to the increases.

Fifty-seven percent of recent college graduates said that they have used a
laptop, smartphone, or computer tablets in the classroom. Most colleges have no
rules for their use, but leave it up to the individual instructor to determine the limi-

tations of their use.

== Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

Probability is used as a basis for inferential
statistics.

. When the sample does not represent the population, it is

called a biased sample.

. The difference between a sampling measure and a popu-

lation measure is called a nonsampling error.

. When the population of college professors is divided

into groups according to their rank (instructor, assistant
professor, etc.) and then several are selected from each
group to make up a sample, the sample is called a cluster
sample.

. The variable temperature is an example of a quantitative

variable.

. The height of basketball players is considered a continu-

ous variable.

. The boundary of a value such as 6 inches would be

5.9-6.1 inches.

Select the best answer.

8.

The number of ads on a one-hour television show is
what type of data?

a. Nominal
b. Qualitative
c. Discrete

d. Continuous

. What are the boundaries of 25.6 ounces?

a. 25-26 ounces

b. 25.55-25.65 ounces
c. 25.5-25.7 ounces

d. 20-39 ounces
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10. A researcher divided subjects into two groups
according to gender and then selected members from
each group for her sample. What sampling method was
the researcher using?

a. Cluster

b. Random

c. Systematic
d. Stratified

11. Data that can be classified according to color are
measured on what scale?

a. Nominal

b. Ratio
c¢. Ordinal
d. Interval

12. A study that involves no researcher intervention is
called

a. An experimental study.

b. A noninvolvement study.

c.  An observational study.

d. A quasi-experimental study.

13. A variable that interferes with other variables in the
study is called

a. A confounding variable.
b. An explanatory variable.
c.  An outcome variable.

d. An interfering variable.

Use the best answer to complete these statements.

14. Two major branches of statistics are and

15. Two uses of probability are and




16.

17.

18.

19.

20.

21.

22,

The group of all subjects under study is called a(n)

A group of subjects selected from the group of all
subjects under study is called a(n)

Three reasons why samples are used in statistics:
a. b. c.

The four basic sampling methods are
a. b. c. d.

A study that uses intact groups when it is not possible
to randomly assign participants to the groups is called
a(n) study.

In a research study, participants should be assigned to
groups using methods, if possible.

For each statement, decide whether descriptive or
inferential statistics is used.

a. The average life expectancy in New Zealand is 78.49
years (Source: World Factbook).

b. A diet high in fruits and vegetables will lower blood
pressure (Source: Institute of Medicine).

c. The total amount of estimated losses for Hurricane
Katrina was $125 billion (Source: The World
Almanac and Book of Facts).

d. Researchers stated that the shape of a person’s ears
is relative to the person’s aggression (Source:
American Journal of Human Biology).

23.

24,

25.
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e. In 2050, it is estimated that there will be 18 million
Americans who are age 85 and over (Source: U.S.
Census Bureau).

Classify each as nominal-level, ordinal-level, interval-
level, or ratio-level of measurement.

a. Rating of movies as G, PG, and R
b. Number of candy bars sold on a fund drive

Classification of automobiles as subcompact,
compact, standard, and luxury

d. Temperatures of hair dryers
e. Weights of suitcases on a commercial airliner

Classify each variable as discrete or continuous.

a. Ages of people working in a large factory

b.  Number of cups of coffee served at a
restaurant

c.  The amount of drug injections into a guinea
pig

d. The time it takes a student to drive to
school

e.  The number of gallons of milk sold each day at a
grocery store

Give the boundaries of each.

a. 32 minutes

b. 0.48 millimeter
c. 6.2 1inches

d. 19 pounds

e. 12.1 quarts

== Critical Thinking Challenges

1.

World’s Busiest Airports A study of the world’s
busiest airports was conducted by Airports Council
International. Describe three variables that one could
use to determine which airports are the busiest. What
units would one use to measure these variables? Are
these variables categorical, discrete, or continuous?

. Smoking and Criminal Behavior The results of a

study published in Archives of General Psychiatry
stated that male children born to women who smoke
during pregnancy run a risk of violent and criminal
behavior that lasts into adulthood. The results of this
study were challenged by some people in the media.
Give several reasons why the results of this study would
be challenged.

. Piano Lessons Improve Math Ability The results of a

study published in Neurological Research stated that
second-graders who took piano lessons and played a
computer math game more readily grasped math prob-
lems in fractions and proportions than a similar group
who took an English class and played the same math

game. What type of inferential study was this? Give
several reasons why the piano lessons could improve a
student’s math ability.

. ACL Tears in Collegiate Soccer Players A study of

2958 collegiate soccer players showed that in 46 anterior
cruciate ligament (ACL) tears, 36 were in women.
Calculate the percentages of tears for each gender.

a. Can it be concluded that female athletes tear their
knees more often than male athletes?

b. Comment on how this study’s conclusion might
have been reached.

. Anger and Snap Judgments Read the article entitled

“Anger Can Cause Snap Judgments” and answer the
following questions.

a. s the study experimental or observational?
b. What is the independent variable?

c.  What is the dependent variable?
d

Do you think the sample sizes are large enough to
merit the conclusion?
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e. Based on the results of the study, what changes c. What is the dependent variable?
would you recommend to persons to help them
reduce their anger?

Suggest some confounding variables that may have
influenced the results of the study.

6. Hostile Children Fight Unemployment Read the arti- e. Identify the three groups of subjects used in the
cle entitled “Hostile Children Fight Unemployment” study.
and answer the following questions.

a. Is the study experimental or observational?
b.  What is the independent variable?

LXTTe73:1 CAN CAUSE SNAP JUDGMENTS

Anger can make a normally  angry subjects were quicker to connect
unbiased person act with negatively charged words—Ilike war,
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prejudice, according to a forthcoming
study in the journal Psychological
Science.

Assistant psychology professors
David DeSteno at Northeastern
University in Boston and Nilanjana
Dasgupta at the University of
Massachusetts, Amherst, randomly
divided 81 study participants into two
groups and assigned them a writing
task designed to induce angry, sad or
neutral feelings. In a subsequent test
to uncover nonconscious associations,

death and vomit—with members of the
opposite group—even though the
groupings were completely arbitrary.
“These automatic responses guide
our behavior when we’re not paying
attention,” says DeSteno, and they can
lead to discriminatory acts when there
is pressure to make a quick decision.
“If you’re aware that your emotions
might be coloring these gut reactions,”
he says, “you should take time to
consider that possibility and adjust
your actions accordingly.”
—Eric Strand

Source: Reprinted with permission from Psychology Today, Copyright © (2004) Sussex Publishers, Inc.

UNEMPLOYMENT

Hostile Children Fight Unemployment

ggressive children may be

destined for later long-term
unemployment. In a study that began
in 1968, researchers at the University
of Jyvaskyla in Finland examined
about 300 participants at ages
8, 14, 27, and 36. They looked for
aggressive behaviors like hurting
other children, kicking objects when
angry, or attacking others without
reason.

Their results, published recently in
the International Journal of Behavioral
Development, suggest that children
with low self-control of emotion
—especially aggression—were
significantly more prone to long-term
unemployment. Children with
behavioral  inhibitions—such  as
passive and anxious behaviors—were
also indirectly linked to unemployment

as they lacked the preliminary initiative
needed for school success. And while
unemployment rates were high in
Finland during the last data collection,
jobless  participants who  were
aggressive as children were less likely
to have a job two years later than their
nonaggressive counterparts.

Ongoing unemployment can have
serious psychological consequences,
including depression, anxiety and
stress. But lead researcher Lea
Pulkkinen, Ph.D., a Jyvaskyla
psychology professor, does have
encouraging news for parents:
Aggressive children with good social
skills and child-centered parents were
significantly  less likely to be
unemployed for more than two years
as adults.

—Tanya Zimbardo

Source: Reprinted with permission from Psychology Today, Copyright © (2001) Sussex Publishers, Inc.
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== Data Projects

1. Business and Finance Investigate the types of data that things such as blood type, cholesterol level, smoking
are collected regarding stock and bonds, for example, status, and body mass index. Find as many data
price, earnings ratios, and bond ratings. Find as many items as you can. For each, identify the level of
types of data as possible. For each, identify the level of measurement as nominal, ordinal, interval, or ratio.
measurement as nominal, ordinal, interval, or ratio. For For any quantitative data, also note if they are discrete
any quantitative data, also note if they are discrete or or continuous.
continuous. . Politics and Economics Every 10 years since 1790,
2. Sports and Leisure Select a professional sport. Investi- the federal government has conducted a census of

gate the types of data that are collected about that sport,
for example, in baseball, the level of play (A, AA, AAA,
Major League), batting average, and home-run hits. For
each, identify the level of measurement as nominal,
ordinal, interval, or ratio. For any quantitative data, also
note if they are discrete or continuous.

. Technology Music organization programs on computers

and music players maintain information about a song,
such as the writer, song length, genre, and your personal
rating. Investigate the types of data collected about a
song. For each, identify the level of measurement as
nominal, ordinal, interval, or ratio. For any quantitative
data, also note if they are discrete or continuous.

. Health and Wellness Think about the types of data

that can be collected about your health and wellness,

= Answers to Applying the Concepts

U.S. residents. Investigate the types of data that were
collected in the 2010 census. For each, identify the
level of measurement as nominal, ordinal, interval, or
ratio. For any quantitative data, also note if they are
discrete or continuous. Use the library or a genealogy
website to find a census form from 1860. What types
of data were collected? How do the types of data
differ?

. Your Class Your school probably has a database that

contains information about each student, such as age,
county of residence, credits earned, and ethnicity. Inves-
tigate the types of student data that your college collects
and reports. For each, identify the level of measurement
as nominal, ordinal, interval, or ratio. For any quantita-
tive data, also note if they are discrete or continuous.

Section 1-1 Attendance and Grades

1.

The variables are grades and attendance.

. Even though the number of fatalities for the railroad in-

dustry is lowest, you should consider the fact that fewer
people use the railroads to travel than the other industries.

2. The data consist of specific grades and attendance R . . .
numbers p g . A person’s transportation choice might also be affected
: by convenience, cost, service, availability, etc.
3. These are descriptive statistics; however, if an inference

were made to all students, then that would be inferential
statistics.

. The population under study is students at Manatee

Community College (MCC).

. While not specified, we probably have data from a

. Answers will vary. The railroad industry had the fewest

fatalities followed by water vehicle accidents while the
aircraft accidents were about three times as many as the
water vehicle accidents. Of course, the most fatalities
occurred in highway accidents.

sample of MCC students. Section 1-3 American Culture and Drug Abuse

6. Based on the data, it appears that, in general, the better Answers will vary, so this is one possible answer.

your attendance, the higher your grade. 1. T used a telephone survey. The advantage to my survey

Section 1-2 Fatal Transportation Injuries

1.

The variables are transportation industry and fatal
injuries.

. Transportation industry is a qualitative variable, and the

number of fatal injuries is a quantitative variable.

3. The number of fatalities is discrete.

. The type of industry is nominal, and the number of

fatalities is ratio.

method is that this was a relatively inexpensive survey
method (although more expensive than using the mail)
that could get a fairly sizable response. The disadvan-
tage to my survey method is that I have not included
anyone without a telephone. (Note: My survey used a
random dialing method to include unlisted numbers
and cell phone exchanges.)

. A mail survey also would have been fairly inexpensive,

but my response rate may have been much lower than
what I got with my telephone survey. Interviewing
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would have allowed me to use follow-up questions and
to clarify any questions of the respondents at the time of
the interview. However, interviewing is very labor- and
cost-intensive.

. I used ordinal data on a scale of 1 to 5. The scores

were 1 = strongly disagree, 2 = disagree, 3 = neutral,
4 = agree, 5 = strongly agree.

. The random method that I used was a random dialing

method.

. To include people from each state, I used a stratified

random sample, collecting data randomly from each of
the area codes and telephone exchanges available.

. This method allowed me to make sure that I had repre-

sentation from each area of the United States.

. Convenience samples may not be representative of the

population, and a convenience sample of adolescents
would probably differ greatly from the general popula-
tion with regard to the influence of American culture on
illegal drug use.

Section 1-4 Just a Pinch Between Your Cheek
and Gum

1.

This was an experiment, since the researchers imposed
a treatment on each of the two groups involved in the
study.

1-40

. The independent variable is whether the participant

chewed tobacco or not. The dependent variables are the
students’ blood pressures and heart rates.

. The treatment group is the tobacco group—the other

group was used as a control.

. A student’s blood pressure might not be affected by

knowing that he or she was part of a study. However,
if the student’s blood pressure were affected by this
knowledge, all the students (in both groups) would be
affected similarly. This might be an example of the
placebo effect.

. Answers will vary. One possible answer is that

confounding variables might include the way that
the students chewed the tobacco, whether or not the
students smoked (although this would hopefully have
been evened out with the randomization), and that all
the participants were university students.

. Answers will vary. One possible answer is that the study

design was fine, but that it cannot be generalized be-
yond the population of university students (or people
around that age).
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= STATISTICS TODAY
How Your Identity Can Be Stolen

Identity fraud is a big business today —more than 8.1 million people
were victims. The total amount of the fraud in 2010 was $37 billion.
The average amount of the fraud for a victim is $4607, and the aver-
age time to correct the problem is 40 hours. The ways in which a
person’s identity can be stolen are presented in the following table:

Lost or stolen wallet, checkbook, or credit card 38%
Friends, acquaintances 15
Corrupt business employees 15
Computer viruses and hackers 9
Stolen mail or fraudulent change of address 8
Online purchases or transactions 4
Other methods 11

Source: Javelin Strategy & Research; Council of Better Business Bureau, Inc.

Looking at the numbers presented in a table does not have the
same impact as presenting numbers in a well-drawn chart or graph.
The article did not include any graphs. This chapter will show you
how to construct appropriate graphs to represent data and help you
to get your point across to your audience.

See Statistics Today—Revisited at the end of the chapter for
some suggestions on how to represent the data graphically.

-

-

(Inset) Copyright 2005 Nexus Energy Software Inc. All Rights Reserved.
Used with Permission.
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Introduction

2-1  Organizing Data

2-2  Histograms, Frequency Polygons,
and Ogives

2-3 Other Types of Graphs
Summary

OBJECTIVES

After completing this chapter, you should be able to

0 Organize data using a frequency
distribution.

Represent data in frequency distributions
graphically, using histograms, frequency
polygons, and ogives.

charts, time series graphs, pie graphs, and

6 Represent data using bar graphs, Pareto
dotplots.

Draw and interpret a stem and leaf plot.
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Introduction

When conducting a statistical study, the researcher must gather data for the particular
variable under study. For example, if a researcher wishes to study the number of people
who were bitten by poisonous snakes in a specific geographic area over the past several
years, he or she has to gather the data from various doctors, hospitals, or health
departments.

To describe situations, draw conclusions, or make inferences about events, the re-
searcher must organize the data in some meaningful way. The most convenient method of
organizing data is to construct a frequency distribution.

After organizing the data, the researcher must present them so they can be understood
by those who will benefit from reading the study. The most useful method of presenting
the data is by constructing statistical charts and graphs. There are many different types of
charts and graphs, and each one has a specific purpose.

This chapter explains how to organize data by constructing frequency distributions
and how to present the data by constructing charts and graphs. The charts and graphs il-
lustrated here are histograms, frequency polygons, ogives, pie graphs, Pareto charts, and
time series graphs. A graph that combines the characteristics of a frequency distribution
and a histogram, called a stem and leaf plot, is also explained.

Organizing Data

OBJECTIVE @

Organize data using
a frequency distribution.

IUnusual Stats

Of Americans 50 years
old and over, 23% think
their greatest achieve-
ments are still ahead of
them.

Suppose a researcher wished to do a study on the ages of the 50 wealthiest people in the
world. The researcher first would have to get the data on the ages of the people. In this
case, these ages are listed in Forbes Magazine. When the data are in original form, they
are called raw data and are listed next.

Since little information can be obtained from looking at raw data, the researcher or-
ganizes the data into what is called a frequency distribution.

A frequency distribution is the organization of raw data in table form, using classes
and frequencies.

Each raw data value is placed into a quantitative or qualitative category called a class. The
frequency of a class then is the number of data values contained in a specific class. A fre-
quency distribution is shown for the preceding data set.
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Class limits | Tally Frequency
27-35 / 1
36-44 1/ 3
45-53 TR 9
54-62 TR TR TR 15
63-71 TR IR 10
72-80 /1] 3
81-89 L/ 7
90-98 /!

50

Now some general observations can be made from looking at the frequency distri-
bution. For example, it can be stated that the majority of the wealthy people in the study
are over 45 years old.

The classes in this distribution are 27-35, 3644, etc. These values are called class
limits. The data values 27, 28, 29, 30, 31, 32, 33, 34, 35 can be tallied in the first class; 36,
37,38, 39, 40, 41, 42, 43, 44 in the second class; and so on.

Two types of frequency distributions that are most often used are the categorical
frequency distribution and the grouped frequency distribution. The procedures for con-
structing these distributions are shown now.

Categorical Frequency Distributions

The categorical frequency distribution is used for data that can be placed in specific cate-
gories, such as nominal- or ordinal-level data. For example, data such as political affiliation,
religious affiliation, or major field of study would use categorical frequency distributions.

EXAMPLE 2-1 Distribution of Blood Types

Twenty-five army inductees were given a blood test to determine their blood type. The
data set is

A B B AB 0
0 0 B AB B
B B 0 A 0
A 0 0 0 AB
AB A 0 B A

Construct a frequency distribution for the data.

Since the data are categorical, discrete classes can be used. There are four blood types:
A, B, O, and AB. These types will be used as the classes for the distribution.

The procedure for constructing a frequency distribution for categorical data is
given next.

Step1 Make a table as shown.

A B C D
Class | Tally | Frequency | Percent
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Step 2 Tally the data and place the results in column B.
Step 3 Count the tallies and place the results in column C.

Step 4 Find the percentage of values in each class by using the formula

%Zi-100
n

where f = frequency of the class and n = total number of values. For exam-
ple, in the class of type A blood, the percentage is

5

%:g

+ 100 = 20%

Percentages are not normally part of a frequency distribution, but they can
be added since they are used in certain types of graphs such as pie graphs.
Also, the decimal equivalent of a percent is called a relative frequency.

Step 5 Find the totals for columns C (frequency) and D (percent). The completed
table is shown. It is a good idea to add the percent column to make sure it
sums to 100%. This column won’t always sum to 100% because of rounding.

A B C D
Class Tally Frequency | Percent
A | T 5 20
B | /I 7 28
o | LI 9 36
AB | /1 4| 18

Total 25 100%

For the sample, more people have type O blood than any other type.

Grouped Frequency Distributions

When the range of the data is large, the data must be grouped into classes that are more
than one unit in width, in what is called a grouped frequency distribution. For example,
a distribution of the blood glucose levels in milligrams per deciliter (mg/dL) for 50 ran-
domly selected college students is shown.

I Unusual Stats ﬁ::.stz bofl:ta;f'ies Tally Frequency
Six percent of Americans

say they find life dull. 58-64 | 57.5-645 |/

65-71 | 64.5-71.5 | L/ 6

72-78 | 71.5-785 | LA 10

79-85 78.5-85.5 TRLTAL T 14

86-92 85.5-92.5 TRLTAL /] 12

93-99 92.5-99.5 T 5

100-106 | 99.5-106.5 | // 2

Total 50

The procedure for constructing the preceding frequency distribution is given in
Example 2-2; however, several things should be noted. In this distribution, the values 58
and 64 of the first class are called class limits. The lower class limit is 58; it represents
the smallest data value that can be included in the class. The upper class limit is 64; it



IUnusual Stats

One out of every
hundred people in
the United States is
color-blind.

Section 2—-1 Organizing Data 45

represents the largest data value that can be included in the class. The numbers in the sec-
ond column are called class boundaries. These numbers are used to separate the classes
so that there are no gaps in the frequency distribution. The gaps are due to the limits; for
example, there is a gap between 64 and 65.

Students sometimes have difficulty finding class boundaries when given the class
limits. The basic rule of thumb is that the class limits should have the same decimal
place value as the data, but the class boundaries should have one additional place value
and end in a 5. For example, if the values in the data set are whole numbers, such as 59,
68, and 82, the limits for a class might be 58—64, and the boundaries are 57.5-64.5. Find
the boundaries by subtracting 0.5 from 58 (the lower class limit) and adding 0.5 to 64
(the upper class limit).

Lower limit — 0.5 = 58 — 0.5 = 57.5 = lower boundary
Upper limit + 0.5 = 64 + 0.5 = 64.5 = upper boundary

If the data are in tenths, such as 6.2, 7.8, and 12.6, the limits for a class hypothetically
might be 7.8-8.8, and the boundaries for that class would be 7.75-8.85. Find these values
by subtracting 0.05 from 7.8 and adding 0.05 to 8.8.

Class boundaries are not always included in frequency distributions; however, they
give a more formal approach to the procedure of organizing data, including the fact that
sometimes the data have been rounded. You should be familiar with boundaries since you
may encounter them in a statistical study.

Finally, the class width for a class in a frequency distribution is found by subtracting
the lower (or upper) class limit of one class from the lower (or upper) class limit of the
next class. For example, the class width in the preceding distribution on the distribution
of blood glucose levels is 7, found from 65 — 58 = 7.

The class width can also be found by subtracting the lower boundary from the upper
boundary for any given class. In this case, 64.5 — 57.5 = 7.

Note: Do not subtract the limits of a single class. It will result in an incorrect
answer.

The researcher must decide how many classes to use and the width of each class.
To construct a frequency distribution, follow these rules:

1. There should be between 5 and 20 classes. Although there is no hard-and-fast
rule for the number of classes contained in a frequency distribution, it is of
utmost importance to have enough classes to present a clear description of the
collected data.

2. It is preferable but not absolutely necessary that the class width be an odd number.
This ensures that the midpoint of each class has the same place value as the data.
The class midpoint X, is obtained by adding the lower and upper boundaries and
dividing by 2, or adding the lower and upper limits and dividing by 2:

_ lower boundary + upper boundary

X, 2

or

_lower limit + upper limit

X, >

For example, the midpoint of the first class in the example with glucose levels is

58 +64 _ 61 575 + 645 _

> or > 61

The midpoint is the numeric location of the center of the class. Midpoints are
necessary for graphing (see Section 2-2). If the class width is an even number, the

2-5
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midpoint is in tenths. For example, if the class width is 6 and the boundaries are 5.5
and 11.5, the midpoint is

554115 _ 17 _

> > 8.5

Rule 2 is only a suggestion, and it is not rigorously followed, especially when a
computer is used to group data.

3. The classes must be mutually exclusive. Mutually exclusive classes have nonover-
lapping class limits so that data cannot be placed into two classes. Many times,
frequency distributions such as this

Age

10-20
20-30
30-40
40-50

are found in the literature or in surveys. If a person is 40 years old, into which class
should she or he be placed? A better way to construct a frequency distribution is to
use classes such as

Age

10-20
21-31
32-42
43-53

Recall that boundaries are mutually exclusive. For example, when a class boundary
18 5.5 to 10.5, the data values that are included in that class are values from 6 to 10.
A data value of 5 goes into the previous class, and a data value of 11 goes into the
next-higher class.

4. The classes must be continuous. Even if there are no values in a class, the class
must be included in the frequency distribution. There should be no gaps in a fre-
quency distribution. The only exception occurs when the class with a zero fre-
quency is the first or last class. A class with a zero frequency at either end can be
omitted without affecting the distribution.

5. The classes must be exhaustive. There should be enough classes to accommodate all
the data.

6. The classes must be equal in width. This avoids a distorted view of the data.

One exception occurs when a distribution has a class that is open-ended. That
is, the first class has no specific lower limit, or the last class has no specific upper
limit. A frequency distribution with an open-ended class is called an open-ended
distribution. Here are two examples of distributions with open-ended classes.

Age Frequency Minutes Frequency
10-20 3 Below 110 16
21-31 6 110-114 24
32-42 4 115-119 38
43-53 10 120-124 14
54 and above 8 125-129 5

The frequency distribution for age is open-ended for the last class, which means
that anybody who is 54 years or older will be tallied in the last class. The distribution
for minutes is open-ended for the first class, meaning that any minute values below
110 will be tallied in that class.



IUnusual Stats

America’s most popular
beverages are soft
drinks. It is estimated
that, on average, each
person drinks about

52 gallons of soft drinks
per year, compared

to 22 gallons of beer.
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The steps for constructing a grouped frequency distribution are summarized in the
following Procedure Table.

Procedure Table

Constructing a Grouped Frequency Distribution

Step 1 Determine the classes.
Find the highest and lowest values.
Find the range.
Select the number of classes desired.
Find the width by dividing the range by the number of classes and rounding up.

Select a starting point (usually the lowest value or any convenient number less
than the lowest value); add the width to get the lower limits.

Find the upper class limits.
Find the boundaries.

Step2  Tally the data.

Step 3 Find the numerical frequencies from the tallies, and find the cumulative
frequencies.

Example 2-2 shows the procedure for constructing a grouped frequency distribution,
i.e., when the classes contain more than one data value.

EXAMPLE 2-2 Record High Temperatures

These data represent the record high temperatures in degrees Fahrenheit (°F) for each of
the 50 states. Construct a grouped frequency distribution for the data, using 7 classes.

112 100 127 120 134 118 105 110 109 112
110 118 117 116 118 122 114 114 105 109
107 112 114 115 118 117 118 122 106 110
116 108 110 121 113 120 119 111 104 111
120 113 120 117 105 110 118 112 114 114

Source: The World Almanac and Book of Facts.

SOLUTION

The procedure for constructing a grouped frequency distribution for numerical data
follows.

Step1 Determine the classes.
Find the highest value and lowest value: H = 134 and L = 100.

Find the range: R = highest value — lowest value = H — L, so
R =134 —100 =34

Select the number of classes desired (usually between 5 and 20). In this case,
7 is arbitrarily chosen.

Find the class width by dividing the range by the number of classes.

o R 34
Width = number of classes 7 4.9
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I Historical Note

Florence Nightingale, a
nurse in the Crimean
War in 1854, used
statistics to persuade
government officials to
improve hospital care
of soldiers in order to
reduce the death rate
from unsanitary condi-
tions in the military
hospitals that cared for
the wounded soldiers.

Step 2
Step 3

Round the answer up to the nearest whole number if there is a remainder:

4.9 = 5. (Rounding up is different from rounding off. A number is rounded up if
there is any decimal remainder when dividing. For example, 85 +~ 6 = 14.167
and is rounded up to 15. Also, 53 + 4 = 13.25 and is rounded up to 14. Also,
after dividing, if there is no remainder, you will need to add an extra class to
accommodate all the data.)

Select a starting point for the lowest class limit. This can be the smallest data
value or any convenient number less than the smallest data value. In this case,
100 is used. Add the width to the lowest score taken as the starting point to
get the lower limit of the next class. Keep adding until there are 7 classes, as
shown, 100, 105, 110, etc.

Subtract one unit from the lower limit of the second class to get the upper
limit of the first class. Then add the width to each upper limit to get all the
upper limits.

105 —-1=104

The first class is 100-104, the second class is 105-109, etc.

Find the class boundaries by subtracting 0.5 from each lower class limit and
adding 0.5 to each upper class limit:

99.5-104.5, 104.5-109.5, etc.

Tally the data.

Find the numerical frequencies from the tallies.

The completed frequency distribution is

Class Class
limits boundaries | Tally Frequency
100-104 | 99.5-104.5 | // 2
105-109 | 104.5-109.5 | JWL/// 8
110-114 | 109.5-114.5 | T 18
115-119 | 114.5-119.5 | LI /// 13
120-124 | 119.5-124.5 | JHL// 7
125-129 | 124.5-1295 | / 1
130-134 | 129.5-1345 | / 1
Total 50

The frequency distribution shows that the class 109.5-114.5 contains
the largest number of temperatures (18) followed by the class 114.5-119.5
with 13 temperatures. Hence, most of the temperatures (31) fall between
110 and 119°F.

Sometimes it is necessary to use a cumulative frequency distribution. A camulative
frequency distribution is a distribution that shows the number of data values less than or
equal to a specific value (usually an upper boundary). The values are found by adding the
frequencies of the classes less than or equal to the upper class boundary of a specific class.
This gives an ascending cumulative frequency. In this example, the cumulative frequency
for the first class is O + 2 = 2; for the second class itis O + 2 + 8 = 10; for the third class
itis 0 + 2 + 8 + 18 = 28. Naturally, a shorter way to do this would be to just add the cu-
mulative frequency of the class below to the frequency of the given class. For example,
the cumulative frequency for the number of data values less than 114.5 can be found by
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adding 10 + 18 = 28. The cumulative frequency distribution for the data in this example
is as follows:

Cumulative frequency
Less than 99.5 0
Less than 104.5 2
Less than 109.5 10
Less than 114.5 28
Less than 119.5 41
Less than 124.5 48
Less than 129.5 49
Less than 134.5 50

Cumulative frequencies are used to show how many data values are accumulated up
to and including a specific class. In Example 2-2, of the total record high temperatures 28
are less than or equal to 114°F. Forty-eight of the total record high temperatures are less
than or equal to 124°F.

After the raw data have been organized into a frequency distribution, it will be ana-
lyzed by looking for peaks and extreme values. The peaks show which class or classes
have the most data values compared to the other classes. Extreme values, called outliers,
show large or small data values that are relative to other data values.

When the range of the data values is relatively small, a frequency distribution can be
constructed using single data values for each class. This type of distribution is called an
ungrouped frequency distribution and is shown next.

EXAMPLE 2-3 MPGs for SUVs

The data shown here represent the number of miles per gallon (mpg) that 30 selected
four-wheel-drive sport utility vehicles obtained in city driving. Construct a frequency
distribution, and analyze the distribution.

12 17 12 14 16 18
16 18 12 16 17 15
15 16 12 15 16 16
12 14 15 12 15 15
19 13 16 18 16 14

Source: Model Year Fuel Economy Guide. United States
Environmental Protection Agency.

SOLUTION

Step1 Determine the classes. Since the range of the data set is small (19 — 12 = 7),
classes consisting of a single data value can be used. They are 12, 13, 14, 15,
16, 17, 18, 19.
Note: If the data are continuous, class boundaries can be used. Subtract 0.5
from each class value to get the lower class boundary, and add 0.5 to each
class value to get the upper class boundary.

Step2 Tally the data.

Step 3 Find the numerical frequencies from the tallies, and find the cumulative
frequencies.
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I Interesting Fact

Male dogs bite children
more often than female
dogs do; however,
female cats bite children
more often than male
cats do.

The completed ungrouped frequency distribution is

Class Class
limits | boundaries | Tally Frequency
12 | 1154125 | W/ 6
13 12.5-135 | / 1
14 | 135-145 | /// 3
15 | 145-155 | T/ 6
16 | 155-165 | JAL/// 8
17 | 165-175 | // 2
18 | 17.5-185 | /// 3
19 18.5-195 | / 1

In this case, almost one-half (14) of the vehicles get 15 or 16 miles per gallon.
The cumulative frequencies are

Cumulative frequency
Less than 11.5 0
Less than 12.5 6
Less than 13.5 7
Less than 14.5 10
Less than 15.5 16
Less than 16.5 24
Less than 17.5 26
Less than 18.5 29
Less than 19.5 30

When you are constructing a frequency distribution, the guidelines presented in this
section should be followed. However, you can construct several different but correct
frequency distributions for the same data by using a different class width, a different num-
ber of classes, or a different starting point.

Furthermore, the method shown here for constructing a frequency distribution is not
unique, and there are other ways of constructing one. Slight variations exist, especially in
computer packages. But regardless of what methods are used, classes should be mutually
exclusive, continuous, exhaustive, and of equal width.

In summary, the different types of frequency distributions were shown in this sec-
tion. The first type, shown in Example 2-1, is used when the data are categorical
(nominal), such as blood type or political affiliation. This type is called a categorical
frequency distribution. The second type of distribution is used when the range is large
and classes several units in width are needed. This type is called a grouped frequency
distribution and is shown in Example 2-2. Another type of distribution is used for nu-
merical data and when the range of data is small, as shown in Example 2-3. Since each
class is only one unit, this distribution is called an ungrouped frequency distribution.

All the different types of distributions are used in statistics and are helpful when one
is organizing and presenting data.

The reasons for constructing a frequency distribution are as follows:

1. To organize the data in a meaningful, intelligible way.

2. To enable the reader to determine the nature or shape of the distribution.

3. To facilitate computational procedures for measures of average and spread (shown
in Sections 3—1 and 3-2).
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4. To enable the researcher to draw charts and graphs for the presentation of data
(shown in Section 2-2).

5. To enable the reader to make comparisons among different data sets.

The factors used to analyze a frequency distribution are essentially the same as those
used to analyze histograms and frequency polygons, which are shown in Section 2-2.

== Applying the Concepts 2-1

Ages of Presidents at Inauguration

The data represent the ages of our Presidents at the time they were first inaugurated.

1. Were the data obtained from a population or a sample? Explain your answer.
2. What was the age of the oldest President?
3. What was the age of the youngest President?

4. Construct a frequency distribution for the data. (Use your own judgment as to the number of
classes and class size.)

5. Are there any peaks in the distribution?
6. 1dentify any possible outliers.

7. Write a brief summary of the nature of the data as shown in the frequency distribution.

See page 108 for the answers.

1. List five reasons for organizing data into a frequency For Exercises 9—12, show frequency distributions that are
distribution. incorrectly constructed. State the reasons why they are
wrong.
2. Name the three types of frequency distributions, and
explain when each should be used. 9. Class Frequency
3. How many classes should frequency distributions have? 27-32 1
Why should the class width be an odd number? 33-38 0
39-44 6
4. What are open-ended frequency distributions? Why are 45-49 4
they necessary? 50-55 2
For Ex‘ercises 5-8, find the class boundaries, midpoints, 10. Class Frequency
and widths for each class.
5. 43-47 5-9 1
9-13 2
6. 125-131 13-17 5
17-20 6
7. 8.24-11.36 20-24 3
8. 16.3-18.5
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11.

12.

13.

14.

15.
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Class Frequency
123-127 3
128-132 7
138-142 2
143-147 19
Class Frequency
9-13 1
14-19 6
20-25 2
26-28 5
29-32 9
Favorite Sport Fifty people were asked to identify

their favorite sport. The responses were F = professional
football, C = college football, B = baseball, and A =
auto racing. Construct a categorical frequency distribu-
tion for the data. Which class has the most data values,
and which class has the fewest data values? (Based on
information from a Harris Interactive survey.)
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Trust in Internet Information A survey was taken on
how much trust people place in the information they
read on the Internet. Construct a categorical frequency
distribution for the data. A = trust in all that they read,
M = trust in most of what they read, H = trust in about
one-half of what they read, S = trust in a small portion
of what they read. (Based on information from the
UCLA Internet Report.)

M M M A H
S M M M M
M M H M M
A M M M H
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Eating at Fast Food Restaurants A survey was taken
of 50 individuals. They were asked how many days per
week they ate at a fast-food restaurant. Construct a
frequency distribution using 8 classes (0—7). Based on
the distribution, how often did most people eat at a
fast-food restaurant?

1 3 4 0 4
5 2 3 1
2 2 2 2 2
2 2 2 2 3
2 2 5 2 4
2 4 5 2 1
4 1 3 2 2
2 0 7 2 3
2 2 2 5 2
3 3 4 1 3

16. Ages of Dogs The ages of 20 dogs in a pet shelter
are shown. Construct a frequency distribution using

7 classes.

5 8 7 6 3
9 4 4 5 8
7 4 7 5 7
3 5 8 4 9

17. Energy Used by Plasma TVs Forty plasma TVs were
tested, and the number of watts per hour that they used

while running for 4 hours per day were recorded.
Construct a frequency distribution for the data. Use

6 classes.

480 503 514 472 465
473 475 500 502 506
492 477 483 475 481
512 473 488 485 503
508 484 486 499 512
485 468 507 501 470
497 479 492 468 492
466 472 483 511 481

18. Stories in the World’s Tallest Buildings The number

of stories in each of a sample of the world’s 30 tallest
buildings follows. Construct a grouped frequency
distribution and a cumulative frequency distribution
with 7 classes.

88 88 110 88 80 69 102 78 70 55
79 8 80 100 60 90 77 55 75 55
54 60 75 64 105 56 71 70 65 72

Source: New York Times Almanac.

19. Ages of Declaration of Independence Signers The
ages of the signers of the Declaration of Independence
are shown. (Age is approximate since only the birth
year appeared in the source, and one has been omitted
since his birth year is unknown.) Construct a grouped
frequency distribution and a cumulative frequency
distribution for the data, using 7 classes.

41 54 47 40 39 35 50 37 49 42 70
44 52 39 50 40 30 34 69 39 45 33
44 63 60 27 42 34 50 42 52 38 36
35 43 48 46 31 27 55 63 46 33 60
35 46 45 34 53 50 50

Source: The Universal Almanac.

20.
of the governors of 25 randomly selected states.
Construct a grouped frequency distribution with

32
42
45
62

Salaries of Governors Here are the salaries (in dollars)

6 classes.

112,895 117,312 140,533 110,000 115,331
95,000 177,500 120,303 139,590 150,000

173,987 130,000 133,821 144269 142,542

150,000 145,885 105,000 93,600 166,891

130,273 70,000 113,834 117,817 137,092

Source: World Almanac.

21. Charity Donations A random sample of 30 large
companies in the United States shows the amount, in
millions of dollars, that each company donated to



22,

23.

24.

charity for a specific year. Construct a frequency
distribution for the data, using 9 classes.

26 25 19 31 14
48 35 43 25 46
17 21 57 58 34
41 12 27 15 53
16 63 82 23 52
56 75 19 26 88

Unclaimed Expired Prizes The number of unclaimed
expired prizes (in millions of dollars) for lottery tickets
bought in a sample of states is shown. Construct a
frequency distribution for the data, using 5 classes.

28.5 51.7 19 5
2 1.2 14 14.6
0.8 11.6 35 30.1
1.7 1.3 13 14
NFL Payrolls The data show the NFL team

payrolls (in millions of dollars) for a specific year.
Construct a frequency distribution for the payroll,
using 7 classes.

99 105 106 102
102 93 109 106

71 91 103 118

97 100 107 103

94 109 100 98

84 92 98 110

94 104 98 123
102 99 100 107
Source: NFL.

Consumption of Natural Gas Construct a frequency
distribution for the energy consumption of natural gas
(in billions of Btu) by the 50 states and the District of
Columbia. Use 9 classes.

474 475 205 639 197 344 3 409 247 66
377 87 747 1166 223 248 958 406 251 3462
2391 514 371 58 224 530 317 267 769 9
188 289 76 678 331 52 214 165 255 319
34 1300 284 834 114 1082 73 62 95 393
146

Source: Time Almanac.

25.

26.

21

35
33
23

4 260 253 193
27.1 292 245 295
2 379 247 31.0
9 248 31.7 25.6
S5 250 21.8 252
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Average Wind Speeds A sample of 40 large cities was
selected, and the average of the wind speeds was
computed for each city over one year. Construct a
frequency distribution, using 7 classes.

12.2 9.1 11.2 9.0
10.5 8.2 8.9 12.2
9.5 10.2 7.1 11.0
6.2 7.9 8.7 8.4
8.9 8.8 7.1 10.1
8.7 10.5 10.2 10.7
7.9 8.3 8.7 8.7
10.4 1.1 12.3 10.7
1.7 7.8 11.8 10.5
9.6 9.6 8.6 10.3

Source: World Almanac and Book of Facts.

Percentage of People Who Completed 4 or More
Years of College Listed by state are the percentages
of the population who have completed 4 or more
years of a college education. Construct a frequency
distribution with 7 classes.

29.5 350
22.1 243
18.9 245
257 24.1
28.7 33.6

34.7
28.8
27.0
22.8
33.6

26.1 25.8
20.0 204
27.5 21.8
28.3 25.8
30.3 17.3

234
26.7
325
29.8
254

Source: NY Times Almanac.

== Extending the Concepts

27.

28.

JFK Assassination A researcher conducted a survey
asking people if they believed more than one person was
involved in the assassination of John F. Kennedy. The
results were as follows: 73% said yes, 19% said no, and
9% had no opinion. Is there anything suspicious about
the results?

The Value of Pi The ratio of the circumference of a
circle to its diameter is known as 7 (pi). The value of
7r 18 an irrational number, which means that the decimal

part goes on forever and there is no fixed sequence of
numbers that repeats. People have found the decimal
part of 7 to over a million places. We can statistically
study the number. Shown here is the value of 7 to

40 decimal places. Construct an ungrouped frequency
distribution for the digits. Based on the distribution, do
you think each digit appears equally in the number?

3.1415926535897932384626433832795028841971
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ERETONGIGLIA  Step by Step

EXCEL
Step by Step

Categorical Frequency Table (Qualitative or Discrete Data)

1.

A Ui A W N

In an open workbook, select cell A1 and type in all the blood types from Example 2—1 down
column A.

. Type in the variable name Blood Type in cell B1.
. Select cell B2 and type in the four different blood types down the column.
. Type in the name Count in cell C1.

. Select cell C2. From the toolbar, select the Formulas tab on the toolbar.

S

. Select the Insert Function icon -, then select the Statistical category in the Insert Function

dialog box.

. Select the Countif function from the function name list.
. In the dialog box, type A1:A25 in the Range box. Type in the blood type “A” in quotes in the

Criteria box. The count or frequency of the number of data corresponding to the blood type
should appear below the input. Repeat for the remaining blood types.

. After all the data have been counted, select cell C6 in the worksheet.
10.

From the toolbar select Formulas, then AutoSum and type in C2:C5 to insert the total
frequency into cell C6.

Function Arguments

COUNTIF
Range |a1:425 = AL 0T O A

Criteria "4 -

-5

Counks the number of cels witt :\E mest thy it
Criteria is the condition in the form of & number, expression, or text that

defines which ceds wall be counted.
Formeda resl = §

e —— =

After entering data or a heading into a worksheet, you can change the width of a column to fit the
input. To automatically change the width of a column to fit the data:

1.
2.
3.

Select the column or columns that you want to change.
On the Home tab, in the Cells group, select Format.
Under Cell Size, click Autofit Column Width.

Making a Grouped Frequency Distribution (Quantitative Data)

A Ui A W N

. Press [Ctrl]-N for a new workbook.

. Enter the raw data from Example 2-2 in column A, one number per cell.

. Enter the upper class boundaries in column B.

. From the toolbar select the Data tab, then click Data Analysis.

. In the Analysis Tools, select Histogram and click [OK].

. In the Histogram dialog box, type A1:A50 in the Input Range box and type B1:B7 in the Bin

Range box.

. Select New Worksheet Ply, and check the Cumulative Percentage option. Click [OK].

. You can change the label for the column containing the upper class boundaries and expand

the width of the columns automatically after relabeling:
Select the Home tab from the toolbar.
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Highlight the columns that you want to change.
Select Format, then AutoFit Column Width.

bﬁ' b e ) C2E2-2 - Microsoft Excel non-commercial use STEEnE
| Home | set  Pagelmuut  Fomules  Dita  Review  View  Adddm L
an [ .
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Note: By leaving the Chart Output unchecked, a new worksheet will display the table only.

MINITAB Make a Categorical Frequency Table
(Qualitative or Discrete Data)
StEp by StEp 1. Type in all the blood types from Example 2—1 down C1 of the worksheet.

ABBABOOOBABBBBOAOAOOOABABAOBA
2. Click above row 1 and name the column BloodType.
3. Select Stat>Tables>Tally Individual Values.
The cursor should be blinking in the Variables dialog box. If not, click inside the dialog box.
4. Double-click C1 in the Variables list.
5. Check the boxes for the statistics: Counts, Percents, and Cumulative percents.
6. Click [OK]. The results will be displayed in the Session Window as shown.

Tally for Discrete Variables: BloodType

BloodType Count Percent CumPct
A 5 20.00 20.00
AB 4 16.00 36.00
B 7 28.00 64.00
0 9 36.00 100.00
N= 25

Make a Grouped Frequency Distribution
(Quantitative Variable)

1. Select File>New>Minitab Worksheet. A new worksheet will be added to the project.
2. Type the data used in Example 2-2 into C1. Name the column TEMPERATURES.

3. Use the instructions in the textbook to determine the class limits of 100 to 134 in
increments of 5.

In the next step you will create a new column of data, converting the numeric variable to text
categories that can be tallied.
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4. Select Data>Code>Numeric to Text.

a) The cursor should be blinking in Code data from columns. If not, click inside the box,
then double-click C1 Temperatures in the list. Only quantitative variables will be shown
in this list.

b) Click in the Into columns: then type the name of the new column, TempCodes.
¢) Press [Tab] to move to the next dialog box.
d) Type in the first interval 100:104.
Use a colon to indicate the interval from 100 to 104 with no spaces before or after the colon.
e) Press [Tab] to move to the New: column, and type the text category 100-104.
f) Continue to tab to each dialog box, typing the interval and then the category until the last

category has been entered.

The dialog box should look like the one shown.

Code  Humeric to Text

Code data from columns:
TENPERATURES
Intn eolumns:
[TenpCodea
Driginal values [eg. 1:4 12): New:
|100:104 |100 — 104
[A05:109 fits - 109
[110:114 [110 - 114
[115.119 {115 - 119
[120-124 [120 - 124
128:129 128 - 129
[130:134 [130 =134
etect || I
Help I [ oKk | Cancel

5. Click [OK]. In the worksheet, a new column of data will be created in the first empty column,

C2. This new variable will contain the category for each value in C1. The column C2-T
contains alphanumeric data.

6. Click Stat>Tables>Tally Individual Values, then double-click TempCodes in the Variables

list.

a) Check the boxes for the desired statistics, such as Counts, Percents, and Cumulative
percents.

b) Click [OK].

The table will be displayed in the Session Window. Eighteen states have high

temperatures between 110 and 114°F. Eighty-two percent of the states have record high
temperatures less than or equal to 119°F.

Tally for Discrete Variables: TempCodes

TempCodes Count Percent CumPct
100-104 2 4.00 4.00
105-109 8 16.00 20.00
110-114 18 36.00 56.00
115-119 13 26.00 82.00
120-124 7 14.00 96.00
125-129 1 2.00 98.00
130-134 1 2.00 100.00

N= 50

7. Click File>Save Project As . . ., and type the name of the project file, Ch2-1. This will save

the two worksheets and the Session Window. -
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Histograms, Frequency Polygons, and Ogives

OBJECTIVE @

Represent data in frequency
distributions graphically,
using histograms, frequency
polygons, and ogives.

I Historical Note

Karl Pearson introduced
the histogram in 1891.
He used it to show time
concepts of various
reigns of Prime
Ministers.

After you have organized the data into a frequency distribution, you can present them in
graphical form. The purpose of graphs in statistics is to convey the data to the viewers
in pictorial form. It is easier for most people to comprehend the meaning of data presented
graphically than data presented numerically in tables or frequency distributions. This is
especially true if the users have little or no statistical knowledge.

Statistical graphs can be used to describe the data set or to analyze it. Graphs are also
useful in getting the audience’s attention in a publication or a speaking presentation.
They can be used to discuss an issue, reinforce a critical point, or summarize a data set.
They can also be used to discover a trend or pattern in a situation over a period of time.

The three most commonly used graphs in research are

1. The histogram.
2. The frequency polygon.

3. The cumulative frequency graph, or ogive (pronounced o-jive).

The steps for constructing the histogram, frequency polygon, and the ogive are sum-
marized in the procedure table.

Procedure Table

Constructing a Histogram, Frequency Polygon, and Ogive

Step 1 Draw and label the x and y axes.

Step2  On the x axis, label the class boundaries of the frequency distribution for the
histogram and ogive. Label the midpoints for the frequency polygon.

Step 3 Plot the frequencies for each class, and draw the vertical bars for the histogram and

the lines for the frequency polygon and ogive.

(Note: Remember that the lines for the frequency polygon begin and end on the x axis while the
lines for the ogive begin on the x axis.)

The Histogram

The histogram is a graph that displays the data by using contiguous vertical bars
(unless the frequency of a class is 0) of various heights to represent the frequencies
of the classes.

EXAMPLE 2-4 Record High Temperatures

Construct a histogram to represent the data shown for the record high temperatures for
each of the 50 states (see Example 2-2).

Class boundaries Frequency

99.5-104.5 2
104.5-109.5 8
109.5-114.5 18
114.5-119.5 13
119.5-124.5 7
124.5-129.5 1
129.5-134.5 1




58 Chapter 2 Frequency Distributions and Graphs

I Historical Note

Graphs originated when
ancient astronomers
drew the position of the
stars in the heavens.
Roman surveyors also
used coordinates to
locate landmarks on
their maps.

The development
of statistical graphs can
be traced to William
Playfair (1759-1823),
an engineer and drafter
who used graphs to
present economic
data pictorially.

SOLUTION

Step1 Draw and label the x and y axes. The x axis is always the horizontal axis,

and the y axis is always the vertical axis.

Step 2 Represent the frequency on the y axis and the class boundaries on the
X axis.
Step 3  Using the frequencies as the heights, draw vertical bars for each class. See
Figure 2—-1.
FIGURE 2-1 Histogram for Example 2—4
y Record High Temperatures
18 1
15
g‘ 12 1
6 -
3
0

109.5° 114.5° 119.5° 124.5° 129.5° 134.5°

Temperature (°F)

99.5°

104.5°

As the histogram shows, the class with the greatest number of data values (18) is
109.5-114.5, followed by 13 for 114.5-119.5. The graph also has one peak with the
data clustering around it.

The Frequency Polygon

Another way to represent the same data set is by using a frequency polygon.

The frequency polygon is a graph that displays the data by using lines that connect
points plotted for the frequencies at the midpoints of the classes. The frequencies
are represented by the heights of the points.

Example 2-5 shows the procedure for constructing a frequency polygon. Be sure to
begin and end on the x axis.

EXAMPLE 2-5 Record High Temperatures

Using the frequency distribution given in Example 2—4, construct a frequency polygon.

SOLUTION

Step 1 Find the midpoints of each class. Recall that midpoints are found by adding

the upper and lower boundaries and dividing by 2:

99.5 + 1045 _ 102 104.5 + 109.5

) 5 = 107



FIGURE 2-2
Frequency Polygon for
Example 2-5
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and so on. The midpoints are

Class boundaries Midpoints Frequency

99.5-104.5 102 2
104.5-109.5 107 8
109.5-114.5 112 18
114.5-119.5 117 13
119.5-124.5 122 7
124.5-129.5 127 1
129.5-134.5 132 1

Step 2 Draw the x and y axes. Label the x axis with the midpoint of each class, and
then use a suitable scale on the y axis for the frequencies.

Step 3  Using the midpoints for the x values and the frequencies as the y values, plot
the points.

Step4 Connect adjacent points with line segments. Draw a line back to the x axis at
the beginning and end of the graph, at the same distance that the previous
and next midpoints would be located, as shown in Figure 2-2.

y Record High Temperatures

181 A
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[$3]
L
T

Frequency
>
t

©
L
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® L2 X

0 * } } } } } } } *~—>
102°  107°  112°  117° 122°  127°  132°
Temperature (°F)

The frequency polygon and the histogram are two different ways to represent
the same data set. The choice of which one to use is left to the discretion of the
researcher.

The Ogive

The third type of graph that can be used represents the cumulative frequencies for
the classes. This type of graph is called the cumulative frequency graph, or ogive. The
cumulative frequency is the sum of the frequencies accumulated up to the upper bound-
ary of a class in the distribution.

The ogive is a graph that represents the cumulative frequencies for the classes in a
frequency distribution.

Example 2-6 shows the procedure for constructing an ogive. Be sure to start on the
X axis.

EXAMPLE 2-6 Record High Temperatures

Construct an ogive for the frequency distribution described in Example 2—4.
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Step1  Find the cumulative frequency for each class.
Cumulative frequency
Less than 99.5 0
Less than 104.5 2
Less than 109.5 10
Less than 114.5 28
Less than 119.5 4
Less than 124.5 48
Less than 129.5 49
Less than 134.5 50

Step2 Draw the x and y axes. Label the x axis with the class boundaries. Use an
appropriate scale for the y axis to represent the cumulative frequencies.
(Depending on the numbers in the cumulative frequency columns, scales
suchas0,1,2,3,...,0r5,10, 15, 20, ..., or 1000, 2000, 3000, . . . can be
used. Do not label the y axis with the numbers in the cumulative frequency
column.) In this example, a scale of 0, 5, 10, 15, . . . will be used.

Step 3 Plot the cumulative frequency at each upper class boundary, as shown in
Figure 2-3. Upper boundaries are used since the cumulative frequencies
represent the number of data values accumulated up to the upper boundary
of each class.

Step 4  Starting with the first upper class boundary, 104.5, connect adjacent points
with line segments, as shown in Figure 2—4. Then extend the graph to the
first lower class boundary, 99.5, on the x axis.

FIGURE 2-3 Y
Plotting the Cumulative 50 1 ° °
Frequency for 4T

Example 2—-6 40 1
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Temperature (°F)

FIGURE 2-4 Record High Temperatures
Ogive for Example 2—6
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FIGURE 2-5
Finding a Specific Cumulative
Frequency

IUnusual Stats

Twenty-two percent
of Americans sleep
6 hours a day or less.
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Cumulative frequency graphs are used to visually represent how many values are
below a certain upper class boundary. For example, to find out how many record high tem-
peratures are less than 114.5°F, locate 114.5°F on the x axis, draw a vertical line up until it
intersects the graph, and then draw a horizontal line at that point to the y axis. The y axis
value is 28, as shown in Figure 2-5.

Relative Frequency Graphs

The histogram, the frequency polygon, and the ogive shown previously were constructed
by using frequencies in terms of the raw data. These distributions can be converted to dis-
tributions using proportions instead of raw data as frequencies. These types of graphs are
called relative frequency graphs.

Graphs of relative frequencies instead of frequencies are used when the proportion of
data values that fall into a given class is more important than the actual number of data
values that fall into that class. For example, if you wanted to compare the age distribution
of adults in Philadelphia, Pennsylvania, with the age distribution of adults of Erie, Penn-
sylvania, you would use relative frequency distributions. The reason is that since the pop-
ulation of Philadelphia is 1,526,006 and the population of Erie is 101,786, the bars using
the actual data values for Philadelphia would be much taller than those for the same
classes for Erie.

To convert a frequency into a proportion or relative frequency, divide the frequency
for each class by the total of the frequencies. The sum of the relative frequencies will al-
ways be 1. These graphs are similar to the ones that use raw data as frequencies, but the
values on the y axis are in terms of proportions. Example 2—7 shows the three types of
relative frequency graphs.

EXAMPLE 2-7 Miles Run per Week

Construct a histogram, frequency polygon, and ogive using relative frequencies for the
distribution (shown here) of the miles that 20 randomly selected runners ran during a
given week.

Class boundaries Frequency

5.5-10.5 1
10.5-15.5 2
15.5-20.5 3
20.5-25.5 5
25.5-30.5 4
30.5-35.5 3
35.5-40.5 2
Total 20
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SOLUTION

Step 1 Convert each frequency to a proportion or relative frequency by dividing the
frequency for each class by the total number of observations.

For class 5.5-10.5, the relative frequency is 21*0 = 0.05; for class 10.5-15.5,
the relative frequency is 3 = 0.10; for class 15.5-20.5, the relative frequency
is % = 0.15; and so on.

Place these values in the column labeled Relative frequency.

Class Relative
boundaries Midpoints frequency
5.5-10.5 8 0.05
10.5-15.5 13 0.10
15.5-20.5 18 0.15
20.5-25.5 23 0.25
25.5-30.5 28 0.20
30.5-35.5 33 0.15
35.5-40.5 38 0.10
Total 1.00

Step 2 Find the cumulative relative frequencies. To do this, add the frequency in each
class to the total frequency of the preceding class. In this case, 0 + 0.05 = 0.05,
0.05 + 0.10 = 0.15, 0.15 + 0.15 = 0.30, 0.30 + 0.25 = 0.55, etc. Place
these values in the column labeled Cumulative relative frequency.
An alternative method would be to find the cumulative frequencies and
then convert each one to a relative frequency.

Cumulative
Cumulative relative
frequency frequency
Less than 5.5 0 0.00
Less than 10.5 1 0.05
Less than 15.5 3 0.15
Less than 20.5 6 0.30
Less than 25.5 11 0.55
Less than 30.5 15 0.75
Less than 35.5 18 0.90
Less than 40.5 20 1.00

Step 3 Draw each graph as shown in Figure 2—6. For the histogram and ogive,
use the class boundaries along the x axis. For the frequency polygon, use the
midpoints on the x axis. The scale on the y axis uses proportions.

FIGURE 2-6 Histogram for Runners’ Miles
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Frequency Polygon for Runners’ Miles

0.25 1
0.20

015

Relative frequency

0.10

0.05 1

(b) Frequency polygon

Ogive for Runners’ Miles

1.00

0.80 1

0.60 1

0.40 1

Cumulative relative frequency

0.20

(c) Ogive

Distribution Shapes

When one is describing data, it is important to be able to recognize the shapes of the
distribution values. In later chapters, you will see that the shape of a distribution also
determines the appropriate statistical methods used to analyze the data.

A distribution can have many shapes, and one method of analyzing a distribution is
to draw a histogram or frequency polygon for the distribution. Several of the most
common shapes are shown in Figure 2—-7: the bell-shaped or mound-shaped, the uniform-
shaped, the J-shaped, the reverse J-shaped, the positively or right-skewed shape, the
negatively or left-skewed shape, the bimodal-shaped, and the U-shaped.

Distributions are most often not perfectly shaped, so it is not necessary to have an
exact shape but rather to identify an overall pattern.

A bell-shaped distribution shown in Figure 2—7(a) has a single peak and tapers off at
either end. It is approximately symmetric; i.e., it is roughly the same on both sides of
a line running through the center.

A uniform distribution is basically flat or rectangular. See Figure 2—7(b).

A J-shaped distribution is shown in Figure 2-7(c), and it has a few data values on the
left side and increases as one moves to the right. A reverse J-shaped distribution is the
opposite of the J-shaped distribution. See Figure 2-7(d).

When the peak of a distribution is to the left and the data values taper off to the
right, a distribution is said to be positively or right-skewed. See Figure 2—7(e). When
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FIGURE 2-7
Distribution Shapes

2-24
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(a) Bell-shaped (b) Uniform

(c) J-shaped (d) Reverse J-shaped

(e) Right-skewed (f) Left-skewed

(g) Bimodal (h) U-shaped

the data values are clustered to the right and taper off to the left, a distribution is said to
be negatively or left-skewed. See Figure 2—7(f). Skewness will be explained in detail
in Chapter 3. Distributions with one peak, such as those shown in Figure 2-7(a), (e),
and (f), are said to be unimodal. (The highest peak of a distribution indicates where the
mode of the data values is. The mode is the data value that occurs more often than any
other data value. Modes are explained in Chapter 3.) When a distribution has two peaks
of the same height, it is said to be bimodal. See Figure 2-7(g). Finally, the graph shown
in Figure 2—7(h) is a U-shaped distribution.

Distributions can have other shapes in addition to the ones shown here; however,
these are some of the more common ones that you will encounter in analyzing data.

When you are analyzing histograms and frequency polygons, look at the shape of the
curve. For example, does it have one peak or two peaks? Is it relatively flat, or is it
U-shaped? Are the data values spread out on the graph, or are they clustered around
the center? Are there data values in the extreme ends? These may be outliers. (See
Section 3-3 for an explanation of outliers.) Are there any gaps in the histogram, or does
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the frequency polygon touch the x axis somewhere other than at the ends? Finally, are the
data clustered at one end or the other, indicating a skewed distribution?

For example, the histogram for the record high temperatures in Figure 2—1 shows a
single peaked distribution, with the class 109.5-114.5 containing the largest number of
temperatures. The distribution has no gaps, and there are fewer temperatures in the high-
est class than in the lowest class.

== Applying the Concepts 2-2

Selling Real Estate

Assume you are a realtor in Bradenton, Florida. You have recently obtained a listing of the selling
prices of the homes that have sold in that area in the last 6 months. You wish to organize those data
so you will be able to provide potential buyers with useful information. Use the following data to
create a histogram, frequency polygon, and cumulative frequency polygon.

142,000 127,000 99,600 162,000 89,000 93,000 99,500

73,800 135,000 119,500 67,900 156,300 104,500 108,650
123,000 91,000 205,000 110,000 156,300 104,000 133,900
179,000 112,000 147,000 321,550 87,900 88,400 180,000
159,400 205,300 144,400 163,000 96,000 81,000 131,000
114,000 119,600 93,000 123,000 187,000 96,000 80,000
231,000 189,500 177,600 83,400 77,000 132,300 166,000

1. What questions could be answered more easily by looking at the histogram rather than the
listing of home prices?

2. What different questions could be answered more easily by looking at the frequency polygon
rather than the listing of home prices?

3. What different questions could be answered more easily by looking at the cumulative
frequency polygon rather than the listing of home prices?

4. Are there any extremely large or extremely small data values compared to the other data values?
5. Which graph displays these extremes the best?

6. Is the distribution skewed?

See page 108 for the answers.

1. Do Students Need Summer Development? For 108 Applicants who score above 107 need not enroll
randomly selected college applicants, the following in a summer developmental program. In this group,
frequency distribution for entrance exam scores was how many students do not have to enroll in the
obtained. Construct a histogram, frequency polygon, developmental program?
and ogive for the data. (The data for this exercise will 2. Bear Kills The number of bears killed in 2010 for

be used for Exercise 13 in this section.)

Class limits

52 counties in Pennsylvania is shown in the frequency

90-98

99-107
108-116
117-125
126-134

Frequency distribution. Construct a histogram, frequency polygon,
and ogive for the data. Comment on the skewness of
6 the distribution. How many counties had 75 or fewer
22 bears killed? (The data for this exercise will be used
‘2‘3 for Exercise 14 of this section.)
9
Total 108
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Class limits Frequency 6. NFL Salaries The salaries (in millions of dollars) for
1-25 18 31 NFL teams for a specific season are given in this
26-50 12 frequency distribution.
5175 7 Construct a histogram, a frequency polygon, and an
76-100 6 ogive for the data; and comment on Fhe sl}ape of the
101-125 2 dlstrlbutlon. (The. data for this exercise will be used for
126-150 3 Exercise 16 of this section.)
151-175 0 Class limits Frequency
176-200 2
201-225 0 39.9-42.8 2
226-250 2 42.9-45.8 2
— 45.9-48.8 5
Total 52 48.9-51.8 5
Source: Pennsylvania State Game Commission. 51.9-54.8 12
3. Counties, Divisions, or Parishes for 50 States The 54.9-57.8 5
number of counties, divisions, or parishes for each of Total 31

the 50 states is given below. Use the data to construct
a grouped frequency distribution with 6 classes, a

Source: NFL.com

histogram, a frequency polygon, and an ogive. Analyze 7. Super Bowl Scores The frequency distribution shows
the distribution. the total number of points scored in the Super Bowl
67 27 15 75 58 64 8 67 159 5 games from 1967 to 2012. Construct a histogram, fre-
102 44 92 99 105 120 64 16 23 14 quency polygon, and ogive for the distribution. If you
83 87 8 114 56 93 16 10 21 33 were to predict the total number of points for the next
62 100 53 88 77 36 67 546 66 Super Bowl game, what range of values would you
95 254 29 14 95 39 55 72 23 3 choose? In how many games were the total points

greater than 567
Source: World Almanac and Book of Facts.

4. Number of College Faculty The number of faculty Class limits Frequency
listed for a variety of private colleges that offer only 21-29 5
bachelor’s degrees is listed below. Use these data to 30-38 10
construct a frequency distribution with 7 classes, a 3947 13
histogram, a frequency polygon, and an ogive. Discuss 48-56 10
the shape of this distribution. What proportion of 57-65 4
schools have 180 or more faculty? 66-74 3
165 221 218 206 138 135 224 204 75-83 A

70 210 207 154 155 82 120 116 Total 46
176 162 225 214 93 380 77 135
21 161 128 310 8. Costs of Utilities The frequency distribution represents

the cost (in cents) for the utilities of states that supply

Source: World Almanac and Book of Facts. X X
much of their own power. Construct a histogram,

5. Railroad Crossing Accidents The data show the frequency polygon, and ogive for the data. Is the
number of railroad crossing accidents for the 50 states distribution skewed?
of the United States for a specific year. Construct a
histogram, frequency polygon, and ogive for the data. Class limits Frequency
Comment on the skewness of the distribution. (The 6-8 12
data in this exercise will be used for Exercise 15 in 9-11 16
this section.) 12-14 3
Class limits Frequency 15-17 1
X S ;
44-86 17 24-26 1
87-129 3 —
130-172 4 Total 33
173-215 1 9. Air Pollution One of the air pollutants that is measured
216-258 0 in selected cities is sulfur dioxide. This pollutant occurs
259-301 0 when fossil fuels are burned. This pollutant is measured
302-344 A in micrograms per cubic meter (pg/m?). The results
Total 50 obtained from a sample of 24 cities are shown in the
Source: Federal Railroad Administration. frequency distributions. One sample was taken recently,
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10.

11.

12.

and the other sample of the same cities was taken
5 years ago. Construct a histogram and compare the

two distributions.

Class Frequency Frequency
limits (now) (5 years ago)
10-14 6 5
15-19 4 4
20-24 3 2
25-29 2 3
30-34 5 6
35-39 1 2
40-44 2 1
45-49 1 1
Total 24 Total 24

Making the Grade The frequency distributions shown
indicate the percentages of public school students in
fourth-grade reading and mathematics who performed at
or above the required proficiency levels for the 50 states
in the United States. Draw histograms for each, and
decide if there is any difference in the performance of

the students in the subjects.

Reading Math
Class frequency frequency
17.5-22.5 7 5
22.5-27.5 6 9
27.5-32.5 14 11
32.5-37.5 19 16
37.5-42.5 3 8
42.5-47.5 1 1

Total 50 Total 50

Source: National Center for Educational Statistics.

Blood Glucose Levels The frequency distribution
shows the blood glucose levels (in milligrams per
deciliter) for 50 patients at a medical facility. Construct
a histogram, frequency polygon, and ogive for the data.
Comment on the shape of the distribution. What range

of glucose levels did most patients fall into?

Class limits Frequency
60-64 2
65-69 1
70-74 5
75-79 12
80-84 18
85-89 6
90-94 5
95-99 1
Total 50

Waiting Times The frequency distribution shows
the waiting times (in minutes) for 50 patients at a
walk-in medical facility. Construct a histogram,
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13.

15.

16.

17.

18.

frequency polygon, and ogive for the data. Is the
distribution skewed? How many patients waited
longer than 30 minutes?

Class limits Frequency
11-15 7
16-20 9
21-25 15
26-30 9
31-35 5
36-40 3
41-45 2
Total 50

Construct a histogram, frequency polygon, and ogive,
using relative frequencies for the data in Exercise 1 of
this section.

. Construct a histogram, frequency polygon, and ogive,

using relative frequencies for the data in Exercise 2 of
this section.

Construct a histogram, frequency polygon, and ogive,
using relative frequencies for the data in Exercise 5 of
this section.

Construct a histogram, frequency polygon, and ogive,
using relative frequencies for the data in Exercise 6 of
this section.

Cereal Calories The number of calories per serving for
selected ready-to-eat cereals is listed here. Construct a
frequency distribution, using 7 classes. Draw a
histogram, a frequency polygon, and an ogive for the
data, using relative frequencies. Describe the shape of
the histogram.

130 190 140 80 100 120 220 220 110 100
210 130 100 90 210 120 200 120 180 120
190 210 120 200 130 180 260 270 100 160
190 240 80 120 90 190 200 210 190 180
115 210 110 225 190 130

Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.

Protein Grams in Fast Food The amount of protein
(in grams) for a variety of fast-food sandwiches is
reported here. Construct a frequency distribution,
using 6 classes. Draw a histogram, a frequency
polygon, and an ogive for the data, using relative
frequencies. Describe the shape of the histogram.

23 30 20 27 44 26 35 20 29 29
25 15 18 27 19 22 12 26 34 15
27 35 26 43 35 14 24 12 23 31
40 35 38 57 22 42 24 21 27 33

Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.
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== Extending the Concepts

19. Using the histogram shown here, do the following. c.

7__

How many values are below 33.5?

d. How many values are above 30.5?

21.

oy
g
50 +
>
215 245 275 305 335 365 395 425 2 40
Class boundaries =
. = 30
a. Construct a frequency distribution; include class 2
limits, class frequencies, midpoints, and cumulative = 20
frequencies. §
b. Construct a frequency polygon. 10 4
c. Construct an ogive.
20. Using the results from Exercise 19, answer these 0

questions.

Math SAT Scores Shown is an ogive depicting the
cumulative frequency of the average mathematics SAT
scores by state. Use it to construct a histogram and a
frequency polygon.

Average Mathematics SAT Scores

 J
X

a. How many values are in the class 27.5-30.5?
b. How many values fall between 24.5 and 36.5?
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Step by Step

Constructing a Histogram

468.5 4955 522.5 549.5 576.5 603.5 630.5
Mathematics scores

To display the graphs on the screen, enter the appropriate values in the calculator, using the

WINDOW menu. The default values are X, =

—10, Xpax = 10, Yiin =

—10, and Y. = 10.

The X changes the distance between the tick marks on the x axis and can be used to change

the class width for the histogram.

To change the values in the WINDOW:
1. Press WINDOW.

2. Move the cursor to the value that needs to be changed. Then type in the desired value and

press ENTER.

3. Continue until all values are appropriate.

4. Press [2nd] [QUIT] to leave the WINDOW menu.

To plot the histogram from raw data:
1. Enter the data in L.

. Press [2nd] [STAT PLOT] ENTER.

wn A WD

the third option.
. Make sure Xlist is L.
. Make sure Freq is 1.
. Press GRAPH to display the histogram.

N2> T B

followed by < or P> keys.

. Make sure WINDOW values are appropriate for the histogram.

. Press ENTER to turn the plot 1 on, if necessary.

. Move cursor to the Histogram symbol and press ENTER, if necessary. The histogram is

. To obtain the frequency (number of data values in each class), press the TRACE key,
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Fi:Ld

rin=10¢
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=2

Output

Output

Example TI2-1

Plot a histogram for the following data from Example 2-2.

112 100
110 118
107 112
116 108
120 113

Press TRACE and use the arrow keys to determine the number of values in each group.

127 120
117 116
114 115
110 121
120 117

Section 2-2 Histograms, Frequency Polygons, and Ogives

134 118
118 122
118 117
113 120
105 110

To graph a histogram from grouped data:

1. Enter the midpoints into L.

o e N SN R W

Example TI2-2

Plot a histogram for the data from Examples 2—4 and 2-5.

. Enter the frequencies into L.

105 110
114 114
118 122
119 111
118 112

. Make sure WINDOW values are appropriate for the histogram.
. Press [2nd] [STAT PLOT] ENTER.

. Press ENTER to turn the plot on, if necessary.
Move cursor to the histogram symbol, and press ENTER, if necessary.
. Make sure Xlist is L.
. Make sure Freq is Lo.
. Press GRAPH to display the histogram.

109
105
106
104
114

69

112
109
110
111
114

Class boundaries Midpoints Frequency
99.5-104.5 102 2
104.5-109.5 107 8
109.5-114.5 112 18
114.5-119.5 117 13
119.5-124.5 122 7
124.5-129.5 127 1
129.5-134.5 132 1
Input Input Output
L1 Lz L 1 Flakz  Flakz:
aft

T e |- E&-: L L= um

11z 18 Hh- b |~

¥ 31ist il

|1 Freailz

Liii=1@2

To graph a frequency polygon from grouped data, follow the same steps as for the histogram

except change the graph type from histogram (third graph) to a line graph (second graph).

To graph an ogive from grouped data, modify the procedure for the histogram as follows:

1. Enter the upper class boundaries into L.

2. Enter the cumulative frequencies into Lp.

3. Change the graph type from histogram (third graph) to line (second graph).
4. Change the Y, from the WINDOW menu to the sample size.
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Constructing a Histogram
1. Press [Ctrl]-N for a new workbook.

EXCEL
Step by Step

2. Enter the data from Example 2-2 in column A, one number per cell.
. Enter the upper boundaries into column B.

. From the toolbar, select the Data tab, then select Data Analysis.

. In Data Analysis, select Histogram and click [OK].

A Ui A W

. In the Histogram dialog box, type A1:A50 in the Input Range box and type B1:B7 in the
Bin Range box.

E-Histogram

Input
Input Range:

Ein Range:

[ Lakels

e]

|a1:850 [EI

|B1:B7| [g]

1

Cutpuk options

O Qukput Range:

(®) Mew Worksheet Ply:
() Mew Workbook

[ Pareto (sorted histogram)
[ cumulative Percentage
Chart Oukput

7. Select New Worksheet Ply and Chart Output. Click [OK].

Histogram
20
i1 I
1 | .
e m Frequency
e ST SO N O O
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Bin

Editing the Histogram
To move the vertical bars of the histogram closer together:

1. Right-click one of the bars of the histogram, and select Format Data Series.
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2. Move the Gap Width slider all the way to the left to change the gap width of the bars in the
histogram to 0.

Series Options
Series Qveriap

To change the label for the horizontal axis:
1. Left-click the mouse over any part of the histogram.
2. Select the Chart Tools tab from the toolbar.
3. Select the Layout tab, Axis Titles and Primary Horizontal Axis Title.
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S 6 @ ] (] fallod] ] B] ) 6 6 e O L]

Picture Shapes Text Chart | Axit |lagend Data Data Aves Gridlines | Plat  Chat Chat 30 Trandlins

& Reset tn Mateh Style - Box | Title~ |Ttles=| =~ labels~ Table~ - - Arca= Wall~ Floor = Retation -
Susgt Spledion Josert ! (] Primary Horizontal dsis Title » Nune
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Once the Axis Titles text box is selected, you can type in the name of the variable represented
on the horizontal axis.
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Constructing a Frequency Polygon
1. Press [CTRL]-N for a new notebook.

2. Enter the midpoints of the data from Example 2-2 into column A and the frequencies into
column B, including labels.

Note: Classes with frequency 0 have been added at the beginning and the end to “anchor” the
frequency polygon to the horizontal axis.

B~
1 |Midpoints Frequencies
L 97 (i
20 102 2
4| 107 8
i 112 18
6 | 117 13
bl 122 7
8 | 127 i
9 | 132 1
10| 137 (]
11

3. Press and hold the left mouse button, and drag over the Frequencies (including the label)
from column B.

4. Select the Insert tab from the toolbar and the Line Chart option.
5. Select the 2-D line chart type.

View
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We will need to edit the graph so that the midpoints are on the horizontal axis.
1. Right click the mouse on any region of the chart.
2. Choose Select Data.
3. Select Edit below the Horizontal (Category) Axis Labels panel on the right.
4

. Press and hold the left mouse button, and drag over the midpoints (not including the label)
for the Axis label range, then click [OK].

5. Click [OK] on the Select Data Source box.

Inserting Labels on the Axes
1. Click the mouse on any region of the graph.
2. Select Chart Tools and then Layout on the toolbar.

3. Select Axis Titles to open the horizontal and vertical axis text boxes. Then manually type
in labels for the axes.

Changing the Title
1. Select Chart Tools, Layout from the toolbar.
2. Select Chart Title.
3. Choose one of the options from the Chart Title menu and edit.

Polygon
20 T
18 +
1A : !’\.\
12 l \
Elz l \
210
g / N\
g 2 / \ —TFrequencies
s / \
2
97 102 107 112 117 122 127 132 137
Temperatures

Constructing an Ogive

To create an ogive, use the upper class boundaries (horizontal axis) and cumulative frequencies
(vertical axis) from the frequency distribution.

1. Type the upper class boundaries (including a class with frequency 0 before the lowest
class to anchor the graph to the horizontal axis) and corresponding cumulative frequencies
into adjacent columns of an Excel worksheet.

2. Press and hold the left mouse button, and drag over the Cumulative Frequencies from
column B.

3. Select Line Chart, then the 2-D Line option.
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As with the frequency polygon, you can insert labels on the axes and a chart title for

the ogive.
Ogive
60
g |
'3"40 | /—'
£
£
3 20 4
E
d10 7
.“—99.5 1045 109.5 1145 1195 1245 1295 1345
Temperatures
MINITAB Construct a Histogram

Ste D by Ste D 1. Enter the data fr(.)rn Example 2-2, the high temperatures for the 50 states, into C1.
. Select Graph>Histogram.

. Select [Simple], then click [OK].

. Click C1 TEMPERATURES in the Graph variables dialog box.

. Click [OK]. A new graph window containing the histogram will open.

A Ut AW

. Click the File menu to print or save the graph.

Histogram of TEMPERATURES

Frequency
g

104 12 120 128 136
TEMPERATURES

7. Click File>Exit.
8. Save the project as Ch2-3.mp)j. -

2-3 Other Types of Graphs

In addition to the histogram, the frequency polygon, and the ogive, several other
types of graphs are often used in statistics. They are the bar graph, Pareto chart, time
series graph, pie graph, and the dotplot. Figure 2-8 shows an example of each type
of graph.
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FIGURE 2-8  Other Types of Graphs Used in Statistics
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(c) Time series graph (d) Pie graph

(e) Dotplot

OBJECTIVE @

Represent data using bar
graphs, Pareto charts, time
series graphs, pie graphs,
and dotplots.

Number of Named Tropical Storms Each Year for
the Years 1971-2010

ot e e

+ o000
+ o000 o
+ o0 o
+ oo

ot oo e e
+ oo
+ oo

°

Bar Graphs

When the data are qualitative or categorical, bar graphs can be used to represent the data.
A bar graph can be drawn using either horizontal or vertical bars.

A bar graph represents the data by using vertical or horizontal bars whose heights
or lengths represent the frequencies of the data.
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EXAMPLE 2-8 College Spending for First-Year Students

The table shows the average money spent by first-year college students. Draw a horizon-
tal and vertical bar graph for the data.

Electronics $728
Dorm decor 344
Clothing 141
Shoes 72

Source: The National Retail Federation.

SOLUTION

1. Draw and label the x and y axes. For the horizontal bar graph place the frequency
scale on the x axis, and for the vertical bar graph place the frequency scale on the
y axis.

2. Draw the bars corresponding to the frequencies. See Figure 2-9.

FIGURE 2-9 Bar Graphs for Example 2-8

y First-Year College Student Spending y Average Amount Spent

$800

$700
$600
$500 -

Electronics

Dorm decor
$400

Clothing $300
$200

Shoes $100
X

T T T T T T T T T $ . .
$0 $100 $200 $300 $400 $500 $600 $700 $800 Shoes  Clothing gém Electronics

The graphs show that first-year college students spend the most on electronic equipment.

Bar graphs can also be used to compare data for two or more groups. These types of bar
graphs are called compound bar graphs. Consider the following data for the number (in
millions) of never married adults in the United States.

Year Males Females
1960 15.3 12.3
1980 24.2 20.2
2000 32.3 27.8
2010 40.2 34.0

Source: U.S. Census Bureau.

Figure 2—10 shows a bar graph that compares the number of never married males with
the number of never married females for the years shown. The comparison is made by
placing the bars next to each other for the specific years. The heights of the bars can be
compared. This graph shows that there have consistently been more never married males
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FIGURE 2-10
Example of a Compound
Bar Graph
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Never Married Adults

a1 | Men

1 Women

351
30 1+

25+

Number (millions)

151

10 1

1960 1980 2000 2010
Year

than never married females and that the difference in the two groups has increased
slightly over the last 50 years.

Pareto Charts

When the variable displayed on the horizontal axis is qualitative or categorical, a Pareto
chart can also be used to represent the data.

A Pareto chart is used to represent a frequency distribution for a categorical
variable, and the frequencies are displayed by the heights of vertical bars, which
are arranged in order from highest to lowest.

EXAMPLE 2-9 Police Calls

The data shown here consist of the number of police calls for specific categories that a
local municipality received in 2011. (The data were obtained by the author.) Draw and
analyze a Pareto chart for the data.

Category Number
Juvenile complaint 92
Loud noise/music/party 27
Drug offenses 79
Driving under the influence 38
Disabled vehicle 65
Step1  Arrange the data from the largest to smallest according to frequency.
Category Number
Juvenile complaint 92
Drug offenses 79
Disabled vehicle 65
Driving under the influence 38
Loud noise/music/party 27
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I Historical Note

Vilfredo Pareto
(1848-1923) was an
[talian scholar who de-
veloped theories in eco-
nomics, statistics, and
the social sciences. His
contributions to statistics
include the development
of a mathematical func-
tion used in economics.
This function has many
statistical applications
and is called the Pareto
distribution. In addition,
he researched income
distribution, and his
findings became known
as Pareto’s law.
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Step 2 Draw and label the x and y axes.
Step 3 Draw the bars corresponding to the frequencies. See Figure 2—11.

The graph in Figure 2—11 shows that the police department received the most calls for
juvenile complaints and the fewest calls for loud noise, music, and parties.

FIGURE 2-11 Pareto Chart for Example 2-9

100

Number

Suggestions for Drawing Pareto Charts

y

90
80
70
60
50
40
30
20
10

1. Make the bars the same width.
2. Arrange the data from largest to smallest according to frequency.

3. Make the units that are used for the frequency equal in size.

When you analyze a Pareto chart, make comparisons by looking at the heights of the bars.

The Time Series Graph

When data are collected over a period of time, they can be represented by a time series

graph.

A time series graph represents data that occur over a specific period of time.

Example 2—-10 shows the procedure for constructing a time series graph.

Police Calls

Category

EXAMPLE 2-10 Percent of Cigarette Smokers

The data show the percentage of U.S. adults who smoke. Draw and analyze a time

series graph for the data.

Year

1970

1980

1990

2000

2010

Percent

37

33

25

23

19

Source: Center for Disease Control and Prevention.
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I Historical Note

Time series graphs are
over 1000 years old. The
first ones were used to
chart the movements of
the planets and the sun.

FIGURE 2-13
Two Time Series Graphs for
Comparison

Step 1
Step 2
Step 3
Step 4

Draw and label the x and y axes.
Label the x axis for years and the y axis for the percent.
Plot each point according to the table.

Draw line segments connecting adjacent points. Do not try to fit a smooth
curve through the data points. See Figure 2—12.

There has been a decrease in the percent of smokers over the 40-year period.

FIGURE 2-12

Figure for Example 2-10

y Percent of U.S. Adult Smokers

Percent
'}

1970 1980 1990 2000 2010
Year

When you analyze a time series graph, look for a trend or pattern that occurs over the
time period. For example, is the line ascending (indicating an increase over time) or
descending (indicating a decrease over time)? Another thing to look for is the slope, or
steepness, of the line. A line that is steep over a specific time period indicates a rapid
increase or decrease over that period.

Two or more data sets can be compared on the same graph called a compound time
series graph if two or more lines are used, as shown in Figure 2—13. This graph shows the

Elderly in the U.S. Labor Force

y
40 +
e
30 +
9,
E 20 4 . e Men
[ ]
°
° o Women
10 + ° o ° °
X
0 L L L L L L

1960 1970 1980 1990 2000 2010
Year

Source: Bureau of Census, U.S. Department of Commerce.
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percentage of elderly males and females in the U.S. labor force from 1960 to 2010. It
shows that the percentage of elderly men decreased significantly from 1960 to 1990 and
then increased slightly after that. For the elderly females, the percentage decreased
slightly from 1960 to 1980 and then increased from 1980 to 2010.

The Pie Graph

Pie graphs are used extensively in statistics. The purpose of the pie graph is to show the
relationship of the parts to the whole by visually comparing the sizes of the sections.
Percentages or proportions can be used. The variable is nominal or categorical.

A pie graph is a circle that is divided into sections or wedges according to the
percentage of frequencies in each category of the distribution.

Example 2—-11 shows the procedure for constructing a pie graph.

EXAMPLE 2-11 Super Bowl Snack Foods

This frequency distribution shows the number of pounds of each snack food eaten
during the Super Bowl. Construct a pie graph for the data.

Snack Pounds (frequency)
Potato chips 11.2 million
Tortilla chips 8.2 million
Pretzels 4.3 million
Popcorn 3.8 million
Snack nuts 2.5 million

Total n = 30.0 million

Source: USA TODAY Weekend.

SOLUTION

Step 1  Since there are 360° in a circle, the frequency for each class must be con-
verted to a proportional part of the circle. This conversion is done by using
the formula

Degrees = % -+ 360°

where f = frequency for each class and n = sum of the frequencies. Hence,
the following conversions are obtained. The degrees should sum to 360°.!

Potato chips % - 360° = 134°
. . 8.2

Tortilla chips 30 360° = 98°
4.3

Pretzel — ° = 52°

retzels 30 360 5

3.8

P — -+ 360° = 46°
opcorn 30
2.5

k . (e} — o

Snack nuts 30 360 30

Total 360°

!Note: The degrees column does not always sum to 360° due to rounding.
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= SPEAKING OF STATISTICS

Murders in the United States

The graph shows the number of murders
(in thousands) that have occurred in the United
States since 2001. Based on the graph, do you
think the number of murders is increasing,
decreasing, or remaining the same?

Number (thousands)
o
[$)]

13 f f

Murders in the United States

2001

2002 2003 2004 2005 2006 2007 2008 2009 2010

Year

Source: Crime in the United States 2010, FBI, Department of Justice.

Step 2 Each frequency must also be converted to a percentage. Recall from Exam-
ple 2—1 that this conversion is done by using the formula

i-lOO

n

Hence, the following percentages are obtained. The percentages should sum

% p—
to 100%.2
. 11.2
Potato chips 30 100 = 37.3%
Tortilla chips ?g + 100 = 27.3%
43
Pretzels 30 100 = 14.3%
3.8
Popcorn 0 100 = 12.7%
Snack nuts % - 100 = 8.3%
Total 99.9%

Step 3  Next, using a protractor and a
compass, draw the graph, using
the appropriate degree measures
found in Step 1, and label each
section with the name and
percentages, as shown in

Figure 2-14.

FIGURE 2-14 Pie Graph for Example 2—11

Super Bowl Snacks

Snack nuts

Popcorn 8.3%

12.7%

Pretzels
14.3%

Potato chips
37.3%

Tortilla chips
27.3%

’Note: The percent column does not always sum to 100% due to rounding.
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FIGURE 2-15
Figure for Example 2—12
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EXAMPLE 2-12 Police Calls

Construct and analyze a pie graph for the calls received each shift by a local

municipality for 2011. (Data obtained by author.)

Shift Frequency

1. Day 2594

2. Evening 2800

3. Night 2436
7830

SOLUTION

Step 1

Step 2

Step 3

Find the number of degrees for each shift, using the formula:
Degrees = % - 360°

For each shift, the following results are obtained:

12594

2773600 = 119°
A 7830

D

2800
Evening: 7830 360° = 129°

2436
ight: —— - °=112°
Night 7830 360

Find the percentages:

Day: —— - 100 = 33%

2800
Evening: —— -+ 100 = 36%
£ 7830

Night: 20 . 100 = 319
ight: =—— - =
£ 7830 ‘

Using a protractor, graph each section and write its name and corresponding

percentage as shown in Figure 2-15.

Police Calls

Evening
36%
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To analyze the nature of the data shown in the pie graph, look at the size of the
sections in the pie graph. For example, are any sections relatively large compared to
the rest? Figure 2—15 shows that the number of calls for the three shifts are about equal,
although slightly more calls were received on the evening shift.

Note: Computer programs can construct pie graphs easily, so the mathematics shown
here would only be used if those programs were not available.

Dotplots

A dotplot uses points or dots to represent the data values. If the data values occur more
than once, the corresponding points are plotted above one another.

A dotplot is a statistical graph in which each data value is plotted as a point (dot)
above the horizontal axis.

Dotplots are used to show how the data values are distributed and to see if there are
any extremely high or low data values.

EXAMPLE 2-13 Named Storms

The data show the number of named storms each year for the last 40 years. Construct
and analyze a dotplot for the data.

19 | 15 14 7 6 | M 11

16 12 13 14 13 | 12
15 15 19 1 4 6 1

W N

Source: NOAA.

Step 1  Find the lowest and highest data values, and decide what scale to use on the
horizontal axis. The lowest data value is 4 and the highest data value is 28, so
a scale from 4 to 28 is needed.

Step 2 Draw a horizontal line, and draw the scale on the line.

Step 3 Plot each data value above the line. If the value occurs more than once, plot
the other point above the first point. See Figure 2—16.

FIGURE 2-16 Figure for Example 2-13

5 10 15 20 25 30

The graph shows that the majority of the named storms occur with frequency between 6
and 16 per year. There are only 3 years when there were 19 or more named storms per year.

Stem and Leaf Plots

The stem and leaf plot is a method of organizing data and is a combination of sorting and
graphing. It has the advantage over a grouped frequency distribution of retaining the
actual data while showing them in graphical form.
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OBJECTIVE
Draw and interpret a stem

and leaf plot.

FIGURE 2-17
Stem and Leaf Plot for

Example 2-14
0 2

1 3 4
2 0 3 5
3 1.2 2
4 3 4 4
5 1.2 7
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2 2 36

A stem and leaf plot is a data plot that uses part of the data value as the stem and
part of the data value as the leaf to form groups or classes.

For example, a data value of 34 would have 3 as the stem and 4 as the leaf. A data value
of 356 would have 35 as the stem and 6 as the leaf.
Example 2—-14 shows the procedure for constructing a stem and leaf plot.

EXAMPLE 2-14 Out Patient Cardiograms

At an outpatient testing center, the number of cardiograms performed each day for 20
days is shown. Construct a stem and leaf plot for the data.

SOLUTION

Step1  Arrange the data in order:

02, 13, 14, 20, 23, 25, 31, 32, 32, 32,
32,33,36,43, 44, 44, 45, 51, 52, 57

Note: Arranging the data in order is not essential and can be cumbersome
when the data set is large; however, it is helpful in constructing a stem and
leaf plot. The leaves in the final stem and leaf plot should be arranged

in order.

Step 2 Separate the data according to the first digit, as shown.

02 13, 14 20, 23, 25 31,32, 32,32, 32,33, 36
43, 44, 44, 45 51, 52,57

Step 3 A display can be made by using the leading digit as the stem and the
trailing digit as the leaf. For example, for the value 32, the leading digit,
3, is the stem and the trailing digit, 2, is the leaf. For the value 14, the 1 is
the stem and the 4 is the leaf. Now a plot can be constructed as shown in

Figure 2-17.
Leading digit (stem) | Trailing digit (leaf)
0 2
1 34
2 035
3 1222236
4 3445
5 127

Figure 2—17 shows that the distribution peaks in the center and that there are no gaps
in the data. For 7 of the 20 days, the number of patients receiving cardiograms was
between 31 and 36. The plot also shows that the testing center treated from a minimum of
2 patients to a maximum of 57 patients in any one day.

If there are no data values in a class, you should write the stem number and leave the
leaf row blank. Do not put a zero in the leaf row.



= SPEAKING OF STATISTICS How Much Paper Money Is
in Circulation Today?

The Federal Reserve estimated that during a recent
year, there were 22 billion bills in circulation. About
35% of them were $1 bills, 3% were $2 bills, 8% were
$5 bills, 7% were $10 bills, 23% were $20 bills, 5%
were $50 bills, and 19% were $100 bills. It costs about
3¢ to print each bill.

The average life of a $1 bill is 22 months, a $10 bill
3 years, a $20 bill 4 years, a $50 bill 9 years, and a
$100 bill 9 years. What type of graph would you use to
represent the average lifetimes of the bills?

EXAMPLE 2-15 Number of Car Thefts in a Large City

An insurance company researcher conducted a survey on the number of car thefts in a
large city for a period of 30 days last summer. The raw data are shown. Construct a stem
and leaf plot by using classes 50-54, 55-59, 60-64, 65-69, 7074, and 75-79.

SOLUTION

Step1  Arrange the data in order.

50,51, 51, 52, 53, 53, 55, 55, 56, 57, 57, 58, 59, 62, 63,
65, 65, 66, 66, 67, 68, 69, 69, 72,73, 75,75,717,78, 719

Step 2  Separate the data according to the classes.

50,51, 51, 52, 53,53 55,55, 56, 57, 57, 58, 59
62,63 65, 65, 66, 66, 67, 68, 69, 69 72,73

FIGURE 2-18 75,75,717,78,79
Siem and Leai Fiot for Step 3 Plot the data as shown here.
Example 2-15
Leading digit (stem) | Trailing digit (leaf)

Spot1r 1233 5 011233
51556 7 7 89 5 5567789

6 23
623 6 55667899
6|55 6 6 7 8 9 9 7 23

7 55789
7 2 3
71557 89

The graph for this plot is shown in Figure 2-18.
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I Interesting Fact

The average number

of pencils and index
cards David Letterman
tosses over his shoulder
during one show is 4.
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When you analyze a stem and leaf plot, look for peaks and gaps in the distribution.
See if the distribution is symmetric or skewed. Check the variability of the data by look-
ing at the spread.

Related distributions can be compared by using a back-to-back stem and leaf plot.
The back-to-back stem and leaf plot uses the same digits for the stems of both distribu-
tions, but the digits that are used for the leaves are arranged in order out from the stems
on both sides. Example 2—16 shows a back-to-back stem and leaf plot.

EXAMPLE 2-16 Number of Stories in Tall Buildings

The number of stories in two selected samples of tall buildings in Atlanta and Philadelphia
is shown. Construct a back-to-back stem and leaf plot, and compare the distributions.

Atlanta Philadelphia
55 70 44 36 40 61 40 38 32 30
63 40 44 34 38 58 40 40 25 30
60 47 52 32 32 54 40 36 30 30
50 53 32 28 3 53 39 36 34 33
52 32 34 32 50 50 38 36 39 32
26 29
Source: The World Almanac and Book of Facts.

Step 1  Arrange the data for both data sets in order.

Step2 Construct a stem and leaf plot, using the same digits as stems. Place the dig-
its for the leaves for Atlanta on the left side of the stem and the digits for the
leaves for Philadelphia on the right side, as shown. See Figure 2—-19.

FIGURE 2-19 Back-to-Back Stem and Leaf Plot for Example 2—16

Atlanta Philadelphia
986 2 5
8644222221 3 000022346668899
74400 4 0000
532200 5 0348
30 6 1
0 7

Step 3 Compare the distributions. The buildings in Atlanta have a large variation in
the number of stories per building. Although both distributions are peaked in
the 30- to 39-story class, Philadelphia has more buildings in this class. Atlanta
has more buildings that have 40 or more stories than Philadelphia does.

Stem and leaf plots are part of the techniques called exploratory data analysis. More
information on this topic is presented in Chapter 3.

Misleading Graphs

Graphs give a visual representation that enables readers to analyze and interpret data more
easily than they could simply by looking at numbers. However, inappropriately drawn
graphs can misrepresent the data and lead the reader to false conclusions. For example, a
car manufacturer’s ad stated that 98% of the vehicles it had sold in the past 10 years were
still on the road. The ad then showed a graph similar to the one in Figure 2-20. The graph
shows the percentage of the manufacturer’s automobiles still on the road and the



FIGURE 2-20
Graph of Automaker’s
Claim Using a Scale
from 95 to 100%

FIGURE 2-21

Graph in Figure 2-20

Redrawn Using a Scale
from 0 to 100%
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percentage of its competitors’ automobiles still on the road. Is there a large difference?
Not necessarily.

Notice the scale on the vertical axis in Figure 2-20. It has been cut off (or truncated)
and starts at 95%. When the graph is redrawn using a scale that goes from 0 to 100%, as
in Figure 2-21, there is hardly a noticeable difference in the percentages. Thus, changing
the units at the starting point on the y axis can convey a very different visual representa-
tion of the data.

100 1

99 1

98

Percent of cars on road

97 1

96 -

Vehicles on the Road

95

100

80 1

D
o
|

Percent of cars on road

S
o
|

20 1

Manufacturer’s Competitor I's Competitor II's
automobiles automobiles automobiles

Vehicles on the Road

Manufacturer’s Competitor I's Competitor II’s
automobiles automobiles automobiles
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FIGURE 2-22
Projected Miles per Gallon

2-48

It is not wrong to truncate an axis of the graph; many times it is necessary to do so.
However, the reader should be aware of this fact and interpret the graph accordingly. Do
not be misled if an inappropriate impression is given.

Let us consider another example. The projected required fuel economy in miles per
gallon for General Motors vehicles is shown. In this case, an increase from 21.9 to
23.2 miles per gallon is projected.

Year 2008 2009 2010 2011
MPG 219 22.6 229 232

Source: National Highway Traffic Safety Administration.

When you examine the graph shown in Figure 2—22(a), using a scale of 0 to 25 miles
per gallon, the graph shows a slight increase. However, when the scale is changed to 21 to
24 miles per gallon, the graph shows a much larger increase even though the data remain
the same. See Figure 2-22(b). Again, by changing the units or starting point on the y axis,
one can change the visual representation.

Projected Miles per Gallon

nN
o
|
T

N
o
|
T

15 1

Miles per gallon

10 1

0 f f f f
2008 2009 2010 2011

Year
(a)
Projected Miles per Gallon
24 +

23+

22 1

Miles per gallon

2008 2009 2010 2011
Year
(b)



FIGURE 2-23
Comparison of Costs for a
30-Second Super Bowl
Commercial

FIGURE 2-24
A Graph with No Units on
the y Axis

Section 2-3 Other Types of Graphs 89

Cost of 30-Second Cost of 30-Second
Super Bowl Commercial y Super Bowl Commercial
35+ 35+
30+ 30t
g g
S S
225+ S 254
o o
5 5
= 20 1+ = 201
B 15+ 3 154
[} [}
1.0 + 104
| X | © X
1967 2012 1967 2012
Year Year
(a) Graph using bars (b) Graph using circles

Another misleading graphing technique sometimes used involves exaggerating a one-
dimensional increase by showing it in two dimensions. For example, the average cost of a
30-second Super Bowl commercial has increased from $42,000 in 1967 to $3.5 million in
2012 (Source: USA TODAY).

The increase shown by the graph in Figure 2-23(a) represents the change by a
comparison of the heights of the two bars in one dimension. The same data are shown
two-dimensionally with circles in Figure 2-23(b). Notice that the difference seems much
larger because the eye is comparing the areas of the circles rather than the lengths of the
diameters.

Note that it is not wrong to use the graphing techniques of truncating the scales or
representing data by two-dimensional pictures. But when these techniques are used, the
reader should be cautious of the conclusion drawn on the basis of the graphs.

Another way to misrepresent data on a graph is by omitting labels or units on the axes
of the graph. The graph shown in Figure 2-24 compares the cost of living, economic
growth, population growth, etc., of four main geographic areas in the United States. How-
ever, since there are no numbers on the y axis, very little information can be gained from
this graph, except a crude ranking of each factor. There is no way to decide the actual
magnitude of the differences.

Finally, all graphs should contain a source for the information presented. The
inclusion of a source for the data will enable you to check the reliability of the organiza-
tion presenting the data.

N W W E W
W S S N
E N N
S E E S
Cost of Economic Population Crime
living growth growth rate
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90 Chapter 2 Frequency Distributions and Graphs

== Applying the Concepts 2-3

Causes of Accidental Deaths in the United States, 1999-2009

The graph shows the number of deaths in the United States due to accidents. Answer the following
questions about the graph.

Causes of Accidental Deaths in the United States

y
50 +
45 + = | ] ] -
[

40 + # Poisoning
= 35+ = Motor Vehicle
2
330+ .

o
£ Falls
= 251 o
2 * °
IS 4
5 20 * ®
L J
15 + $
$

10 +

ST % - s X 5 % Drowning

O 1 1 1 1 1 1 X

1999 2001 2003 2005 2007 2009
Year

Source: National Safety Council.

. Name the variables used in the graph.

. Are the variables qualitative or quantitative?

. What type of graph is used here?

. Which variable shows a decrease in the number of deaths over the years?

. Which variable or variables show an increase in the number of deaths over the years?
. The number of deaths in which variable remains about the same over the years?

. List the approximate number of deaths for each category for the year 2001.

ol e Y T S OS B

. In 1999, which variable accounted for the most deaths? In 2009, which variable accounted
for the most deaths?

9. In what year were the numbers of deaths from poisoning and falls about the same?

See page 108 for the answers.

1. Pet Population Construct vertical and horizontal bar 2. Worldwide Sales of Fast Foods The worldwide sales
graphs for the number of pets (in millions) in the (in billions of dollars) for several fast-food franchises for
United States. a specific year are shown. Construct a vertical bar graph

and a horizontal bar graph for the data.
Type Number Wendy’s $ 87
Dogs 78 KFC 14.2
Cats 86 Pizza Hut 9.3
Fish 160 Burger King 12.7
Other 53 Subway 10.0
Source: AAPA National Pet Owners. Source: Franchise Times.
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3. Calories Burned While Exercising Construct a Pareto

chart for the following data on exercise.

Calories burned per minute

Walking, 2 mph 2.8
Bicycling, 5.5 mph 32
Golfing 5.0
Tennis playing 7.1
Skiing, 3 mph 9.0

Running, 7 mph 14.5

Source: Physiology of Exercise.
. Roller Coaster Mania The World Roller Coaster Census
Report lists the following numbers of roller coasters on

each continent. Represent the data graphically, using a
Pareto chart.

Africa 17
Asia 315
Australia 22
Europe 413
North America 643
South America 45

Source: www.rcdb.com

. Online Ad Spending The amount spent (in billions of
dollars) for ads online is shown. (The numbers for 2011
through 2015 are projected numbers.) Draw a time
series graph and comment on the trend.

Year |201O 2011 2012 2013 2014 2015

Amount | $68.4 $80.2 $94.2 $106.1 $119.8 $132.1

Source: eMarketer.

. Violent Crimes The number of all violent crimes
(murder, nonnegligent homicide, manslaughter, forcible
rape, robbery, and aggravated assault) in the United States
for each of these years is listed below. Represent the
data with a time series graph.

2000 1,425,486 2004 1,360,088
2001 1,439,480 2005 1,390,745
2002 1,423,677 2006 1,435,123
2003 1,383,676 2007 1,422,970

Source: World Almanac and Book of Facts.

2008 1,394,461
2009 1,325,896
2010 1,246,248

. Super Bowl Viewer’s Expenditures The average
amount a television viewer spent on merchandise,
apparel, and snacks when watching a Super Bowl game
is shown. Draw a time series graph for the data and
interpret the results.

Year | 2005 2007 2009 2011 2012

Amount | $38.35 $56.04 $57.27 $59.33 $63.87

Source: Retail Advertising and Marketing Association.

. Valentine’s Day Spending The data show the average
amount of money spent by consumers on Valentine’s
Day. Draw a time series graph for the data and comment
on the trend.

Year | 2007 2008 2009 2010 2011 2012

Amount | $120 $123 $103 $103 $110 $126

Source: National Retail Federation.

9.

10.

11.

12.

13.
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Grading of Schools Parents were asked to grade their
child’s school for overall performance. The numbers are
shown. Draw a pie graph for the data and analyze the
graph.

Grade | A B C D F
Number | 337 424 144 48 10

Source: Harris Interactive Survey.

Reasons We Travel The following data are based on a
survey from American Travel Survey on why people
travel. Construct a pie graph for the data and analyze
the results.

Purpose Number
Personal business 146
Visit friends or relatives 330
Work-related 225
Leisure 299

Source: USA TODAY.

Energy Consumption The data show the percentages
of the types of energy consumed in the United States.
Draw a pie graph for the data. What percentage of
energy used is obtained from fossil fuels (coal, gas, and
petroleum)?

Energy Percent
Natural gas 25
Coal 21
Petroleum 37
Nuclear 9
Renewable 8

Source: U.S. Energy Information Administration.

Colors of Automobiles The popular car colors are
shown. Construct a pie graph for the data.

White 19%
Silver 18
Black 16
Red 13
Blue 12
Gray 12
Other 10

Source: Dupont Automotive Color Popularity Report.

Ages of Football Players The data show the ages of
the players of the New England Patriots in 2012.
Construct a dotplot for the data, and comment on the
distribution.

28 24 26 23 27 25
26 27 28 25 23 33
24 21 23 29 22

25 23 27 26 30

34 24 25 24 32

25 35 25 29 34

23 22 34 24 22

26 30 24 33 30

29 28 30 25 34

25 24 26 30 28

Source: USA Today.
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14.

15.

16.

17.

18.

19.

Chapter 2 Frequency Distributions and Graphs

Teacher Strikes In Pennsylvania the numbers of
teacher strikes for the last 14 years are shown.
Construct a dotplot for the data. Comment on the
graph.

9 13 15 7 7 14 9
10 14 18 7 8 8 3

Source: School Leader News.

Patients at a Medical Care Facility The number of
patients seen at a walk-in medical care facility for each
of 40 days is shown. Construct a dotplot for the data,
and comment on the distribution.

87 72 88 86 90 74 78 88
86 77 75 73 85 84 71 71
76 78 85 80 90 88 91 80
88 80 84 80 84 &9 84 75
77 74 89 74 79 75 75 77

Commuting Times Fifty off-campus students were
asked how long it takes them to get to school. The times
(in minutes) are shown. Construct a dotplot and analyze
the data.

23 22 29 19 12
18 17 30 11 27
11 18 26 25 20
25 15 24 21 31
29 14 22 25 29
24 12 30 27 21
27 25 21 14 28
17 17 24 20 26
13 20 27 26 17
18 25 21 33 29

50 Home Run Club There are 42 Major League
baseball players (as of 2011) that have hit 50 or more
home runs in one season. Construct a stem and leaf
plot and analyze the data.

50 51 52 54 59 51
54 50 58 51 54 54
56 58 56 70 54 52
58 54 64 52 73 57
50 60 56 50 66 54
52 51 58 63 57 52
51 50 61 52 65 50

Source: The World Almanac and Book of Facts.

Calories in Salad Dressings A listing of calories per
1 ounce of selected salad dressings (not fat-free) is
given below. Construct a stem and leaf plot for the
data.

100 130
140 170
145 115
160 120

130
160
120
140

130
130
100
150

110
160
120
190

110
120
160
150

120
150
140
180

130 140 100
100 145 145
120 180 100
160

Length of Major Rivers The data show the lengths (in
hundreds of miles) of major rivers in South America and
Europe. Construct a back-to-back stem and leaf plot,
and compare the distributions.
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20.

South America | Europe
39 21 10 10 5 12 7 6 8
11 10 2 10 5 5 4 6
10 14 10 12 18 5 13 9
17 15 10 14 6 6 11
15 25 16 8 6 3 4

Source: The World Almanac and Book of Facts.

Math and Reading Achievement Scores The math
and reading achievement scores from the National
Assessment of Educational Progress for selected states
are listed below. Construct a back-to-back stem and leaf
plot with the data, and compare the distributions.

Math | Reading

52
63
55
68

66 69 62 61 65 76 76 66 67
57 59 59 55 71 70 70 66 61
59 74 72 73 61 69 78 76 77
76 73 77 77 80

Source: World Almanac.

21.

22,

23.

State which type of graph (Pareto chart, time series graph,
or pie graph) would most appropriately represent the data.

a. Situations that distract automobile drivers

b. Number of persons in an automobile used for get-
ting to and from work each day

c. Amount of money spent for textbooks and supplies
for one semester

d. Number of people killed by tornados in the
United States each year for the last 10 years

e. The number of pets (dogs, cats, birds, fish, etc.) in
the United States this year

f. The average amount of money that a person spent
for his or her significant other for Christmas for the
last 6 years

State which graph (Pareto chart, time series graph, or
pie graph) would most appropriately represent the given
situation.

a. The number of students enrolled at a local college
for each year during the last 5 years

b. The budget for the student activities department at a
certain college for a specific year

c. The means of transportation the students use to get
to school

d. The percentage of votes each of the four candidates
received in the last election

e. The record temperatures of a city for the last 30 years

f. The frequency of each type of crime committed in
a city during the year

U.S. Health Dollar The U.S. health dollar is spent as

indicated below. Construct two different types of

graphs to represent the data.

Government administration 9.7%
Nursing home care 55
Prescription drugs 10.1
Physician and clinical services 20.3
Hospital care 30.5
Other (OTC drugs, dental, etc.) 239

Source: Time Almanac.



24.

25.

Patents The U.S. Department of Commerce reports the
following number of U.S. patents received by foreign
countries and the United States in the year 2010.
Illustrate the data with a bar graph and a pie graph.
Which do you think better illustrates this data set?

Japan 44,814 United Kingdom 4,302
Germany 12,363 China 2,657
South Korea 11,671 Israel 1,819
Taiwan 8,238 Italy 1,796
Canada 4,852 United States 107,792

Source: World Almanac.

NO doubit \/OUI” each dGw Your ouln
Conclusions from this chart..,

Source: Cartoon by Bradford Veley, Marquette, Michigan. Used with
permission.

Cost of Milk The graph shows the increase in the price
of a quart of milk. Why might the increase appear to be
larger than it really is?

y Cost of Milk
$3.50
$3.50 1 —
$3.00 +
$2.50 +
$2.00 +
$1.50 +
$1.08
$1.00 +
$0.50 +
X
Fall 1988 Fall 2011

26.

27.

28.
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U.S. Population by Age The following information
was found in a recent almanac. Use a pie graph to
illustrate the information. Is there anything wrong with
the data?

U.S. Population by Age in 2011

Under 20 years 27.0%
20 years and over 73.0
65 years and over 13.1

Source: Time Almanac.

Concealed Weapons Licenses The numbers of
concealed weapons licenses issued for two
neighboring counties are listed below for the years
2005-2011. Compare the data with the time series
graph(s), and comment on the accompanying
headline of the story, “Gun sales increase as crime
rate decreases.”

Year County 1 County 2
2005 2207 312
2006 2239 428
2007 4476 693
2008 4200 1509
2009 3770 769
2010 3128 423
2011 3906 508

Source: PA State Police Firearms Report.

Trip Reimbursements The average amount requested
for business trip reimbursement is itemized below.
[lustrate the data with an appropriate graph. Do you
have any questions regarding the data?

Flight $440
Hotel stay 323
Entertainment 139
Phone usage 95
Transportation 65
Meal 38
Parking 34

Source: USA TODAY.
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94 Chapter 2 Frequency Distributions and Graphs

AL LIOGNA  Step by Step

T|-84 Pl us To graph a time series, follow the procedure for a frequency polygon from Section 2-2, using the
following data for the number of outdoor drive-in theaters
Step by Step

Year 1988 1990 1992 1994 1996 1998 2000
Number 1497 910 870 859 826 750 637

Input Output

1T MO
Aamin=192&
Anax=2aE2
#acl=2
Ymin=-0
Vmax=1280
Vacl=16A
Liix=19328 ares=1

EXCEL Constructing a Pareto Chart
Step by Step To make a Pareto chart:

1. Enter the snack food categories from Example 2—11 into column A of a new worksheet.

2. Enter the corresponding frequencies in column B. The data should be entered in descending
order according to frequency.

3. Highlight the data from columns A and B, and select the Insert tab from the toolbar.
4. Select the Column Chart type.
5. To change the title of the chart, click on the current title of the chart.
6. When the text box containing the title is highlighted, click the mouse in the text box and
change the title.
A B C D E E L5} H I
1 Snack Pounds (in millions)
2 Paotato Chips 11.2
3 [Tortilla Chips 8.2
4 Pretzels 43
5 Popcorn 3.8
6 Snack Nuts 2.5
7
: Super Bowl Snacks
10 12
11 10
12
13 8
14 6
15 B Pounds (in millions)
16 4
17 :
8
19 o
20 Potato Tortilla Pretzels Popcom Mam
n Chips Ch-ps
2

Constructing a Time Series Chart

Example
Year 1999 2000 2001 2002 2003
Vehicles* 156.2 160.1 162.3 172.8 1794

*Vehicles (in millions) that used the Pennsylvania Turnpike.
Source: Tribune Review.
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To make a time series chart:

1. Enter the years 1999 through 2003 from the example in column A of a new worksheet.
2. Enter the corresponding frequencies in column B.

3. Highlight the data from column B and select the Insert tab from the toolbar.

4. Select the Line chart type.

;:) - s 254 - Microsoft Excel non-commercial use Chart Tools -
— Wome  tt Fagelssout

Formules  Dets  Revew  View  Adddng  Design | Lot Formst - x
R
Sriect

B ==l I\/”\.-/”\/ |\./ ‘\/ s [ (@)

Change  Save A¢ Swiiteh henve
Chart Type Tempiate  Row/Column Dste Chant
Tyme Data Chart Layouts Chart Styiec Lazation
| Chart 2 -3 Se | [v:
oLt Lo Je e Lp Joe Jo g Lo oo lox T low L o I
Number
185
180
s // |
1
i 188 _//
180 p—
——_g tumber
155
150
145
19 140
20 1 2 3 4 5
a
2
bl
b S
25

AT p b1 sheott | Shoet? | Sheeta 3/ L
e suerage: 16516 Countié _Sum: 3308

5. Right-click the mouse on any region of the graph.
6. Select the Select Data option.

7. Select Edit from the Horizontal Axis Labels and highlight the years from column A, then
click [OK].

8. Click [OK] on the Select Data Source box.

9. Create a title for your chart, such as Number of Vehicles Using the Pennsylvania Turnpike
Between 1999 and 2003. Right-click the mouse on any region of the chart. Select the Chart
Tools tab from the toolbar, then Layout.

10. Select Chart Title and highlight the current title to change the title.
11. Select Axis Titles to change the horizontal and vertical axis labels.
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Constructing a Pie Chart
To make a pie chart:

1. Enter the shifts from Example 2—12 into column A of a new worksheet.

2. Enter the frequencies corresponding to each shift in column B.

3. Highlight the data in columns A and B and select Insert from the toolbar; then select the Pie

chart type.

Ingert Page Layout Foarmulsy Dats Riview View

a Cl &)@ o gees (1 & O G Uvesense g
e O = i oo L G
Fage PageBreak  Custom  Full [ Grannes [#) Hesdings Zoom 100% Zoomto New  Ammange Freeze 1 Save
Jiayout Preview  views Soeen | Selection  Window AN Panes~ mhade R Rerat ¥ aHHen  warksper
Workbaok Views Show Toom Window
5] bl 5~
A B [N .D . F G H 1 1 X M N o
1 |shift Frequency
2 Day 2594
3 Evening 2800
4 Night 2436
5
o] —1
7
]
]
10
1 Frequency
12
13
13
15
16
"Dy
17
18 S Evening |
19 gt
o]
21
22
2
24
25

. Click on any region of the chart. Then select Design from the Chart Tools tab on the toolbar.

. To change the title of the chart, click on the current title of the chart.

4
5. Select Formulas from the chart Layouts tab on the toolbar.
6
7

. When the text box containing the title is highlighted, click the mouse in the text box and

change the title.
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Construct a Bar Chart
The procedure for constructing a bar chart is similar to that for the pie chart.
1. Select Graph>Bar Chart.
a) Click on the drop-down list in Bars Represent: and then select values from a table.
b) Click on the Simple chart, then click [OK]. The dialog box will be similar to the Pie

Chart Dialog Box.
2. Select the frequency column C2 f for Graph variables: and C1 Snack for the Categorical
variable.
Super Bowl Snacks
4 Potato chps
3 Tortla chps
%
E 20
Pretzely fias
10 Snack ruts
Potato chips  Tortilla chips Pretzels Popcorn Snack nuts
Percent within all data, Sack

3. Click on [Labels], then type the title in the Titles/Footnote tab: Super Bowl Snacks.

4. Click the tab for Data Labels, then click the option to Use labels from column: and select
C1 Snacks.

5. Click [OK] twice.
After the graph is made, right-click over any bar to change the appearance such as the color of
the bars. To change the gap between them, right-click on the horizontal axis and then choose
Edit X scale. In the Space Between Scale Categories select Gap between clusters then change

the 1.5 to 0.2. Click [OK]. To change the y Scale to percents, right-click on the vertical axis
and then choose Graph options and Show Y as a Percent.

Construct a Pareto Chart

Pareto charts are a quality control tool. They are similar to a bar chart with no gaps between the
bars, and the bars are arranged by frequency.

1. Select Stat>Quality Tools>Pareto.

2. Click the option to Chart defects table.

3. Click in the box for the Labels in: and select C1 Snack.
4. Click on the frequencies column C2 f.

E Pareto Chart of Snack

0 v T - T T
Defect Potato chips Tortillachips  Pretzels Fopcormn  Snack nuts

Count 1.2 8.2 4.3 38 23
Percent 3?3 273 142 127 83
Cum % 373 64.7 79.0 07 100.0
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5. Click on [Options].
a) Type Snack for the X axis label and Count for the Y axis label.
b) Type in the title, Super Bowl Snacks.

6. Click [OK] twice. The chart is completed.

Construct a Time Series Plot

The data used are the percentage of U.S. adults who smoke (Example 2-10).

Year

1970

1980

1990

2000

2010

Number

37

33

25

23

19

1. Add a blank worksheet to the project by selecting File>New>New-Minitab Worksheet.

2. To enter the dates from 1970 to 2010 in C1, select Calc>Make Patterned Data>Simple
Set of Numbers.

a)
b)
9]
d)

€)

Type Year in the text box for Store patterned data in.
From First value: should be 1970.
To Last value: should be 2010.

In steps of should be 10 (for every 10-year increment). The last two boxes should be 1,
the default value.

Click [OK]. The sequence from 1970 to 2010 will be entered in C1 whose label will be Year.

3. Type Percent Smokers for the label row above row 1 in C2.
4. Type 37 for the first number, then press [Enter].

5. Continue entering each value in a row of C2.

Percent of U.S. Adults Who Smoke
75,
35.0- o
325 ™
§
£ 300+
E
w
B 275
=
p
g 2501 R
22.5 N
20,0 e Y
e
1970 1980 1990 2000 2010
Year

6. To make the graph, select Graph>Time series plot, then Simple, and press [OK].

a)
b)
9]
d)
€)

For Series select Percent Smokers; then click [Time/scale].

Click the Stamp option and select Year for the Stamp column.

Click the Gridlines tab and select all three boxes, Y major, Y minor, and X major.
Click [OK] twice. A new window will open that contains the graph.

To change the title, double-click the title in the graph window. A dialog box will open,
allowing you to change the text to Percent of U.S. Adults Who Smoke.
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Construct a Pie Chart

1. Enter the summary data for snack foods and frequencies from Example 2—11 into C1 and C2.

Plechart x|
|  Chart cougts of unique values
.
Categarical variable;
Snack
Summary
f =
&
s T | a
Snack f
5 Forlla chips o Pie Options... | Lebels... |
— i-—-::;::: ;; : Selart | Multiple Graphs... | Data Optians... |
5 Snark nuts 25
s . s oK | Cancel

2. Name them Snack and f.
3. Select Graph>Pie Chart.
a) Click the option for Chart summarized data.
b) Press [Tab] to move to Categorical variable, then double-click C1 to select it.
¢) Press [Tab] to move to Summary variables, and select the column with the frequencies f.

Super Bowl Snacks

Tiles/Footnotes  Shos Labeks | Srack ruts
Label pie sices with: 5
¥ Category name

¥ Crequency
T~ Becert

= Ew ihhumlﬁdhg
k

T I o I e I Tu'nllamgg

4. Click the [Labels] tab, then Titles/Footnotes.
a) Type in the title: Super Bowl Snacks.
b) Click the Slice Labels tab, then the options for Category name and Frequency.
c¢) Click the option to Draw a line from label to slice.
d) Click [OK] twice to create the chart.

Construct a Stem and Leaf Plot
1. Type in the data for Example 2—15. Label the column CarThefts.
2. Select STAT>EDA>Stem-and-Leaf. This is the same as Graph>Stem-and-Leaf.
3. Double-click on C1 CarThefts in the column list.

4. Click in the Increment text box, and enter the class width of 5.
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5. Click [OK]. This character graph will be displayed in the session window.

CARS

x| Stem-and-Leaf Display: CarThefts

Stem-and-leaf of CarThefts N =30

Leaf Unit = 1.0

6 5 011233
13 5 5567789
15 6 23

15 6 55667899
7 7 23

5 7 55789

= Summary

¢ When data are collected, the values are called
raw data. Since very little knowledge can
be obtained from raw data, they must be
organized in some meaningful way. A frequency
distribution using classes is the common method
that is used. (2—-1)

* Once a frequency distribution is constructed,
graphs can be drawn to give a visual
representation of the data. The most commonly
used graphs in statistics are the histogram,
frequency polygon, and ogive. (2-2)

* A stem and leaf plot uses part of the data values as

stems and part of the data values as leaves. This
graph has the advantage of a frequency
distribution and a histogram. (2-3)

Finally, graphs can be misleading if they are
drawn improperly. For example, increases and
decreases over time in time series graphs can be
exaggerated by truncating the scale on the y axis.
One-dimensional increases or decreases can be
exaggerated by using two-dimensional figures.
Finally, when labels or units are purposely

e Other graphs such as the bar graph, Pareto chart, omitted, there is no actual way to decide the
time series graph, pie graph and dotplot can also magmtqde of the differences between the
be used. Some of these graphs are frequently seen categories. (2-3)

in newspapers, magazines, and various statistical
reports. (2-3)

== Important Terms

bar graph 75 cumulative frequency lower class limit 44 time series graph 78

distribution 48

categorical frequency ogive 59 ungrouped frequency

distribution 43 dotplot 83 open-ended distribution 46 distribution 49
class 42 frequency 42 Pareto chart 77 upper class limit 44
class boundaries 45 frequency distribution 42 pie graph 80

class midpoint 45 frequency polygon 58 raw data 42

class width 45 grouped frequency relative frequency

compound bar graphs 76 distribution 44 graph 61

cumulative frequency 59 histogram 57 stem and leaf plot 84
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== Important Formulas

Formula for the percentage of values in each class:

%=£-100
n

where

f = frequency of class
n = total number of values

Formula for the range:
R = highest value — lowest value

Formula for the class width:

Class width = upper boundary — lower boundary

Formula for the class midpoint:

_ lower boundary + upper boundary

X, 2

_ lower limit + upper limit

" 2

Formula for the degrees for each section of a pie graph:

Degrees = J;c - 360°

= Review Exercises

Section 2-1

1. How People Get Their News The Brunswick Research
Organization surveyed 50 randomly selected individuals
and asked them the primary way they received the daily
news. Their choices were via newspaper (N), television
(T), radio (R), or Internet (I). Construct a categorical
frequency distribution for the data and interpret the
results.

R ==z
- % & ZZ
z— %3
=z —=m -
4=
—m 3z
o zZzZ R
z—= =%
R R
4=z

2. Men’s World Hockey Champions The United States
won the Men’s World Hockey Championship in 1933
and 1960. Below are listed the world champions for
the last 30 years. Use this information to construct a
frequency distribution of the champions. What is the
difficulty with these data?

1982 USSR 1992  Sweden

1983 USSR 1993 Russia

1984 Not held 1994 Canada

1985 Czechoslovakia 1995  Finland

1986 USSR 1996  Czech Republic
1987 Sweden 1997 Canada

1988 Not held 1998 Sweden

1989 USSR 1999  Czech Republic
1990 Sweden 2000  Czech Republic
1991 Sweden 2001  Czech Republic

2002  Slovakia 2007 Canada

2003 Canada 2008 Russia

2004 Canada 2009 Russia

2005 Czech Republic 2010  Czech Republic
2006 Sweden 2011 Finland

Source: Time Almanac.

3. BUN Count The blood urea nitrogen (BUN)
count of 20 randomly selected patients is given here
in milligrams per deciliter (mg/dl). Construct an
ungrouped frequency distribution for the data.

17 18 13 14
12 17 11 20
13 18 19 17
14 16 17 12
16 15 19 22

4. Wind Speed The data show the average wind speed
for 30 days in a large city. Construct an ungrouped
frequency distribution for the data.

& 15 9 8 9 10
& 10 14 9 8 8
12 9 8 8 14 9
9 13 13 10 1 9
13 g8 11 11 8
9 13 9 8 8 10

5. College Completions The percentage (rounded to the
nearest whole percent) of persons from each state
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completing 4 years or more of college is listed below.
Organize the data into a grouped frequency distribution
with 5 classes. The data for this exercise will be used for
Exercises 7,9, and 11.

Percentage of persons completing 4 years of college

23 25 24 34 22 24 27 37 33 24
26 23 38 24 24 17 28 23 30 25
30 22 33 24 28 36 24 19 25 3l
34 31 27 24 29 28 21 25 26 15
26 22 27 21 25 28 24 21 25 26

Source: New York Times Almanac.

6. Ages of the Vice Presidents at the Time of
Their Death The ages of the Vice Presidents of the
United States at the time of their death are listed below.
Use the data to construct a frequency distribution.
Use 6 classes. The data for this exercise will be used for
Exercises 8, 10, and 12.
90 83 80 73 70 51 68 79 70 71
72 74 67 54 81 66 62 63 68 57
66 9 78 55 60 66 57 71 60 85
76 98 77 88 78 81 64 66 77 93 70
Source: World Almanac and Book of Facts.

Section 2-2

7. Find the relative frequency for the frequency distribu-
tion for the data in Exercise 5.

8. Find the relative frequency for the frequency distribu-

10.

11.

12.

tion for the data in Exercise 6.

. Construct a histogram, frequency polygon, and ogive

for the data in Exercise 5.

Construct a histogram, frequency polygon, and ogive
for the data in Exercise 6.

Construct a histogram, frequency polygon, and ogive,
using relative frequencies for the data in Exercise 5.

Construct a histogram, frequency polygon, and ogive,
using relative frequencies for the data in Exercise 6.

Section 2-3

13.

Activities While Driving A survey of 1200 drivers
showed the percentage of respondents who did the fol-
lowing while driving. Construct a vertical bar graph and
a horizontal bar graph for the data.

Drink beverage 80%
Talk on cell phone 73
Eat a meal 41
Experience road rage 23
Smoke 21

Source: Nationwide Mutual Insurance Company.
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14.

15.

16.

17.

18.

Calories of Nuts The data show the number of calories
per ounce in selected types of nuts. Construct vertical
and horizontal bar graphs for the data.

Types Calories

Peanuts 160

Almonds 170

Macadamia 200

Pecans 190

Cashews 160

Classroom Technology The number of teachers

who use the types of technology in the classroom
is shown. Construct a Pareto chart for the data.
(Note: The respondents could select more than one
category.)

Type Number
Websites 280
Online games 215
Online videos 165
Online images 220

Source: Vera Quest Research.

Pet Care The data (in billions of dollars) show the
estimated amount of money spent on pet care in
the United States. Construct a Pareto chart for

the data.

Type of care Amount spent
Veterinarian care $14
Supplies and medicine 11
Grooming and boarding 4
Animal purchases 2

Source: American Pet Products Association.

Space Launches The data show the number of U.S.
space launches for the 10-year periods from 1960 to
2009. Construct a time series graph for the data and

analyze the graph.

Year | 60-69 70-79 80-89 90-99 100-109

Launches | 614 247 199 300 206

Source: NASA.

High School Dropout Rate The data show the high
school dropout rate for students for the years 2003 to
2009. Construct a time series graph and analyze the
graph.

Year | 2003 2004 2005 2006 2007 2008 2009

Percent | 99 103 94 93 87 80 8.1

Source: U.S. Department of Commerce.



19.

20.

21.

22.

23.

24.

Spending of College Freshmen The average amounts
spent by college freshmen for school items are shown.
Construct a pie graph for the data.

Electronics/computers $728
Dorm items 344
Clothing 141
Shoes 72

Source: National Retail Federation.

Career Changes A survey asked if people would like
to spend the rest of their careers with their present
employers. The results are shown. Construct a pie graph
for the data and analyze the results.

Answer Number of people
Yes 660
No 260
Undecided 80

Peyton Manning’s Colts Career Peyton Manning
played for the Indianapolis Colts for 14 years. (He did
not play in 2011.) The data show the number of touch-
downs he scored for the years 1998-2010. Construct a
dotplot for the data and comment on the graph.

26 33 27 49 31 27 33
26 26 29 28 31 33

Source: NFL.com

Songs on CDs The data show the number of songs on
each of 40 CDs from the author’s collection. Construct a
dotplot for the data and comment on the graph.

10 14 18 11
11 15 16 10
10 17 10 15
22 9 14 12
18 12 12 15
21 22 20 15
10 19 20 21
17 9 13 15
11 12 12 9
14 20 12 10

Museum Visitors The number of visitors to the Rail-
road Museum during 24 randomly selected hours is
shown here. Construct a stem and leaf plot for the data.

67 62 38 73 34 43 72 35
53 55 58 63 47 42 51 62
32 29 47 62 29 38 36 41

Public Libraries The numbers of public libraries in
operation for selected states are listed below. Organize
the data with a stem and leaf plot.

102 176 210 142 189 176 108
209 184 144 108 192 176

Source: World Almanac.

113 205

Review Exercises 103

25. Pain Relief The graph below shows the time it takes

Quick Pain Relief to relieve a person’s pain. The graph
below that shows the time a competitor’s product
takes to relieve pain. Why might these graphs be
misleading?

Ti
y ime
1 1 1 1 1 1 1 1 1 1 1 1 X
0 T T T T T T T T T T T
Quick pain relief
Time
y
T L L L L L L L L L L X
0 T T T T T T T T T T

Competitor’s product

26. Casino Payoffs The graph shows the payoffs

obtained from the White Oak Casino compared to
the nearest competitor’s casino. Why is this graph
misleading?

Payoff Amount

98%

Percent
[{e)
D
1
T

95%

White oak Competitor’s
casino casino
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= STATISTICS TODAY

HOW YOUF Data presented in numerical form do not convey an easy-to-interpret conclusion;
. however, when data are presented in graphical form, readers can see the visual im-
|dent|ty Can pact of the numbers. In the case of identity fraud, the reader can see that most of the
Be St0|en identity frauds are due to lost or stolen wallets, checkbooks, or credit cards, and very
.. few identity frauds are caused by online purchases or transactions.
—Revisited

Identity Fraud

Online purchases or

transactions 4% .

1%

Stolen mail or fraudulent
change of address

8% Lost or stolen wallet,
checkbook, or credit card

Computer viruses 38%

and hackers
9%

Corrupt
business Friends,

employees  acquaintances
15% 15%

The Federal Trade Commission suggests some ways to protect your identity:

1. Shred all financial documents no longer needed.
2. Protect your Social Security number.

3. Don’t give out personal information on the phone, through the mail, or over the
Internet.

4. Never click on links sent in unsolicited emails.
5. Don’t use an obvious password for your computer documents.
6. Keep your personal information in a secure place at home.

== Data Analysis

A Data Bank is found in Appendix B, or on the frequency distribution for the data. For the distribution,
World Wide Web by following links from draw a Pareto chart and describe briefly the nature of
www.mhhe.com/math/stat/bluman the chart.

1. From the Data Bank located in Appendix B, choose 3. From the Data Bank, select at least 30 subjects and con-
one of the following variables: age, weight, cholesterol struct a categorical distribution for their marital status.

level, systolic pressure, IQ, or sodium level. Select

at least 30 values. For these values, construct a grouped
frequency distribution. Draw a histogram, frequency
polygon, and ogive for the distribution. Describe briefly
the shape of the distribution.

. From the Data Bank, choose one of the following vari-
ables: educational level, smoking status, or exercise.
Select at least 20 values. Construct an ungrouped
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Draw a pie graph and describe briefly the findings.

. Using the data from Data Set IV in Appendix B, con-

struct a frequency distribution and draw a histogram.
Describe briefly the shape of the distribution of the
tallest buildings in New York City.

. Using the data from Data Set XI in Appendix B, con-

struct a frequency distribution and draw a frequency
polygon. Describe briefly the shape of the distribution
for the number of pages in statistics books.



6.

Using the data from Data Set IX in Appendix B, divide
the United States into four regions, as follows:

Northeast CT ME MA NH NJ NY PARIVT

Midwest IL IN IA KS MI MN MD MS NE ND OH
SD WI

South AL AR DE DC FL GA KY LA MD NC OK
SCTNTX VAWV

West AKAZ CA COHIID MT NV NM OR UT
WA WY

Chapter Quiz 105

Find the total population for each region, and draw a
Pareto chart and a pie graph for the data. Analyze the
results. Explain which chart might be a better represen-
tation for the data.

. Using the data from Data Set I in Appendix B, make a

stem and leaf plot for the record low temperatures in the
United States. Describe the nature of the plot.

== Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

In the construction of a frequency distribution, it is a
good idea to have overlapping class limits, such as
10-20, 20-30, 30—40.

. Histograms can be drawn by using vertical or horizontal

bars.

. It is not important to keep the width of each class the

same in a frequency distribution.

. Frequency distributions can aid the researcher in

drawing charts and graphs.

. The type of graph used to represent data is determined

by the type of data collected and by the researcher’s
purpose.

. In construction of a frequency polygon, the class limits

are used for the x axis.

. Data collected over a period of time can be graphed by

using a pie graph.

Select the best answer.

8.

10.

What is another name for the ogive?
a. Histogram

b. Frequency polygon

c. Cumulative frequency graph

d. Pareto chart

. What are the boundaries for 8.6-8.8?

a. 8-9

b. 8.5-8.9
c. 8.55-8.85
d. 8.65-8.75

What graph should be used to show the relationship
between the parts and the whole?

a. Histogram
b. Pie graph
c¢. Pareto chart
d. Ogive

11.

Except for rounding errors, relative frequencies should
add up to what sum?

0

1
50
100

0 SR

Complete these statements with the best answers.

12.

13.

14.

15.

16.

17.

18.

19.

The three types of frequency distributions are
, and

In a frequency distribution, the number of classes
should be between and

Data such as blood types (A, B, AB, O) can be organ-
ized into a(n) frequency distribution.

Data collected over a period of time can be graphed
using a(n) graph.

A statistical device used in exploratory data analysis
that is a combination of a frequency distribution and a
histogram is called a(n)

On a Pareto chart, the frequencies should be represented
on the axis.

Housing Arrangements A questionnaire on housing
arrangements showed this information obtained from
25 respondents. Construct a frequency distribution for
the data (H = house, A = apartment, M = mobile
home, C = condominium). These data will be used in
Exercise 19.

H C H M H A C A M
c M C A M A C cC M
C C H A H H M

Construct a pie graph for the data in Exercise 18.

2-65




106

20.

21.

22,

23.

24,

25.

Chapter 2 Frequency Distributions and Graphs

Items Purchased at a Convenience Store When 30
randomly selected customers left a convenience store,
each was asked the number of items he or she pur-
chased. Construct an ungrouped frequency distribution
for the data. These data will be used in Exercise 21.

2 9 4 3 6
6 2 8 6 5
7 5 3 8 6
6 2 3 2 4
6 9 9 8 9
4 2 1 7 4

Construct a histogram, a frequency polygon, and an
ogive for the data in Exercise 20.

Coal Consumption The following data represent the
energy consumption of coal (in billions of Btu) by each
of the 50 states and the District of Columbia. Use the
data to construct a frequency distribution and a relative
frequency distribution with 7 classes.

631 723 267 60 372 15 19 92 306 38
413 8 736 156 478 264 1015 329 679 1498
52 1365 142 423 365 350 445 776 1267 0
26 356 173 373 335 34 937 250 33 84

0 253 84 1224 743 582 2 33 0 426
474

Source: Time Almanac.

Construct a histogram, frequency polygon, and ogive
for the data in Exercise 22. Analyze the histogram.

Recycled Trash Construct a Pareto chart and a
horizontal bar graph for the number of tons (in millions)
of trash recycled per year by Americans based on an
Environmental Protection Agency study.

Type Amount
Paper 320.0
Iron/steel 292.0
Aluminum 276.0
Yard waste 242.4
Glass 196.0
Plastics 41.6

Source: USA TODAY.

Identity Thefts The results of a survey of 84 people
whose identities were stolen using various methods are
shown. Draw a pie chart for the information.

Lost or stolen wallet,

checkbook, or credit card 38
Retail purchases or telephone
transactions 15
Stolen mail 9
Computer viruses or hackers 8
Phishing 4
Other 10
84

Source: Javelin Strategy and Research.
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26.

27.

28.

29.

Gallons

Needless Deaths of Children 7The New England
Journal of Medicine predicted the number of needless
deaths due to childhood obesity. Draw a time series
graph for the data.

2020
130

2025
550

2030
1500

2035
3700

Year |
Deaths |

Museum Visitors The number of visitors to

the Historic Museum for 25 randomly selected
hours is shown. Construct a stem and leaf plot for
the data.

15 53 48 19 38
86 63 98 79 38
62 89 67 39 26
28 35 54 88 76
31 47 53 41 68
Parking Meter Revenue In a small city the number of

quarters collected from the parking meters is shown.
Construct a dotplot for the data.

13 12 11 7 16
10 16 15 7 11
3 5 14 3 6
8 3 10 9 3
5 7 8 9 9
9 2 6 4 11
7 4 2 8 10
7 17 4 11 8
2 5 5 14 6
3 9 3 12 3

Water Usage The graph shows the average number of
gallons of water a person uses for various activities.
Can you see anything misleading about the way the
graph is drawn?

Average Amount of Water Used

BT 23 gal
20 gal

101 .

6 gal

51 |
} 2 gal
0 — : —= ,
Showering Washing Flushing Brushing

dishes toilet teeth
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== Critical Thinking Challenges

1. The Great Lakes Shown are various statistics about
the Great Lakes. Using appropriate graphs (your choice)

and summary statements, write a report analyzing
the data.

Superior Michigan Huron Erie Ontario
Length (miles) 350 307 206 241 193
Breadth (miles) 160 118 183 57 53
Depth (feet) 1,330 923 750 210 802
Volume (cubic miles) 2,900 1,180 850 116 393
Area (square miles) 31,700 22,300 23,000 9,910 7,550
Shoreline (U.S., miles) 863 1,400 580 431 300

Source: The World Almanac and Book of Facts.

2. Teacher Strikes In Pennsylvania there were more
teacher strikes in 2004 than there were in all other states
combined. Because of the disruptions, state legislators
want to pass a bill outlawing teacher strikes and submit-
ting contract disputes to binding arbitration. The graph
shows the number of teacher strikes in Pennsylvania for
the school years 1997 to 2011. Use the graph to answer
these questions.

a. In what year did the largest number of strikes
occur? How many were there?

b. In what year did the smallest number of teacher
strikes occur? How many were there?

c. In what year was the average duration of the strikes
the longest? How long was it?

d. In what year was the average duration of the strikes
the shortest? How long was it?

e. In what year was the number of teacher strikes the
same as the average duration of the strikes?

/- Find the difference in the number of strikes for the

school years 1997-1998 and 2010-2011.

g. Do you think teacher strikes should be outlawed?
Justify your conclusions.

Teacher Strikes in Pennsylvania

y
° © Number of strikes
25+ ° ® Average no. of days
204 H
[ ]
>
€ 15+ °
= [ ] [ ]
= o ° ° () °
10+ ¢ .
¢ ) > .
v o @
[ 4 [ ] ) [
5__
o
X
0 t t t t t t t t t t t t t t
O O A > 6 O A D O L AN
LTS
7/ 7/ 7 7 / 7/ 4 / 7 7 7 7 " 4
S T F S S
o S S A P R A D A DA R A )

School year

Source: Pennsylvania School Boards Association.

== Data Projects

Where appropriate, use the TI-84 Plus, Excel, MINITAB,
or a computer program of your choice to complete the
following exercises.

1. Business and Finance Consider the 30 stocks listed as
the Dow Jones Industrials. For each, find its earnings

per share. Randomly select 30 stocks traded on the
NASDAQ. For each, find its earnings per share. Create
a frequency table with 5 categories for each data set.
Sketch a histogram for each. How do the two data sets
compare?
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2. Sports and Leisure Use systematic sampling to create

a sample of 25 National League and 25 American
League baseball players from the most recently com-
pleted season. Find the number of home runs for each
player. Create a frequency table with 5 categories for
each data set. Sketch a histogram for each. How do the
two leagues compare?

. Technology Randomly select 50 songs from your
music player or music organization program. Find the
length (in seconds) for each song. Use these data to
create a frequency table with 6 categories. Sketch a
frequency polygon for the frequency table. Is the
shape of the distribution of times uniform, skewed,
or bell-shaped? Also note the genre of each song.
Create a Pareto chart showing the frequencies of

the various categories. Finally, note the year each
song was released. Create a pie chart organized by
decade to show the percentage of songs from various
time periods.

= Answers to Applying the Concepts

Section 2-1 Ages of Presidents at Inauguration

1. The data were obtained from the population of all

Presidents at the time this text was written.

2. The oldest inauguration age was 69 years old.
3. The youngest inauguration age was 42 years old.

4. Answers will vary. One possible answer is

Age at
inauguration Frequency

42-45 2
46-49 7
50-53 8
54-57 16
58-61 5
62-65 4
66-69 2

. Answers will vary. For the frequency distribution given
in question 4, there is a peak for the 5457 class.

. Answers will vary. This frequency distribution shows
no outliers. However, if we had split our frequency into
14 classes instead of 7, then the ages 42, 43, 68, and
69 might appear as outliers.

. Answers will vary. The data appear to be unimodal and
fairly symmetric, centering on 55 years of age.

Section 2-2 Selling Real Estate

1. A histogram of the data gives price ranges and the

counts of homes in each price range. We can also talk
about how the data are distributed by looking at a
histogram.

2. A frequency polygon shows increases or decreases in

the number of home prices around values.
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4. Health and Wellness Use information from the Red

3.

4.

5.

6.

Cross to create a pie chart depicting the percentages of
Americans with various blood types. Also find informa-
tion about blood donations and the percentage of each
type donated. How do the charts compare? Why is the
collection of type O blood so important?

. Politics and Economics Consider the U.S. Electoral

College System. For each of the 50 states, determine the
number of delegates received. Create a frequency table
with 8 classes. Is this distribution uniform, skewed, or
bell-shaped?

. Your Class Have each person in class take his or her

pulse and determine the heart rate (beats in 1 minute).
Use the data to create a frequency table with 6 classes.
Then have everyone in the class do 25 jumping jacks
and immediately take the pulse again after the activity.
Create a frequency table for those data as well. Com-
pare the two results. Are they similarly distributed? How
does the range of scores compare?

A cumulative frequency polygon shows the number of
homes sold at or below a given price.

The house that sold for $321,550 is an extreme value in
this data set.

Answers will vary. One possible answer is that the his-
togram displays the outlier well since there is a gap in
the prices of the homes sold.

The distribution of the data is skewed to the right.

Section 2-3 Gauses of Accidental Deaths in the
United States

1.

The variables in the graph are the year, cause of death,
and number of deaths in thousands.

. The cause of death is qualitative, while the year and

number of deaths are quantitative.

3. A time series graph is used here.

4. The motor vehicle accidents showed a slight increase

from 1999 to 2007, and then a decrease.

. The number of deaths due to poisoning and falls is

increasing.

. The number of deaths due to drowning remains about

the same over the years.

. For 2001, about 44,000 people died in motor vehicle

accidents, about 15,000 people died from falls, about
14,000 people died from poisoning, and about 3000
people died from drowning.

. In 1999, motor vehicle accidents claimed the most lives,

while in 2009, poisoning claimed the most lives.

. Around 2002, the number of deaths from falls and

poisoning were about the same.
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= STATISTICS TODAY

How Long Are You Delayed by Road
Congestion?

No matter where you live, at one time or another, you have been
stuck in traffic. To see whether there are more traffic delays in some
cities than in others, statisticians make comparisons using descrip-
tive statistics. A statistical study by the Texas Transportation Institute
found that a driver is delayed by road congestion an average of
36 hours per year. To see how selected cities compare to this aver-
age, see Statistics Today —Revisited at the end of the chapter.

This chapter will show you how to obtain and interpret descrip-
tive statistics such as measures of average, measures of variation,
and measures of position.

OUTLINE

Introduction

3-1 Measures of Central Tendency

3-2 Measures of Variation

3-8 Measures of Position

3-4 Exploratory Data Analysis
Summary

OBJECTIVES

After completing this chapter, you should be able to

0 Summarize data, using measures of central
tendency, such as the mean, median,
mode, and midrange.

Describe data, using measures of variation,
such as the range, variance, and standard
deviation.

set, using various measures of position,

e Identify the position of a data value in a data
such as percentiles, deciles, and quartiles.

Use the techniques of exploratory data
analysis, including boxplots and five-number
summaries, to discover various aspects

of data.
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I Interesting Fact

A person has on average
1460 dreams in 1 year.

3-2

Introduction

Chapter 2 showed how you can gain useful information from raw data by organizing them
into a frequency distribution and then presenting the data by using various graphs. This
chapter shows the statistical methods that can be used to summarize data. The most famil-
iar of these methods is the finding of averages.

For example, you may read that the average speed of a car crossing midtown Manhattan
during the day is 5.3 miles per hour or that the average number of minutes an American
father of a 4-year-old spends alone with his child each day is 42.!

In the book American Averages by Mike Feinsilber and William B. Meed, the authors
state:

“Average” when you stop to think of it is a funny concept. Although it describes all of us it
describes none of us. . . . While none of us wants to be the average American, we all want to
know about him or her.

The authors go on to give examples of averages:

The average American man is five feet, nine inches tall; the average woman is five feet,

3.6 inches.

The average American is sick in bed seven days a year missing five days of work.

On the average day, 24 million people receive animal bites.

By his or her 70th birthday, the average American will have eaten 14 steers, 1050 chickens,
3.5 lambs, and 25.2 hogs.?

In these examples, the word average is ambiguous, since several different methods
can be used to obtain an average. Loosely stated, the average means the center of the
distribution or the most typical case. Measures of average are also called measures of
central tendency and include the mean, median, mode, and midrange.

Knowing the average of a data set is not enough to describe the data set entirely. Even
though a shoe store owner knows that the average size of a man’s shoe is size 10, she
would not be in business very long if she ordered only size 10 shoes.

“Harper’s Index,” Harper’s magazine.
2Mike Feinsilber and William B. Meed, American Averages (New York: Bantam Doubleday Dell).
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As this example shows, in addition to knowing the average, you must know how the
data values are dispersed. That is, do the data values cluster around the average, or are
they spread more evenly throughout the distribution? The measures that determine the
spread of the data values are called measures of variation, or measures of dispersion.
These measures include the range, variance, and standard deviation.

Finally, another set of measures is necessary to describe data. These measures are
called measures of position. They tell where a specific data value falls within the data set
or its relative position in comparison with other data values. The most common position
measures are percentiles, deciles, and quartiles. These measures are used extensively in
psychology and education. Sometimes they are referred to as norms.

The measures of central tendency, variation, and position explained in this chapter are
part of what is called traditional statistics.

Section 3—4 shows the techniques of what is called exploratory data analysis. These
techniques include the boxplot and the five-number summary. They can be used to explore
data to see what they show (as opposed to the traditional techniques, which are used to
confirm conjectures about the data).

Measures of Central Tendency

OBJECTIVE @

Summarize data, using
measures of central
tendency, such as the
mean, median, mode,
and midrange.

I Historical Note

In 1796, Adolphe

Quetelet investigated the

characteristics (heights,
weights, etc.) of French
conscripts to determine
the “average man.”
Florence Nightingale
was so influenced by
Quetelet’s work that she
began collecting and
analyzing medical
records in the military
hospitals during the
Crimean War. Based on
her work, hospitals
began keeping accurate
records on their
patients.

Chapter 1 stated that statisticians use samples taken from populations; however, when
populations are small, it is not necessary to use samples since the entire population can be
used to gain information. For example, suppose an insurance manager wanted to know the
average weekly sales of all the company’s representatives. If the company employed a
large number of salespeople, say, nationwide, he would have to use a sample and make an
inference to the entire sales force. But if the company had only a few salespeople, say,
only 87 agents, he would be able to use all representatives’ sales for a randomly chosen
week and thus use the entire population.

Measures found by using all the data values in the population are called parameters.
Measures obtained by using the data values from samples are called statistics; hence, the
average of the sales from a sample of representatives is a statistic, and the average of sales
obtained from the entire population is a parameter.

A statistic is a characteristic or measure obtained by using the data values from a
sample.

A parameter is a characteristic or measure obtained by using all the data values
from a specific population.

These concepts as well as the symbols used to represent them will be explained in
detail in this chapter.

General Rounding Rule In statistics the basic rounding rule is that when computa-
tions are done in the calculation, rounding should not be done until the final answer is
calculated. When rounding is done in the intermediate steps, it tends to increase the dif-
ference between that answer and the exact one. But in the textbook and solutions manual,
it is not practical to show long decimals in the intermediate calculations; hence, the val-
ues in the examples are carried out to enough places (usually three or four) to obtain the
same answer that a calculator would give after rounding on the last step.

There are specific rounding rules for many statistics, and they will be given in the
appropriate sections.

The Mean

The mean, also known as the arithmetic average, is found by adding the values of the data
and dividing by the total number of values. For example, the mean of 3, 2, 6, 5, and 4 is
found by adding 3 + 2 + 6 + 5 + 4 = 20 and dividing by 5; hence, the mean of the data
is 20 + 5 = 4. The values of the data are represented by X’s. In this data set, X; = 3, X; = 2,

3-3
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X3 =6,X, =5, and X5 = 4. To show a sum of the total X values, the symbol X (the cap-
ital Greek letter sigma) is used, and 2X means to find the sum of the X values in the data
set. The summation notation is explained on the online resource section under “Algebra
Review.”

The mean is the sum of the values, divided by the total number of values.
The sample mean, denoted by X (pronounced “X bar”), is calculated by using
sample data. The sample mean is a statistic.
Y:X1 +X2+X3+-~~+Xn:§

n n
where n represents the total number of values in the sample.

The population mean, denoted by u (pronounced “mew?”), is calculated by using all
the values in the population. The population mean is a parameter.

e N N
where N represents the total number of values in the population.

In statistics, Greek letters are used to denote parameters, and Roman letters are used to
denote statistics. Assume that the data are obtained from samples unless otherwise specified.

Rounding Rule for the Mean The mean should be rounded to one more decimal
place than occurs in the raw data. For example, if the raw data are given in whole num-
bers, the mean should be rounded to the nearest tenth. If the data are given in tenths, the
mean should be rounded to the nearest hundredth, and so on.

EXAMPLE 3-1 Police Incidents

The number of calls that a local police department responded to for a sample of
9 months is shown. Find the mean. (Data were obtained by the author.)

475, 447, 440, 761, 993, 1052, 783, 671, 621

X:gz 475 + 447 + 440 + 761 + 993 + 1052 + 783 + 671 + 621
n 9
= %% 693.7

Hence, the mean number of incidents per month to which the police responded is 693.7.

EXAMPLE 3-2 Hospital Infections
The data show the number of patients in a sample of six hospitals who acquired an
infection while hospitalized. Find the mean.

110 76 29 38 105 31

Source: Pennsylvania Health Care Cost Containment Council.

SOLUTION

)?Z%I110+76+29;38+105+31=%=64.8

The mean of the number of hospital infections for the six hospitals is 64.8.

The mean, in most cases, is not an actual data value.
The procedure for finding the mean for grouped data assumes that the mean of all the
raw data values in each class is equal to the midpoint of the class. In reality, this is not true,
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since the average of the raw data values in each class usually will not be exactly equal to
the midpoint. However, using this procedure will give an acceptable approximation of the
mean, since some values fall above the midpoint and other values fall below the midpoint
for each class, and the midpoint represents an estimate of all values in the class.

The steps for finding the mean for grouped data are shown in the next Procedure
Table.

Procedure Table

Finding the Mean for Grouped Data
Step 1 Make a table as shown.

A B C
Class Frequency f | Midpoint X,

D
fXn

Step2  Find the midpoints of each class and place them in column C.

Step3  Multiply the frequency by the midpoint for each class, and place the product in
column D.

Step 4 Find the sum of column D.

Step5  Divide the sum obtained in column D by the sum of the frequencies obtained in
column B.

The formula for the mean is
2f-x,
n

[Note: The symbols 2f - ¥ mean to find the sum of the product of the frequency (f) and the
midpoint (X,,) for each class.]

X =

EXAMPLE 3-3 Miles Run per Week

Using the following frequency distribution (taken from Example 2-7), find the mean.
The data represent the number of miles run during one week for a sample of 20 runners.

Class boundaries Frequency

5.5-10.5 1
10.5-15.5 2
15.5-20.5 3
20.5-25.5 5

4
3
2

25.5-30.5
30.5-35.5
35.5-40.5

Total 20

SOLUTION

The procedure for finding the mean for grouped data is given here.
Step1 Make a table as shown.

A B C D
Class Frequency f | Midpoint X, f-Xn

5.5-10.5
10.5-15.5
15.5-20.5
20.5-25.5
25.5-30.5
30.5-35.5
35.5-40.5

8
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The histogram shows the ages of the top 50 wealthiest
individuals according to Forbes Magazine for a recent
year. The mean age is 66 years. The median age is

I Interesting Fact Step 2
The average time it
takes a person to find a
new job is 5.9 months.
Step 3
Frmm— Step 4
Unusual Stat Step 5

A person looks, on
average, at about
14 homes before he
or she buys one.

e —
= SPEAKING OF STATISTICS

Ages of the Top 50 Wealthiest People

68 years. Explain why these two statistics are not
enough to adequately describe the data.

Ages of the Top 50 Wealthiest Persons

—_
—“Nwhs~o
N I |

Frequency

=
O—=MNWhUIOONOOO

34.5 445 54.5 64.5 74.5 84.5 94.5
Age (years)

Find the midpoints of each class and enter them in column C.

_35+105 _ 10.5 + 15.5

i > > =13 etc.

For each class, multiply the frequency by the midpoint, as shown, and place
the product in column D.

1-8=8 2-13 =126 etc.
The completed table is shown here.
A B C D
Class Frequency f Midpoint X, f-Xn
5.5-10.5 1 8 8
10.5-15.5 2 13 26
15.5-20.5 3 18 54
20.5-25.5 5 23 115
25.5-30.5 4 28 112
30.5-35.5 3 33 99
35.5-40.5 2 38 76
n=20 2f Xm =490
Find the sum of column D.
Divide the sum by n to get the mean.
- 2f-X, 490 .
X = f = —— = 24.5 miles
n 20



I Historical Note

The concept of

median was used

by Gauss at the begin-
ning of the 19th century
and introduced as a
statistical concept by
Francis Galton around
1874. The mode was
first used by Karl
Pearson in 1894.
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The Median

An article recently reported that the median income for college professors was $43,250.
This measure of central tendency means that one-half of all the professors surveyed
earned more than $43,250, and one-half earned less than $43,250.

The median is the halfway point in a data set. Before you can find this point, the data
must be arranged in ascending or increasing order. When the data set is ordered, it is
called a data array. The median either will be a specific value in the data set or will fall
between two values, as shown in the next examples.

The median is the midpoint of the data array. The symbol for the median is MD.

The Procedure Table for finding the median is shown next.

Procedure Table

Finding the Median

Step1  Arrange the data values in ascending order.

Step2  Determine the number of values in the data set.

Step 3 a. If n is odd, select the middle data value as the median.

b. If n is even, find the mean of the two middle values. That is, add them and divide
the sum by 2.

EXAMPLE 3-4 Police Officers Killed

The number of police officers killed in the line of duty over the last 11 years is shown.
Find the median.

177 153 122 141 189 155 162 165 149 157 240

Source: National Law Enforcement Officers Memorial Fund.

SOLUTION

Step 1  Arrange the data in ascending order.
122, 141, 149, 153, 155, 157, 162, 165, 177, 189, 240

Step2 There are an odd number of data values, namely, 11.
Step 3  Select the middle data value.

122, 141, 149, 153, 155, 157, 162, 165, 177, 189, 240

T
Median

The median number of police officers killed for the 11-year period is 157.

EXAMPLE 3-5 Tornadoes in the United States

The number of tornadoes that have occurred in the United States over an 8-year period
follows. Find the median.

684, 764, 656, 702, 856, 1133, 1132, 1303

Source: The Universal Almanac.
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SOLUTION

Step 1  Arrange the data values in ascending order.

656, 684, 702, 764, 856, 1132, 1133, 1303
Step 2 There are an even number of data values, namely, 8.
Step 3 The middle two data values are 764 and 856.
656, 684, 702, 764, 856, 1132, 1133, 1303
1
Median

Since the middle point falls halfway between 764 and 856, find the median MD by
adding the two values and dividing by 2.

764 + 856 _ 1620
2 2

The median number of tornadoes is 810.

MD =

= 810

The Mode

The third measure of average is called the mode. The mode is the value that occurs most
often in the data set. It is sometimes said to be the most typical case.

The value that occurs most often in a data set is called the mode.

A data set that has only one value that occurs with the greatest frequency is said to be
unimodal.

If a data set has two values that occur with the same greatest frequency, both values
are considered to be the mode and the data set is said to be bimodal. If a data set has more
than two values that occur with the same greatest frequency, each value is used as the
mode, and the data set is said to be multimodal. When no data value occurs more than
once, the data set is said to have no mode. Note: Do not say that the mode is zero. That
would be incorrect, because in some data, such as temperature, zero can be an actual
value. A data set can have more than one mode or no mode at all. These situations will be
shown in some of the examples that follow.

EXAMPLE 3-6 NFL Signing Bonuses

Find the mode of the signing bonuses of eight NFL players for a specific year. The
bonuses in millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10
Source: USA TODAY.

SOLUTION

It is helpful to arrange the data in order, although it is not necessary.
10, 10, 10, 11.3, 12.4, 14.0, 18.0, 34.5

Since $10 million occurred 3 times—a frequency larger than any other number—the
mode is $10 million.
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EXAMPLE 3-7 Licensed Nuclear Reactors

The data show the number of licensed nuclear reactors in the United States for a recent
15-year period. Find the mode.

Source: The World Almanac and Book of Facts.

104 104 104 104 104
107 109 109 109 110
109 111 112 111 109

Since the values 104 and 109 both occur 5 times, the modes are 104 and 109. The data
set is said to be bimodal.

EXAMPLE 3-8 Accidental Firearm Deaths

The number of accidental deaths due to firearms for a six-year period is shown. Find the
mode.

649, 789, 642, 613, 610, 600

Source: National Safety Council.

SOLUTION

Since each value occurs only once, there is no mode.

The mode for grouped data is the modal class. The modal class is the class with the
largest frequency.

EXAMPLE 3-9 Miles Run per Week

Find the modal class for the frequency distribution of miles that 20 runners ran in one
week, used in Example 2-7.

Class Frequency

5.5-10.5
10.5-15.5
15.5-20.5
20.5-25.5
25.5-30.5
30.5-35.5
35.5-40.5

< Modal class

NDWRAOOITWN —

SOLUTION

The modal class is 20.5-25.5, since it has the largest frequency. Sometimes the midpoint
of the class is used rather than the boundaries; hence, the mode could also be given as
23 miles per week.

The mode is the only measure of central tendency that can be used in finding the most
typical case when the data are nominal or categorical.
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EXAMPLE 3-10 Area Boat Registrations

The data show the number of boats registered for six counties in southwestern
Pennsylvania. Find the mode.

Westmoreland 11,008

Butler 9,002

Washington 6,843

Beaver 6,367

Fayette 4,208

Armstrong 3,782
Source: Pennsylvania Fish and Boat Commission.

SOLUTION

Since the category with the highest frequency is Westmoreland, the most typical case is
Westmoreland. Hence, the mode is Westmoreland.

An extremely high or extremely low data value in a data set can have a striking effect
on the mean of the data set. These extreme values are called outliers. This is one reason
why, when analyzing a frequency distribution, you should be aware of any of these values.
For the data set shown in Example 3—11, the mean, median, and mode can be quite differ-
ent because of extreme values. A method for identifying outliers is given in Section 3-3.

EXAMPLE 3-11 Salaries of Personnel

A small company consists of the owner, the manager, the salesperson, and two technicians,
all of whose annual salaries are listed here. (Assume that this is the entire population.)

Staff Salary

Owner $100,000
Manager 40,000
Salesperson 24,000
Technician 18,000
Technician 18,000

Find the mean, median, and mode.

X _ $100,000 + 40,000 + 24,000 + 18,000 + 18,000  $200,000
o= W = 5 = 5 = $40,000

Hence, the mean is $40,000, the median is $24,000, and the mode is $18,000.

In Example 3-11, the mean is much higher than the median or the mode. This is so
because the extremely high salary of the owner tends to raise the value of the mean. In this
and similar situations, the median should be used as the measure of central tendency.

The Midrange

The midrange is a rough estimate of the middle. It is found by adding the lowest and high-
est values in the data set and dividing by 2. It is a very rough estimate of the average and
can be affected by one extremely high or low value.

The midrange is defined as the sum of the lowest and highest values in the data set,
divided by 2. The symbol MR is used for the midrange.

R = lowest value + highest value
; 2
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EXAMPLE 3-12 Bank Failures
The number of bank failures for a recent five-year period is shown. Find the midrange.

3,30, 148, 157, 71

Source: Federal Deposit Insurance Corporation.

The lowest data value is 3, and the highest data value is 157.
34+ 157 160
MR=——=—=280
2 2

The midrange for the number of bank failures is 80.

EXAMPLE 3-13 NFL Signing Bonuses

Find the midrange of data for the NFL signing bonuses in Example 3—6. The bonuses in
millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10

The lowest bonus is $10 million, and the largest bonus is $34.5 million.

10 + 345 445
2 2
Notice that this amount is larger than seven of the eight amounts and is not typical of

the average of the bonuses. The reason is that there is one very high bonus, namely,
$34.5 million.

MR =

= $22.25 million

In statistics, several measures can be used for an average. The most common mea-
sures are the mean, median, mode, and midrange. Each has its own specific purpose and
use. Exercises 36 through 38 show examples of other averages, such as the harmonic
mean, the geometric mean, and the quadratic mean. Their applications are limited to spe-
cific areas, as shown in the exercises.

The Weighted Mean

Sometimes, you must find the mean of a data set in which not all values are equally repre-
sented. Consider the case of finding the average cost of a gallon of gasoline for three taxis.
Suppose the drivers buy gasoline at three different service stations at a cost of $3.22, $3.53,
and $3.63 per gallon. You might try to find the average by using the formula

¢ X
n
_ 3.22 + 3.53 + 3.63 _ 10.38

3 3

= $3.46

But not all drivers purchased the same number of gallons. Hence, to find the true average
cost per gallon, you must take into consideration the number of gallons each driver
purchased.

The type of mean that considers an additional factor is called the weighted mean, and
it is used when the values are not all equally represented.

3-11
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Find the weighted mean of a variable X by multiplying each value by its correspon-
ding weight and dividing the sum of the products by the sum of the weights.

)7(7W1X1+W2X2+"'+ann72WX
Wit Wy + -+ W, Zw

where wq, Wy, . . ., W, are the weights and X1, X, . . ., X, are the values.

Example 3—14 shows how the weighted mean is used to compute a grade point average.
Since courses vary in their credit value, the number of credits must be used as weights.

EXAMPLE 3-14 Grade Point Average

A student received an A in English Composition I (3 credits), a C in Introduction to
Psychology (3 credits), a B in Biology I (4 credits), and a D in Physical Education
(2 credits). Assuming A = 4 grade points, B = 3 grade points, C = 2 grade points,
D = 1 grade point, and F = 0 grade points, find the student’s grade point average.

Course Credits (w) Grade (X)
English Composition | 3 A (4 points)
Introduction to Psychology 3 C (2 points)
Biology | 4 B (3 points)
Physical Education 2 D (1 point)

IUnusual Stat

Of people in the United X = — =27
States, 45% live within

15 minutes of their best

friend.

3-12

SwX 3-4+3.2+43+2.1 32

Sw 3+3+4+2 T 12

The grade point average is 2.7.

TABLE 3-1 Summary of Measures of Central Tendency

Measure Definition Symbol(s)
Mean Sum of values, divided by total number of values w, X
Median Middle point in data set that has been ordered MD
Mode Most frequent data value None
Midrange Lowest value plus highest value, divided by 2 MR

Table 3—1 summarizes the measures of central tendency.

Researchers and statisticians must know which measure of central tendency is being
used and when to use each measure of central tendency. The properties and uses of the
four measures of central tendency are summarized next.

Properties and Uses of Central Tendency

The Mean
1. The mean is found by using all the values of the data.

2. The mean varies less than the median or mode when samples are taken from the same
population and all three measures are computed for these samples.

3. The mean is used in computing other statistics, such as the variance.
4. The mean for the data set is unique and not necessarily one of the data values.
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5. The mean cannot be computed for the data in a frequency distribution that has an
open-ended class.

6. The mean is affected by extremely high or low values, called outliers, and may not be the
appropriate average to use in these situations.

The Median

1. The median is used to find the center or middle value of a data set.

2. The median is used when it is necessary to find out whether the data values fall into the
upper half or lower half of the distribution.

3. The median is used for an open-ended distribution.
4. The median is affected less than the mean by extremely high or extremely low values.

The Mode

1. The mode is used when the most typical case is desired.
2. The mode is the easiest average to compute.

3. The mode can be used when the data are nominal or categorical, such as religious prefer-
ence, gender, or political affiliation.

4. The mode is not always unique. A data set can have more than one mode, or the mode
may not exist for a data set.

The Midrange

1. The midrange is easy to compute.
2. The midrange gives the midpoint.
3. The midrange is affected by extremely high or low values in a data set.

Distribution Shapes

Frequency distributions can assume many shapes. The three most important shapes are pos-
itively skewed, symmetric, and negatively skewed. Figure 3—1 shows histograms of each.

In a positively skewed or right-skewed distribution, the majority of the data values
fall to the left of the mean and cluster at the lower end of the distribution; the “tail” is to the
right. Also, the mean is to the right of the median, and the mode is to the left of the median.

FIGURE 3-1 y
Types of Distributions

Mode Median Mean
(a) Positively skewed or right-skewed

X
Mean Mean Median Mode
Median
Mode
(b) Symmetric (c) Negatively skewed or left-skewed
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For example, if an instructor gave an examination and most of the students did poorly,
their scores would tend to cluster on the left side of the distribution. A few high scores
would constitute the tail of the distribution, which would be on the right side. Another ex-
ample of a positively skewed distribution is the incomes of the population of the United
States. Most of the incomes cluster about the low end of the distribution; those with high
incomes are in the minority and are in the tail at the right of the distribution.

In a symmetric distribution, the data values are evenly distributed on both sides of
the mean. In addition, when the distribution is unimodal, the mean, median, and mode are
the same and are at the center of the distribution. Examples of symmetric distributions are
1Q scores and heights of adult males.

When the majority of the data values fall to the right of the mean and cluster at
the upper end of the distribution, with the tail to the left, the distribution is said to be
negatively skewed or left-skewed. Also, the mean is to the left of the median, and the
mode is to the right of the median. As an example, a negatively skewed distribution results
if the majority of students score very high on an instructor’s examination. These scores
will tend to cluster to the right of the distribution.

When a distribution is extremely skewed, the value of the mean will be pulled toward
the tail, but the majority of the data values will be greater than the mean or less than the
mean (depending on which way the data are skewed); hence, the median rather than the
mean is a more appropriate measure of central tendency. An extremely skewed distribu-
tion can also affect other statistics.

A measure of skewness for a distribution is discussed in Exercise 48 in Section 3-2.

== Applying the Concepts 3-1

Teacher Salaries

The following data from several years ago represent salaries (in dollars) from a school district in
Greenwood, South Carolina.

10,000 11,000 11,000 12,500 14,300 17,500
18,000 16,600 19,200 21,560 16,400 107,000

1. First, assume you work for the school board in Greenwood and do not wish to raise taxes to
increase salaries. Compute the mean, median, and mode, and decide which one would best
support your position to not raise salaries.

2. Second, assume you work for the teachers’ union and want a raise for the teachers. Use the
best measure of central tendency to support your position.

3. Explain how outliers can be used to support one or the other position.

4. If the salaries represented every teacher in the school district, would the averages be
parameters or statistics?

5. Which measure of central tendency can be misleading when a data set contains outliers?

6. When you are comparing the measures of central tendency, does the distribution display any
skewness? Explain.

See page 184 for the answers.

1. Calories in Salads Are salads a healthy menu choice? entrée salads at several popular restaurants. Find the
Listed below are the number of calories in selected mean, median, mode and midrange for the data.
1165 1180 1090 1595 900 1100 985 1120 940 730
1270 1005 1180 700 1260 605 920 855 935 835
590 860 840 755 1450

3-14



2. Airport Parking The number of short-term parking
spaces at 15 airports is shown. Find the mean, median,
mode, and midrange for the data.

750 3400
900 8662
9239 690

Source: USA Today.

1962 700 203
260 1479 5905
9822 1131 2516

3. Natural Gas Drilling Sites The number of natural gas
drilling sites in Pennsylvania counties with drilling
operations is listed below. Find the mean, median, mode
and midrange for the data and discuss the differences in
these measures of central tendency. Which best describes
the center of the data?

9 112 1 1 6
20 136 85 3 58
26 2 2 2 473

693 1 2 560 4

1008 109 6 14 58
185 6 415 2 43
53 76 19 41 462
191 98

Source: Pennsylvania Dept. of Environmental Protection.

4. Observers in the Frogwatch Program The number of
observers in the Frogwatch USA program (a wildlife
conservation program dedicated to helping conserve
frogs and toads) for the top 10 states with the most
observers is 484, 483, 422, 396, 378, 352, 338, 331,
318, and 302. The top 10 states with the most active
watchers list these numbers of visits: 634, 464, 406,
267,219, 194, 191, 150, 130, and 114. Find the mean,
median, mode, and midrange for the data. Compare
the measures of central tendency for these two groups

of data.

Source: www.nwf.org/frogwatch

5. Violent Crimes Shown are the ten U.S. cities (with
population over 100,000) with the fewest number of
violent crimes reported in 2010. Find the mean, median,
mode, and midrange of the data.

Temecula, CA
Murriefa, CA
Surprise, AZ
Round Rock, TX
Frisco, TX

Source: Time Almanac 2012.

74
99
106
116
119

Irvine, CA
Cary, NC
Ambherst, NY
Simi Valley, CA
Norman, OK

120
120
121
129
132

6. Earnings of Nonliving Celebrities Forbes magazine
prints an annual Top-Earning Nonliving Celebrities list
(based on royalties and estate earnings). Find the mean,
median, mode, and midrange for the data. Comment on
the skewness. Figures represent millions of dollars.

Kurt Cobain 50 Ray Charles 10
Elvis Presley 42 Marilyn Monroe 8
Charles M. Schulz 35 Johnny Cash 8
John Lennon 24 J.R.R. Tolkien 7
Albert Einstein 20 George Harrison 7
Andy Warhol 19 Bob Marley 7
Theodore Geisel 10
(Dr. Seuss)

Source: articles.moneycentral.msn.com
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7. Moons of Jupiter The planet Jupiter has at least

10.

11.

62 moons. In 1610 Galileo first observed the four
brightest moons with a telescope. They are listed below
with their diameters. Find the mean, median, mode, and
midrange, and discuss which of these measures have
any meaningful application with respect to these data.
(Just for reference, the diameter of Earth is 3959 miles.)

Io 3643 km 2264 miles
Europa 3122 1940
Ganymede 5262 3270
Callisto 4821 2996

Source: Time Almanac 2012.

. Top-Paid CEOs The data shown are the total compen-

sation (in millions of dollars) for the 50 top-paid CEOs
for a recent year. Compare the averages, and state which
one you think is the best measure.

17.5 18.0 36.8 31.7 31.7
17.3 243 47.7 385 17.0
23.7 16.5 25.1 17.4 18.0
37.6 19.7 21.4 28.6 21.6
19.3 20.0 16.9 25.2 19.8
25.0 17.2 20.4 20.1 29.1
19.1 25.2 232 25.9 24.0
41.7 24.0 16.8 26.8 314
16.9 17.2 24.1 352 19.1
22.9 18.2 254 354 25.5

Source: USA TODAY.

. College Enrollments The enrollments at a random

selection of independent religiously controlled under-
graduate schools are indicated below. Find the mean,
median, mode, and midrange. Compare the mean and
median and what that says about the data.
1469 1860 1422 1023 2532

1080 2082 1371 1197 1484
Source: World Almanac 2012.

1409
1106

1648
1241

Foreign Workers The number of foreign workers’
certificates for the New England states and the
northwestern states is shown. Find the mean, median,
and mode for both areas and compare the results.

New England states Northwest states

6768 1870
3196 622
1112 620

819 23
1019 172
1795 112

Source: Department of Labor.

Distances of Stars Of the 25 brightest stars, the
distances from earth (in light-years) for those with dis-
tances less than 100 light-years are found below. Find
the mean, median, mode, and midrange for the data.

86 367 422 16.8 337 715 87.9
44 253 114 65.1 25.1 515

Source: New York Times Almanac 2010.
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12.

13.

14.

15.

16.
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Contest Spelling Words The last words given and
spelled correctly at the National Spelling Bee for the
past 21 years are spelled out below. Count the number
of letters in each word, and find the mean, median,
mode, and midrange for the data.

fibranne euonym autochthonous
antipyretic chiaroscurist appoggiatura
lyceum logorrhea Ursprache
kamikaze demarche serrefine
antediluvian succedaneum guerdon
xanthosis propispicience stromuhr
vivisepulture pococurante cymatrichous

Source: World Almanac 2012.

Executive Bonuses A random sample of bonuses

(in millions of dollars) paid by large companies to their
executives is shown. Find the mean and modal class for
the data.

Class boundaries Frequency
0.5-3.5 11
3.5-6.5 12
6.5-9.5 4
9.5-12.5 2

12.5-15.5 1

Hourly Compensation for Production Workers The
hourly compensation costs (in U.S. dollars) for produc-
tion workers in selected countries are represented below.
Find the mean and modal class for the data.

Class Frequency
2.48-7.48 7
7.49-12.49 3

12.50-17.50 1
17.51-22.51 7
22.52-27.52 5
27.53-32.53 5

Compare the mean of these grouped data to the U.S.
mean of $21.97.

Source: New York Times Almanac.

Automobile Fuel Efficiency Thirty automobiles were
tested for fuel efficiency (in miles per gallon). This
frequency distribution was obtained. Find the mean and
modal class for the data.

Class boundaries Frequency
7.5-12.5 3
12.5-17.5 5
17.5-22.5 15
22.5-27.5 5
27.5-32.5 2

Percentage of Foreign-Born People The percentage
of foreign-born population for each of the 50 states is
represented here. Find the mean and modal class for
the data. Do you think the mean is the best average for
this set of data? Explain.

3-16

17.

18.

19.

20.

Percentage Frequency
0.8-4.4 26
4.5-8.1 11
8.2-11.8 4

11.9-15.5 5
15.6-19.2 2
19.3-22.9 1

23.0-26.6 1

Source: World Almanac.

Percentage of College-Educated Population over 25
Below are the percentages of the population over

25 years of age who have completed 4 years of college
or more for the 50 states and the District of Columbia.
Find the mean and modal class.

Percentage Frequency
15.2-19.6 3
19.7-24.1 15
24.2-28.6 19
28.7-33.1 6
33.2-37.6 7
37.7-42.1 0
42.2-46.6 1

Source: New York Times Almanac.

Net Worth of Corporations These data represent the net
worth (in millions of dollars) of 45 national corporations.
Find the mean and modal class for the data.

Class limits Frequency
10-20 2
21-31 8
32-42 15
43-53 7
54-64 10
65-75 3

Specialty Coffee Shops A random sample of 30 states
shows the number of specialty coffee shops for a spe-
cific company. Find the mean and modal class for the
data.

Class boundaries Frequency
0.5-19.5 12
19.5-38.5 7
38.5-57.5 5
57.5-76.5 3
76.5-95.5 3

Commissions Earned This frequency distribution repre-
sents the commission earned (in dollars) by 100 salespeo-
ple employed at several branches of a large chain store.
Find the mean and modal class for the data.

Class limits Frequency
150-158 5
159-167 16
168-176 20
177-185 21
186-194 20
195-203 15
204-212 3



21. Copier Service Calls This frequency distribution rep-
resents the data obtained from a sample of 75 copying
machine service technicians. The values represent the
days between service calls for various copying
machines. Find the mean and modal class for the data.

Class boundaries Frequency
15.5-18.5 14
18.5-21.5 12
21.5-24.5 18
24.5-27.5 10
27.5-30.5 15
30.5-33.5 6

22. Enrollments for Selected Independent Religiously
Controlled 4-Year Colleges Listed below are the
enrollments for selected independent religiously
controlled 4-year colleges that offer bachelor’s degrees
only. Construct a grouped frequency distribution with
six classes and find the mean and modal class.

1013 1867 1268 1666 2309 1231 3005 2895 2166 1136
1532 1461 1750 1069 1723 1827 1155 1714 2391 2155
1412 1688 2471 1759 3008 2511 2577 1082 1067 1062

1319 1037 2400

Source: World Almanac.

23. Find the weighted mean price of three models of
automobiles sold. The number and price of each
model sold are shown in this list.

Model Number Price
A 8 $10,000
B 10 12,000
C 12 8,000

24. Fat Grams Using the weighted mean, find the average
number of grams of fat per ounce of meat or fish that
a person would consume over a 5-day period if he ate

these:

Meat or fish Fat (g/oz)
3 oz fried shrimp 333

3 oz veal cutlet (broiled) 3.00

2 oz roast beef (lean) 2.50
2.5 oz fried chicken drumstick 4.40

4 oz tuna (canned in oil) 1.75
Source: The World Almanac and Book of Facts.

25. Diet Cola Preference A recent survey of a new diet
cola reported the following percentages of people
who liked the taste. Find the weighted mean of the

percentages.

Area % Favored Number surveyed
1 40 1000
2 30 3000
3 50 800

26.

27.

28.

29.

30.

31.

32.
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Costs of Helicopters The costs of three models of
helicopters are shown here. Find the weighted mean
of the costs of the models.

Model Number sold Cost

Sunscraper 9 $427,000
Skycoaster 6 365,000
High-flyer 12 725,000

Final Grade An instructor grades exams, 20%; term
paper, 30%; final exam, 50%. A student had grades of
83, 72, and 90, respectively, for exams, term paper, and
final exam. Find the student’s final average. Use the
weighted mean.

Final Grade Another instructor gives four 1-hour exams
and one final exam, which counts as two 1-hour exams.
Find a student’s grade if she received 62, 83, 97, and 90
on the 1-hour exams and 82 on the final exam.

For these situations, state which measure of central
tendency—mean, median, or mode—should be used.

a. The most typical case is desired.

b. The distribution is open-ended.

There is an extreme value in the data set.

The data are categorical.

Further statistical computations will be needed.

The values are to be divided into two approximately
equal groups, one group containing the larger values
and one containing the smaller values.

S S SV

Describe which measure of central tendency—mean,
median, or mode—was probably used in each
situation.

a. One-half of the factory workers make more than
$5.37 per hour, and one-half make less than
$5.37 per hour.

b. The average number of children per family in the
Plaza Heights Complex is 1.8.

¢. Most people prefer red convertibles over any other
color.

d. The average person cuts the lawn once a week.

e. The most common fear today is fear of speaking in
public.

f The average age of college professors is 42.3 years.

What types of symbols are used to represent sample
statistics? Give an example. What types of symbols
are used to represent population parameters? Give an
example.

A local fast-food company claims that the average
salary of its employees is $13.23 per hour. An employee
states that most employees make minimum wage. If
both are being truthful, how could both be correct?
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== Extending the Concepts

33.

34.

35.

36.

If the mean of five values is 64, find the sum of the
values.

If the mean of five values is 8.2 and four of the values
are 6, 10, 7, and 12, find the fifth value.

Find the mean of 10, 20, 30, 40, and 50.

a. Add 10 to each value and find the mean.

Subtract 10 from each value and find the mean.
Multiply each value by 10 and find the mean.

Divide each value by 10 and find the mean.

SRS T

Make a general statement about each situation.

Harmonic Mean The harmonic mean (HM) is defined
as the number of values divided by the sum of the recip-
rocals of each value. The formula is

n

M=3um

For example, the harmonic mean of 1, 4, 5, and 2 is

4

HM =
11+ 1/4+1/5+1/2

~ 2.051

This mean is useful for finding the average speed.
Suppose a person drove 100 miles at 40 miles per hour
and returned driving 50 miles per hour. The average
miles per hour is not 45 miles per hour, which is found
by adding 40 and 50 and dividing by 2. The average is
found as shown.

Since
Time = distance + rate
then
Time 1 = % = 2.5 hours to make the trip
Time 2 = % = 2 hours to return

Hence, the total time is 4.5 hours, and the total miles
driven are 200. Now, the average speed is
_ distance _ 200

Rate = ime 45 ~ 44.444 miles per hour

This value can also be found by using the harmonic
mean formula

2

M=——"— ~ 44444
1/40 + 1/50

Using the harmonic mean, find each of these.

a. A salesperson drives 300 miles round trip at
30 miles per hour going to Chicago and 45 miles
per hour returning home. Find the average miles
per hour.

3-18

b. A bus driver drives the 50 miles to West Chester at
40 miles per hour and returns driving 25 miles per
hour. Find the average miles per hour.

c. A carpenter buys $500 worth of nails at $50 per
pound and $500 worth of nails at $10 per pound.
Find the average cost of 1 pound of nails.

37. Geometric Mean The geometric mean (GM) is

defined as the nth root of the product of n values. The
formula is

GM = V(X)(X)(Xs) - - (X,)
The geometric mean of 4 and 16 is

GM = V(4)(16) = V64 = 8
The geometric mean of 1, 3, and 9 is

GM = V(1)(3)(9) = V27 = 3

The geometric mean is useful in finding the aver-
age of percentages, ratios, indexes, or growth rates.
For example, if a person receives a 20% raise after
1 year of service and a 10% raise after the second year
of service, the average percentage raise per year is not
15 but 14.89%, as shown.

GM = V/(1.2)(1.1) = 1.1489
or

GM = V/(120)(110) = 114.89%

His salary is 120% at the end of the first year and
110% at the end of the second year. This is equivalent
to an average of 14.89%, since 114.89% — 100% =
14.89%.

This answer can also be shown by assuming that
the person makes $10,000 to start and receives two
raises of 20% and 10%.

Raise 1 = 10,000 - 20% = $2000
Raise 2 = 12,000 - 10% = $1200

His total salary raise is $3200. This total is equivalent to

$10,000 - 14.89% = $1489.00
$11,489 - 14.89% = 1710.71

$3199.71 = $3200

Find the geometric mean of each of these.

a. The growth rates of the Living Life Insurance
Corporation for the past 3 years were 35, 24,
and 18%.

b. A person received these percentage raises in salary
over a 4-year period: 8, 6, 4, and 5%.

c. A stock increased each year for 5 years at these
percentages: 10, 8, 12, 9, and 3%.



d. The price increases, in percentages, for the cost of
food in a specific geographic region for the past
3 years were 1, 3, and 5.5%.

38. Quadratic Mean A useful mean in the physical
sciences (such as voltage) is the quadratic mean (QM),
which is found by taking the square root of the average
of the squares of each value. The formula is

2
oM = [sx
n

The quadratic mean of 3, 5, 6, and 10 is

32+ 52462+ 102
QM_\/ 4

= V425 = 6.519
Find the quadratic mean of §, 6, 3, 5, and 4.

AT I  Step by Step

EXCEL
Step by Step

Example XL3-1
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39. Median for Grouped Data An approximate median

can be found for data that have been grouped into a
frequency distribution. First it is necessary to find the
median class. This is the class that contains the median
value. That is the n/2 data value. Then it is assumed
that the data values are evenly distributed throughout the
median class. The formula is

MD = @(w) + L,

where  n = sum of frequencies
cf = cumulative frequency of class immedi-
ately preceding the median class
w = width of median class
f = frequency of median class
L,, = lower boundary of median class

Using this formula, find the median for data in the
frequency distribution of Exercise 16.

Finding Measures of Central Tendency

Find the mean, mode, and median of the data from Example 3—7. The data represent the popula-
tion of licensed nuclear reactors in the United States for a recent 15-year period.

104
107
109

104 104 104 104
109 109 109 110

112 111 109

1. On an Excel worksheet enter the numbers in cells A2-A16. Enter a label for the variable in

cell A1.

On the same worksheet as the data:

2. Compute the mean of the data: key in =AVERAGE(A2:A16) in a blank cell.
3. Compute the mode of the data: key in =MODE(A2:A16) in a blank cell.
4. Compute the median of the data: key in =MEDIAN(A2:A16) in a blank cell.

These and other statistical functions can also be accessed without typing them into the worksheet

directly.

1. Select the Formulas tab from the toolbar and select the Insert Function Icon ..

2. Select the Statistical category for statistical functions.
3. Scroll to find the appropriate function and click [OK].

A o c
Number of Reactors
104 107.7333 mean
104 104 mode
104 108 median

104
104
107
109
109
109
110
109
111
1z
111
109

I RERBREE 9w (vwe b winme

(Excel reports only the first mode in a bimodal or multimodal distribution.)
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Measures of Variation

OBJECTIVE @

Describe data, using
measures of variation, such
as the range, variance, and
standard deviation.

FIGURE 3-2
Examining Data Sets
Graphically

3-20

In statistics, to describe the data set accurately, statisticians must know more than the
measures of central tendency. Consider Example 3-15.

EXAMPLE 3-15 Comparison of Outdoor Paint

A testing lab wishes to test two experimental brands of outdoor paint to see how long
each will last before fading. The testing lab makes 6 gallons of each paint to test. Since
different chemical agents are added to each group and only six cans are involved, these
two groups constitute two small populations. The results (in months) are shown. Find
the mean of each group.

Brand A | Brand B
10 35
60 45
50 30
30 35
40 40
20 25
The mean for brand A is
>X 210
MEN T e T 35 months
The mean for brand B is
_ =X _210

M N 6 35 months

Since the means are equal in Example 3-15, you might conclude that both brands of
paint last equally well. However, when the data sets are examined graphically, a some-
what different conclusion might be drawn. See Figure 3-2.

As Figure 3-2 shows, even though the means are the same for both brands, the
spread, or variation, is quite different. Figure 3-2 shows that brand B performs more

Variation of paint (in months)
= = == == == ==
A A A A A A

10 20 30 35 40 50 60
(a) Brand A

Variation of paint (in months)

20 25 30 35 40 45 50
(b) Brand B
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consistently; it is less variable. For the spread or variability of a data set, three measures
are commonly used: range, variance, and standard deviation. Each measure will be dis-
cussed in this section.

Range
The range is the simplest of the three measures and is defined now.

The range is the highest value minus the lowest value. The symbol R is used for the
range.

R = highest value — lowest value

EXAMPLE 3-16 Comparison of Outdoor Paint

Find the ranges for the paints in Example 3-15.

SOLUTION

For brand A, the range is

R = 60 — 10 = 50 months
For brand B, the range is

R =45 — 25 = 20 months

Make sure the range is given as a single number.

The range for brand A shows that 50 months separate the largest data value from
the smallest data value. For brand B, 20 months separate the largest data value from the
smallest data value, which is less than one-half of brand A’s range.

One extremely high or one extremely low data value can affect the range markedly,
as shown in Example 3-17.

EXAMPLE 3-17 Employee Salaries

The salaries for the staff of the XYZ Manufacturing Co. are shown here. Find the
range.

Staff Salary
Owner $100,000
Manager 40,000
Sales representative 30,000
Workers 25,000
15,000
18,000

(SOLUTION]
The range is R = $100,000 — $15,000 = $85,000.

Since the owner’s salary is included in the data for Example 3—17, the range is a large
number. To have a more meaningful statistic to measure the variability, statisticians use
measures called the variance and standard deviation.

3-21
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Population Variance and Standard Deviation

Before these measures can be defined, it is necessary to know what data variation means.
It is based on the difference or distance each data value is from the mean. This difference
or distance is called a deviation. In the outdoor paint example, the mean for brand A paint
is w = 35 months, and for a specific can, say, the can that lasted for 50 months, the devi-
ationis X — pwor 50 — 35 = 15. Hence, the deviation for that data value is 15 months. If
you find the sum of the deviations for all data values about the mean (without rounding),
this sum will always be zero. That is, (X — u) = 0. (You can see this if you sum all the
deviations for the paint example.)

To eliminate this problem, we sum the squares, that is, =(X — w)* and find the mean
of these squares by dividing by N (the total number of data values), symbolically
S(X — w)*/N. This measure is called the population variance and is symbolized by o,
where o is the symbol for Greek lowercase letter sigma.

Since this measure (o%) is in square units and the data are in regular units, statisticians
take the square root of the variance and call it the standard deviation.

Formally defined,

The population variance is the average of the squares of the distance each value is
from the mean. The symbol for the population variance is o (o is the Greek lower-
case letter sigma).

The formula for the population variance is

C3(X - p)p?
- =4

0_2

where X = individual value
© = population mean
N = population size

The population standard deviation is the square root of the variance. The symbol

for the population standard deviation is o-.
The corresponding formula for the population standard deviation is

5 =X —ppP
o:\/;=\/N

To find the variance and standard deviation for a data set, the following Procedure
Table can be used.

Procedure Table

Finding the Population Variance and Population Standard Deviation

Step 1 Find the mean for the data.

LN

Step 2 Find the deviation for each data value.

X—p
Step3  Square each of the deviations.
(X — )y
Step4  Find the sum of the squares.
S(X - w)?



I Interesting Fact

The average American
drives about 10,000
miles a year.
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Step 5  Divide by N to get the variance.
S(X - u)’
N

2
o

Step 6  Take the square root of the variance to get the standard deviation.
\/E(X -’
7" N

Rounding Rule for the Standard Deviation The rounding rule for the standard
deviation is the same as that for the mean. The final answer should be rounded to one
more decimal place than that of the original data.

EXAMPLE 3-18 Comparison of Outdoor Paint

Find the variance and standard deviation for the data set for brand A paint in
Example 3—15. The number of months brand A lasted before fading was

10, 60, 50, 30, 40, 20

Step 1 Find the mean for the data.

_ 22X _ 10+60—i—50+30+40—i—20:@:35
N 6 6
Step2  Subtract the mean from each data value (X — w).
10 —35=-25 50 — 35 = +15 40 —35=+5
60 — 35 = +25 30-35=-5 20—-35=-15
Step3  Square each result (X — u)*.
(—25)? = 625 (+15)> =225 (+5)? =25
(+25)? = 625 (—5)?% =25 (—15)? =225
Step4 Find the sum of the squares =(X — w)>.
625 + 625 + 225 + 25 + 25 + 225 = 1750
[2(X — w)’]
N .
Variance = 1750 + 6 = 291.7

Step 6 Take the square root of the variance to get the standard deviation. Hence, the
standard deviation equals V' 291.7, or 17.1. It is helpful to make a table.

Step 5 Divide the sum by N to get the variance

A B C
ValuesX | X—pn (X — m)?
10 —25 625
60 +25 625
50 +15 225
30 -5 25
40 +5 25
20 —15 225
1750

Column A contains the raw data X. Column B contains the differences X — w obtained
in step 2. Column C contains the squares of the differences obtained in step 3.

3-23
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I Historical Note

Karl Pearson in 1892
and 1893 introduced the
statistical concepts of
the range and standard
deviation.

3-24

The preceding computational procedure reveals several things. First, the square root
of the variance gives the standard deviation; and vice versa, squaring the standard devia-
tion gives the variance. Second, the variance is actually the average of the square of the
distance that each value is from the mean. Therefore, if the values are near the mean, the
variance will be small. In contrast, if the values are far from the mean, the variance will
be large.

You might wonder why the squared distances are used instead of the actual distances.
As previously stated, the reason is that the sum of the distances will always be zero. To
verify this result for a specific case, add the values in column B of the table in Exam-
ple 3—18. When each value is squared, the negative signs are eliminated.

Finally, why is it necessary to take the square root? Again, the reason is that since the
distances were squared, the units of the resultant numbers are the squares of the units of
the original raw data. Finding the square root of the variance puts the standard deviation
in the same units as the raw data.

When you are finding the square root, always use its positive value, since the variance
and standard deviation of a data set can never be negative.

EXAMPLE 3-19 Comparison of Outdoor Paint

Find the variance and standard deviation for brand B paint data in Example 3—15. The
months brand B lasted before fading were

35, 45, 30, 35, 40, 25

Step1 Find the mean.
22X 35+45+30+35+40+25 210
SN 6 6
Step2  Subtract the mean from each value, and place the result in column B of the table.
35-35=0 45 —-35=10 30-35=-5
35-35=0 40—-35=5 25 —-35=-10

=35

Step 3  Square each result and place the squares in column C of the table.

A B c

X X—p | (X=pp
35 0 0
45 10 100
30 -5 25
35 0 0
40 5 25
25 -10 100

Step4 Find the sum of the squares in column C.
SX —w)?=0+ 100+ 25+ 0 + 25 + 100 = 250

Step 5 Divide the sum by N to get the variance.

S(X - w)’ 250
2 = —-——=" =
o= N 6 41.7

Step 6 Take the square root to get the standard deviation.

S(X — w)?
g = (1sz \V41.7 = 6.5

Hence, the standard deviation is 6.5.
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Since the standard deviation of brand A is 17.1 (see Example 3—18) and the standard
deviation of brand B is 6.5, the data are more variable for brand A. In summary, when the
means are equal, the larger the variance or standard deviation is, the more variable the
data are.

Sample Variance and Standard Deviation

When computing the variance for a sample, one might expect the following expression to
be used:
S(X - X)?
n

where X is the sample mean and # is the sample size. This formula is not usually used,
however, since in most cases the purpose of calculating the statistic is to estimate the
corresponding parameter. For example, the sample mean X is used to estimate the
population mean w. The expression

S(X - X)?
n
does not give the best estimate of the population variance because when the population is
large and the sample is small (usually less than 30), the variance computed by this for-
mula usually underestimates the population variance. Therefore, instead of dividing by n,

find the variance of the sample by dividing by n — 1, giving a slightly larger value and an
unbiased estimate of the population variance.

Formula for the Sample Variance

The formula for the sample variance (denoted by s?) is
3(X — X)?
N
where X = individual value

X = sample mean
n = sample size

To find the standard deviation of a sample, you must take the square root of the
sample variance, which was found by using the preceding formula.

Formula for the Sample Standard Deviation

The formula for the sample standard deviation, denoted by s, is

S_\ﬁ_\/E(X X)?

n—1

where X = individual value
X = sample mean
n = sample size

The procedure for finding the sample variance and the sample standard deviation is
the same as the procedure for finding the population variance and the population standard
deviation except the sum of the squares is divided by n — 1 (sample size minus 1) instead
of N (population size). Refer to the previous Procedure Table if necessary. The next example
shows these steps.

3-25
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EXAMPLE 3-20 Teacher Strikes

The number of public school teacher strikes in Pennsylvania for a random sample of
school years is shown. Find the sample variance and the sample standard deviation.

9 10 14 7 8 3

Source: Pennsylvania School Board Association.

SOLUTION

Step 1  Find the mean of the data values.
- +10+ 14 +7 + 8 +
X=¥=9 10+ 14+7+38 3=2=8.5
n 6 6
Step2 Find the deviation for each data value (X — X).

9—-85=05 10-85=15 14 —85=55
7—85=-15 8§ —85=-05 3—85=-55

Step3  Square each of the deviations (X — X).

(0.5)> = 0.25 (1.5 =225 (5.5)* = 30.25
(—1.5)% =225 (—0.5)? =0.25 (—5.5)> = 30.25

Step4 Find the sum of the squares.
S(X — X)* =025 + 2.25 + 30.25 + 2.25 + 0.25 + 30.25 = 65.5

Step 5 Divide by n — 1 to get the variance.
,_ SX-X)? 655 _ 655 _
n—1 6—1 5
Step 6  Take the square root of the variance to get the standard deviation.

=X - X7
s = \/(1) = V13.1 = 3.6 (rounded)

n—

13.1

Here the sample variance is 13.1, and the sample standard deviation is 3.6.

Shortcut formulas for computing the variance and standard deviation are presented
next and will be used in the remainder of the chapter and in the exercises. These formulas
are mathematically equivalent to the preceding formulas and do not involve using
the mean. They save time when repeated subtracting and squaring occur in the original
formulas. They are also more accurate when the mean has been rounded.

Shortcut or Computational Formulas for s2 and s

The shortcut formulas for computing the variance and standard deviation for data obtained
from samples are as follows.

Variance Standard deviation
,  n(EX%) - (2X) \/n(EXZ) - (=X)?
b n(n — 1) a n(n — 1)

Note that X2 is not the same as (2X)?. The notation 2X* means to square the val-
ues first, then sum; (X )2 means to sum the values first, then square the sum.
Example 3-21 explains how to use the shortcut formulas.
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EXAMPLE 3-21 Teacher Strikes

The number of public school teacher strikes in Pennsylvania for a random sample of
school years is shown. Find the sample variance and sample standard deviation.

9,10, 14,7,8,3

Step 1  Find the sum of the values:
2X=9+10+14+7+8+3=51
Step2 Square each value and find the sum:
3X2 =92+ 107 + 142 + 7% + 82 + 32 = 499
Step 3  Substitute in the formula and solve:

n(2X?) — (=X)?
nn—1)

2 _

6(499) — 517

66— 1)

_ 2994 — 2601
6(5)

_ 393
30
= 13.1

The variance is 13.1.
s = V13.1 = 3.6 (rounded)

Hence, the sample variance is 13.1, and the sample standard deviation is 3.6.
Notice that these are the same results as the results in Example 3-20.

Variance and Standard Deviation for Grouped Data

The procedure for finding the variance and standard deviation for grouped data is similar to
that for finding the mean for grouped data, and it uses the midpoints of each class.
This procedure uses the shortcut formula, and X, is the symbol for the class midpoint.

Shortcut or Computational Formula for s2 and s for Grouped Data

Sample variance:

s (S X) = (3 X,
n(n — 1)

N

Sample standard deviation

(- BT 5T
n(n — 1)

where X, is the midpoint of each class and f'is the frequency of each class.
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IU

nusual Stat

At birth men outnumber
women by 2%. By age
25, the number of men
living is about equal to
the number of women
living. By age 65, there
are 14% more women

living than men.
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The steps for finding the sample variance and sample standard deviation for grouped
data are summarized in this Procedure Table.

Procedure Table
Finding the Sample Variance and Standard Deviation for Grouped Data

Step 1 Make a table as shown, and find the midpoint of each class.

A

B

C

D

Class Frequency

Midpoint fXn

E
f-X3

Step2  Multiply the frequency by the midpoint for each class, and place the products in
column D.

Step3  Multiply the frequency by the square of the midpoint, and place the products in
column E.

Step 4 Find the sums of columns B, D, and E. (The sum of column B is n. The sum of
column D is 2f - X,,. The sum of column E is 3f - X2.)

Step 5  Substitute in the formula and solve to get the variance.
n(SfX2) = (S X,)

N n(n — 1)

Step 6  Take the square root to get the standard deviation.

2
N

EXAMPLE 3-22 Miles Run per Week

Find the sample variance and the sample standard deviation for the frequency distribu-
tion of the data in Example 2—7. The data represent the number of miles that 20 runners
ran during one week.

Class Frequency | Midpoint

5.5-10.5 1 8

10.5-15.5 2 13

15.5-20.5 3 18

20.5-25.5 5 23

25.5-30.5 4 28

30.5-35.5 3 33

35.5-40.5 2 38

Step1 Make a table as shown, and find the midpoint of each class.
A B C D E
Frequency | Midpoint
Class f L f-Xn f-X32

5.5-10.5 1 8
10.5-15.5 2 13
15.5-20.5 3 18
20.5-25.5 5 23
25.5-30.5 4 28
30.5-35.5 3 33
35.5-40.5 2 38




The average number of
times that a man cries in
amonthis 1.4.

Step 2

Step 3

Step 4

Step 5

Step 6
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Multiply the frequency by the midpoint for each class, and place the
products in column D.

1-8=8 2-13 =26 2-38=176
Multiply the frequency by the square of the midpoint, and place the products
in column E.
1-8 =64 2-132 =338 2 - 382 = 2888
Find the sums of columns B, D, and E. The sum of column B is n, the sum

of column D is 2f - X,,, and the sum of column E is 2f - X2. The completed
table is shown.

A B C D E

Class Frequency Midpoint f-Xn f-X2
5.5-10.5 1 8 8 64
10.5-15.5 2 13 26 338
15.5-20.5 3 18 54 972
20.5-25.5 5 23 115 2,645
25.5-30.5 4 28 112 3,136
30.5-35.5 3 33 99 3,267
35.5-40.5 2 38 76 2,888
n=20 SfeXp=490 | =f-X%=13310

Substitute in the formula and solve for s to get the variance.

, n(ZfXa) = (3 X,)
nn — 1)
~20(13,310) — 490°
20020 — 1)
266,200 — 240,100
a 20(19)
26,100
T 380
~ 68.7

N

Take the square root to get the standard deviation.

s = V68.7=283

Be sure to use the number found in the sum of column B (i.e., the sum of the
frequencies) for n. Do not use the number of classes.
The three measures of variation are summarized in Table 3-2.

I Unusual Stat TABLE 3-2 Summary of Measures of Variation

Measure Definition Symbol(s)

Range Distance between highest value and lowest value R

Variance Average of the squares of the distance that each value 02,82
is from the mean

Standard deviation Square root of the variance g, 8
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I Historical Note

Karl Pearson devised the
coefficient of variation to
compare the deviations
of two different groups
such as the heights of
men and women.

3-30

Uses of the Variance and Standard Deviation

1. As previously stated, variances and standard deviations can be used to determine the
spread of the data. If the variance or standard deviation is large, the data are more
dispersed. This information is useful in comparing two (or more) data sets to determine
which is more (most) variable.

2. The measures of variance and standard deviation are used to determine the consistency
of a variable. For example, in the manufacture of fittings, such as nuts and bolts, the
variation in the diameters must be small, or else the parts will not fit together.

3. The variance and standard deviation are used to determine the number of data values that
fall within a specified interval in a distribution. For example, Chebyshev’s theorem
(explained later) shows that, for any distribution, at least 75% of the data values will
fall within 2 standard deviations of the mean.

4. Finally, the variance and standard deviation are used quite often in inferential statistics.
These uses will be shown in later chapters of this textbook.

Coefficient of Variation

Whenever two samples have the same units of measure, the variance and standard devia-
tion for each can be compared directly. For example, suppose an automobile dealer wanted
to compare the standard deviation of miles driven for the cars she received as trade-ins
on new cars. She found that for a specific year, the standard deviation for Buicks was
422 miles and the standard deviation for Cadillacs was 350 miles. She could say that the
variation in mileage was greater in the Buicks. But what if a manager wanted to compare the
standard deviations of two different variables, such as the number of sales per salesperson
over a 3-month period and the commissions made by these salespeople?

A statistic that allows you to compare standard deviations when the units are differ-
ent, as in this example, is called the coefficient of variation.

The coefficient of variation, denoted by CVar, is the standard deviation divided by
the mean. The result is expressed as a percentage.

For samples, For populations,
CVar = = - 100 cvar = Z - 100
X 2

EXAMPLE 3-23 Sales of Automobiles

The mean of the number of sales of cars over a 3-month period is 87, and the standard
deviation is 5. The mean of the commissions is $5225, and the standard deviation is
$773. Compare the variations of the two.

SOLUTION

The coefficients of variation are

= S - 100 = 5.7% sales

CVar = :s

X 87

773 ..
CVar = 5205 - 100 = 14.8% commissions

Since the coefficient of variation is larger for commissions, the commissions are more
variable than the sales.
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EXAMPLE 3-24 Pages in Women'’s Fithess Magazines

The mean for the number of pages of a sample of women’s fitness magazines is 132,
with a variance of 23; the mean for the number of advertisements of a sample of
women’s fitness magazines is 182, with a variance of 62. Compare the variations.

SOLUTION

The coefficients of variation are

CVar = 7223 -100 = 3.6% pages

3

CVar = - 100 = 4.3% advertisements

182

The number of advertisements is more variable than the number of pages since the
coefficient of variation is larger for advertisements.

Range Rule of Thumb

The range can be used to approximate the standard deviation. The approximation is called
the range rule of thumb.

The Range Rule of Thumb

A rough estimate of the standard deviation is

range
4

s =

In other words, if the range is divided by 4, an approximate value for the standard
deviation is obtained. For example, the standard deviation for the data set 5, 8, 8, 9, 10,
12, and 13 is 2.7, and the range is 13 — 5 = 8. The range rule of thumb is s = 2. The range
rule of thumb in this case underestimates the standard deviation somewhat; however, it is
in the ballpark.

A note of caution should be mentioned here. The range rule of thumb is only an
approximation and should be used when the distribution of data values is unimodal and
roughly symmetric.

The range rule of thumb can be used to estimate the largest and smallest data values
of a data set. The smallest data value will be approximately 2 standard deviations below
the mean, and the largest data value will be approximately 2 standard deviations above the
mean of the data set. The mean for the previous data set is 9.3; hence,

Smallest data value = X — 2s = 9.3 — 2(2.7) = 3.9
Largest data value = X + 25 = 9.3 + 2(2.7) = 14.7

Notice that the smallest data value was 5, and the largest data value was 13. Again,
these are rough approximations. For many data sets, almost all data values will fall within
2 standard deviations of the mean. Better approximations can be obtained by using
Chebyshev’s theorem and the empirical rule. These are explained next.

Chebyshev’s Theorem

As stated previously, the variance and standard deviation of a variable can be used to
determine the spread, or dispersion, of a variable. That is, the larger the variance or stan-
dard deviation, the more the data values are dispersed. For example, if two variables
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measured in the same units have the same mean, say, 70, and the first variable has a stan-
dard deviation of 1.5 while the second variable has a standard deviation of 10, then the
data for the second variable will be more spread out than the data for the first variable.
Chebyshev’s theorem, developed by the Russian mathematician Chebyshev (1821-1894),
specifies the proportions of the spread in terms of the standard deviation.

Chebyshev’s theorem The proportion of values from a data set that will fall within k
standard deviations of the mean will be at least 1 — 1/k?, where k is a number greater
than 1 (k is not necessarily an integer).

This theorem states that at least three-fourths, or 75%, of the data values will fall
within 2 standard deviations of the mean of the data set. This result is found by substitut-
ing k = 2 in the expression

13
- el b R

For the example in which variable 1 has a mean of 70 and a standard deviation of 1.5,
at least three-fourths, or 75%, of the data values fall between 67 and 73. These values are
found by adding 2 standard deviations to the mean and subtracting 2 standard deviations
from the mean, as shown:

70 +2(1.5)=70+3 =173
and
70 — 2(1.5) =70 — 3 = 67

For variable 2, at least three-fourths, or 75%, of the data values fall between 50 and 90.
Again, these values are found by adding and subtracting, respectively, 2 standard devia-
tions to and from the mean.

70 + 2(10) =70 + 20 = 90
and
70 — 2(10) =70 — 20 = 50

Furthermore, the theorem states that at least eight-ninths, or 88.89%, of the data
values will fall within 3 standard deviations of the mean. This result is found by letting
k = 3 and substituting in the expression.

1—l or 1—L=1 L _

e =15 = 8889%

O | o0

For variable 1, at least eight-ninths, or 88.89%, of the data values fall between 65.5 and
74.5, since

70 +3(1.5) =70 +45="745
and
70 — 3(1.5) =70 — 45 =655

For variable 2, at least eight-ninths, or 88.89%, of the data values fall between 40 and 100.
In summary, then, Chebyshev’s theorem states

¢ At least three-fourths, or 75%, of all data values fall within 2 standard deviations of
the mean.

* At least eight-ninths, or 89%, of all data values fall within 3 standard deviations of
the mean.
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Chebyshev’s Theorem
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I At least |
I 88.89% I

| At least |

I 75% I

X-3s X-2s X X+2s X+3s

This theorem can be applied to any distribution regardless of its shape (see Figure 3-3).
Examples 3-25 and 3-26 illustrate the application of Chebyshev’s theorem.

EXAMPLE 3-25 Prices of Homes

The mean price of houses in a certain neighborhood is $50,000, and the standard devia-
tion is $10,000. Find the price range for which at least 75% of the houses will sell.

SOLUTION

Chebyshev’s theorem states that three-fourths, or 75%, of the data values will fall within
2 standard deviations of the mean. Thus,

$50,000 + 2($10,000) = $50,000 + $20,000 = $70,000
and
$50,000 — 2($10,000) = $50,000 — $20,000 = $30,000

Hence, at least 75% of all homes sold in the area will have a price range from $30,000
to $70,000.

Chebyshev’s theorem can be used to find the minimum percentage of data values that
will fall between any two given values. The procedure is shown in Example 3-26.

EXAMPLE 3-26 Travel Allowances

A survey of local companies found that the mean amount of travel allowance for couriers
was $0.25 per mile. The standard deviation was $0.02. Using Chebyshev’s theorem, find
the minimum percentage of the data values that will fall between $0.20 and $0.30.

SOLUTION

Step1  Subtract the mean from the larger value.
$0.30 — $0.25 = $0.05
Step 2 Divide the difference by the standard deviation to get .

0.05
k= 002 2.5
Step 3 Use Chebyshev’s theorem to find the percentage.
1 1 1
l_kz_1_2.52_1_6.25_1_0'16_0'84 or 84%

Hence, at least 84% of the data values will fall between $0.20 and $0.30.
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FIGURE 3-4
The Empirical Rule
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X
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The Empirical (Normal) Rule

Chebyshev’s theorem applies to any distribution regardless of its shape. However, when a
distribution is bell-shaped (or what is called normal), the following statements, which
make up the empirical rule, are true.

* Approximately 68% of the data values will fall within 1 standard deviation of
the mean.

» Approximately 95% of the data values will fall within 2 standard deviations of
the mean.

* Approximately 99.7% of the data values will fall within 3 standard deviations of
the mean.

For example, suppose that the scores on a national achievement exam have a mean of
480 and a standard deviation of 90. If these scores are normally distributed, then approxi-
mately 68% will fall between 390 and 570 (480 + 90 = 570 and 480 — 90 = 390).
Approximately 95% of the scores will fall between 300 and 660 (480 + 2 - 90 = 660
and 480 — 2 - 90 = 300). Approximately 99.7% will fall between 210 and 750 (480 +
3-90 =750 and 480 — 3 - 90 = 210). See Figure 3—4. (The empirical rule is explained in
greater detail in Chapter 6.)

Because the empirical rule requires that the distribution be approximately bell-
shaped, the results are more accurate than those of Chebyshev’s theorem, which applies
to all distributions.

== Applying the Concepts 3-2

Blood Pressure

The table lists means and standard deviations. The mean is the number before the plus/minus, and
the standard deviation is the number after the plus/minus. The results are from a study attempting
to find the average blood pressure of older adults. Use the results to answer the questions.

Normotensive Hypertensive
Men Women Men Women
(n = 1200) (n = 1400) (n = 1100) (n = 1300)
Age 55 =10 55 +10 60 = 10 64 =10
Blood pressure (mm Hg)
Systolic 123 +9 121 =11 153 + 17 156 + 20
Diastolic 78+7 767 91 =10 88 +10
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1. Apply Chebyshev’s theorem to the systolic blood pressure of normotensive men. At least
how many of the men in the study fall within 1 standard deviation of the mean?

2. At least how many of those men in the study fall within 2 standard deviations of the mean?

Assume that blood pressure is normally distributed among older adults. Answer the following
questions, using the empirical rule instead of Chebyshev’s theorem.

3. What are the ranges for the diastolic blood pressure (normotensive and hypertensive) of

older women?

4. Do the normotensive, male, systolic blood pressure ranges overlap with the hypertensive,
male, systolic blood pressure ranges?

See page 184 for the answers.

1. What is the relationship between the variance and the

standard deviation?

. Why might the range not be the best estimate of
variability?

. What are the symbols used to represent the population
variance and standard deviation?

. What are the symbols used to represent the sample vari-
ance and standard deviation?

. Why is the unbiased estimator of variance used?

. The three data sets have the same mean and range, but is
the variation the same? Prove your answer by comput-
ing the standard deviation. Assume the data were ob-
tained from samples.

a. 5,7,9,11,13,15,17
b. 5,6,7,11, 15, 16,17
c. 5,55 11,17,17,17

. Unemployment Benefits The average weekly unem-
ployment benefits (in dollars) for a random selection of
states are listed below. Calculate the range, variance,
and standard deviation for the data.

239 214 327 416 321 289 209 356
190 272 252 272 310 276 251
Source: World Almanac 2012.

. Cigarette Taxes The increases (in cents) in cigarette
taxes for 17 states in a 6-month period are

60, 20, 40, 40, 45, 12, 34, 51, 30, 70, 42, 31, 69, 32, 8,
18, 50

Find the range, variance, and standard deviation for the
data. Use the range rule of thumb to estimate the stan-

dard deviation. Compare the estimate to the actual stan-
dard deviation.

Source: Federation of Tax Administrators.

Men
‘Women

9.

Bowling Scores The scores from the last 10 years” U.S.
Bowling Congress Championships are shown below for
men and for women. Find the range, variance, and
standard deviation for each data set. Which set of data is
more variable?

823 837 858 791 812 814 832 862 833 826
752 764 754 774 771 745 736 816 792 793

Source: Time Almanac 2012.

10.

11.

12.

Size of U.S. States The total surface area (in square
miles) for each of six selected eastern states is listed
here.

28,995 PA 37,534 FL
31,361 NY 27,087 VA
20,966 ME 37,741 GA

The total surface area for each of six selected western
states is listed (in square miles).

72,964 AZ 70,763 NV
101,510 CA 62,161 OR
66,625 CoO 54,339 UuT

Find the standard deviation for each data set. Which set
is more variable?

Source: New York Times Almanac.

Multiple Births The numbers of various multiple
births in the United States for the past 10 years are
listed. Find the range, variance, and standard deviation
of the data sets. Which set of data is the most variable?

Triplets Quadruplets Quintuplets
5877 7110 5937 345 468 369 46 85 91
6898 6118 6885 434 355 501 69 67 85
6208 6742 6750 418 506 439 68 77 86

6742 512 67

Source: World Almanac 2012.

Starting Teachers’ Salaries Starting teachers’ salaries
(in equivalent U.S. dollars) for upper secondary educa-
tion in selected countries are listed. Find the range,

variance, and standard deviation for the data. Which set

3-35
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13.

14.

15.

16.

17.
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of data is more variable? (The U.S. average starting
salary at this time was $29,641.)

Europe Asia
Sweden $48,704 Korea $26,852
Germany 41,441 Japan 23,493
Spain 32,679 India 18,247
Finland 32,136 Malaysia 13,647
Denmark 30,384 Philippines 9,857
Netherlands 29,326 Thailand 5,862
Scotland 27,789

Source: World Almanac.

Ages of U.S. Astronaut Candidates The average age
of U.S. astronaut candidates in the past has been 34, but
candidates have ranged in age from 26 to 46. Use the
range rule of thumb to estimate the standard deviation
of the applicants’ ages.

Source: www.nasa.gov

Times Spent in Rush-Hour Traffic A sample of

12 drivers shows the time that they spent (in minutes)
stopped in rush-hour traffic on a specific snowy day last
winter. Find the range, variance, and standard deviation
for the data.

52 56 53
61 49 51
53 58 53
60 71 58

Prison Executions The numbers of prisoners executed
by the state since 1977 for the top 12 states are listed
below. Find the range, variance, and standard deviation
of the data.

X 355 LA 27 AR 27
VA 94 MO 66 AZ 22
AL 34 NC 39 FL 60
OK 79 GA 39 SC 35

Source: New York Times Almanac 2010.

Passenger Vehicle Deaths The number of people killed
in each state from passenger vehicle crashes for a spe-
cific year is shown. Find the range, variance, and stan-
dard deviation for the data.

718 309 1110 324 705
1067 826 76 205 152
218 492 65 186 712
193 262 452 875 82
730 1185 2707 1279 390
305 123 948 343 602
69 451 951 104 985
155 450 2080 565 875
414 981 2786 82 793
214 130 396 620 797

Source: National Highway Traffic Safety Administration.

Annual Precipitation Days The number of annual pre-
cipitation days for one-half of the 50 largest U.S. cities
is listed below. Find the range, variance, and standard
deviation of the data.

135 128 136 78 116 77 111 79 44 97
116 123 88 102 26 82 156 133 107 35
112 98 45 122 125
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18.

19.

20.

21.

22,

Use the data from Exercises 7, 15, and 17
(unemployment, prisoners, precipitation days) and
compare the standard deviation with that obtained
by the range rule of thumb (R/4.) Comment on the
results.

Cost per Load of Laundry Detergents The costs
per load (in cents) of 35 laundry detergents tested
by a consumer organization are shown here.

Find the variance and standard deviation for the
data.

Class limits Frequency
13-19 2
20-26 7
27-33 12
34-40 5
41-47 6
48-54 1
55-61 0
62-68 2

Automotive Fuel Efficiency Thirty automobiles were
tested for fuel efficiency (in miles per gallon). This
frequency distribution was obtained. Find the variance
and standard deviation for the data.

Class boundaries Frequency
7.5-12.5 3
12.5-17.5 5
17.5-22.5 15
22.5-27.5 5
27.5-32.5 2

Murders in Cities The data show the number of
murders in 25 selected cities. Find the variance and
standard deviation for the data.

Class limits Frequency
34-96 13
97-159 2

160-222 0

223-285 5

286-348 1

349411 1

412474 0

475-537 1

538-600 2

Reaction Times In a study of reaction times to a

specific stimulus, a psychologist recorded these data
(in seconds). Find the variance and standard deviation
for the data.

Class limits Frequency
2.1-2.7 12
2.8-34 13
3.5-4.1 7
4.2-4.8 5
4.9-55 2
5.6-6.2 1



23.

24.

25.

26.

27.

FM Radio Stations A random sample of 30 states
shows the number of low-power FM radio stations for
each state. Find the variance and standard deviation for
the data.

Class limits Frequency
1-9 5
10-18 7
19-27 10
28-36 3
37-45 3
46-54 2

Source: Federal Communications Commission.

Murder Rates The data represent the murder rate per
100,000 individuals in a sample of selected cities in the
United States. Find the variance and standard deviation
for the data.

Class limits Frequency
5-11 8
12-18 5
19-25 7
26-32 1
33-39 1
4046 3

Source: FBI and U.S. Census Bureau.

Battery Lives Eighty randomly selected batteries were
tested to determine their lifetimes (in hours). The
following frequency distribution was obtained. Find the
variance and standard deviation for the data.

Class boundaries Frequency
62.5-73.5 5
73.5-84.5 14
84.5-95.5 18
95.5-106.5 25

106.5-117.5 12

117.5-128.5 6

Can it be concluded that the lifetimes of these brands of
batteries are consistent?

Baseball Team Batting Averages Team batting aver-
ages for major league baseball in 2005 are represented
below. Find the variance and standard deviation for each
league. Compare the results.

NL AL
0.252-0.256 4 0.256-0.261 2
0.257-0.261 6 0.262-0.267 5
0.262-0.266 1 0.268-0.273 4
0.267-0.271 4 0.274-0.279 2
0.272-0.276 1 0.280-0.285 1

Source: World Almanac.

Missing Work The average number of days that
construction workers miss per year is 11. The standard

28.
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deviation is 2.3. The average number of days that factory
workers miss per year is 8 with a standard deviation of
1.8. Which class is more variable in terms of days
missed?

Suspension Bridges The lengths (in feet) of the main
span of the longest suspension bridges in the United
States and the rest of the world are shown below. Which
set of data is more variable?

United States 4205, 4200, 3800, 3500, 3478, 2800, 2800, 2310

World

29.

30.

31.

32.

33.

34.

35.

6570, 5538, 5328, 4888, 4626, 4544, 4518, 3970

Source: World Almanac.

Hospital Emergency Waiting Times The mean of

the waiting times in an emergency room is 80.2 minutes
with a standard deviation of 10.5 minutes for people who
are admitted for additional treatment. The mean waiting
time for patients who are discharged after receiving
treatment is 120.6 minutes with a standard deviation of
18.3 minutes. Which times are more variable?

Ages of Accountants The average age of the
accountants at Three Rivers Corp. is 26 years, with a
standard deviation of 6 years; the average salary of the
accountants is $31,000, with a standard deviation of
$4000. Compare the variations of age and income.

Using Chebyshev’s theorem, solve these problems
for a distribution with a mean of 80 and a standard
deviation of 10.

a. Atleast what percentage of values will fall between
60 and 100?

b. At least what percentage of values will fall between
65 and 95?

The mean of a distribution is 20 and the standard
deviation is 2. Use Chebyshev’s theorem.

a. Atleast what percentage of the values will fall
between 10 and 30?

b. At least what percentage of the values will fall
between 12 and 28?

In a distribution of 160 values with a mean of 72, at
least 120 fall within the interval 67-77. Approximately
what percentage of values should fall in the interval
62-82? Use Chebyshev’s theorem.

Calories The average number of calories in a regular-
size bagel is 240. If the standard deviation is 38 calories,
find the range in which at least 75% of the data will lie.
Use Chebyshev’s theorem.

Time Spent Online Americans spend an average of
3 hours per day online. If the standard deviation is
32 minutes, find the range in which at least 88.89%
of the data will lie. Use Chebyshev’s theorem.

Source: www.cs.cmu.edu
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36.

37.

38.

39.

4.
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Solid Waste Production The average college student
produces 640 pounds of solid waste each year. If the
standard deviation is approximately 85 pounds, within
what weight limits will at least 88.89% of all students’
garbage lie?

Source: Environmental Sustainability Committee, www.esc.mtu.edu

Sale Price of Homes The average sale price of new
one-family houses in the United States for 2003 was
$246,300. Find the range of values in which at least
75% of the sale prices will lie if the standard deviation
is $48,500.

Source: New York Times Almanac.

Trials to Learn a Maze The average of the number of
trials it took a sample of mice to learn to traverse a maze
was 12. The standard deviation was 3. Using Chebyshev’s
theorem, find the minimum percentage of data values that
will fall in the range of 420 trials.

Farm Sizes The average farm in the United States in
2004 contained 443 acres. The standard deviation is

42 acres. Use Chebyshev’s theorem to find the minimum
percentage of data values that will fall in the range of
338-548 acres.

Source: World Almanac.

Serum Cholesterol Levels For this data set, find the
mean and standard deviation of the variable. The data
represent the serum cholesterol levels of 30 individuals.
Count the number of data values that fall within 2 stan-
dard deviations of the mean. Compare this with the
number obtained from Chebyshev’s theorem. Comment
on the answer.

211 240 255 219 204
200 212 193 187 205
256 203 210 221 249
231 212 236 204 187
201 247 206 187 200
237 227 221 192 196

Ages of Consumers For this data set, find the mean and
standard deviation of the variable. The data represent the
ages of 30 customers who ordered a product advertised on
television. Count the number of data values that fall
within 2 standard deviations of the mean. Compare this
with the number obtained from Chebyshev’s theorem.
Comment on the answer.

42 44 62 35 20
30 56 20 23 41
55 22 31 27 66
21 18 24 42 25
32 50 31 26 36
39 40 18 36 22
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40.

41.

Citrus Fruit Consumption The average U.S. yearly
per capita consumption of citrus fruit is 26.8 pounds.
Suppose that the distribution of fruit amounts consumed
is bell-shaped with a standard deviation equal to

4.2 pounds. What percentage of Americans would

you expect to consume more than 31 pounds of citrus
fruit per year?

Source: USDA/Economic Research Service.

SAT Scores The national average for mathematics
SATs in 2011 was 514. Suppose that the distribution of
scores was approximately bell-shaped and that the stan-
dard deviation was approximately 40. Within what
boundaries would you expect 68% of the scores to fall?
What percentage of scores would be above 5947

42. Work Hours for College Faculty The average full-time

45.

46.

47.

faculty member in a postsecondary degree-granting

institution works an average of 53 hours per week.

a. If we assume the standard deviation is 2.8 hours,
what percentage of faculty members work more than
58.6 hours a week?

b. If we assume a bell-shaped distribution, what per-
centage of faculty members work more than
58.6 hours a week?

Source: National Center for Education Statistics.

== Extending the Concepts

43.

Using Chebyshev’s theorem, complete the table to find
the minimum percentage of data values that fall within
k standard deviations of the mean.

k | 1.5 2 25 3 3.5
Percent |
Use this data set: 10, 20, 30, 40, 50

a. Find the standard deviation.

b. Add 5 to each value, and then find the standard
deviation.

c. Subtract 5 from each value and find the standard
deviation.

d. Multiply each value by 5 and find the standard
deviation.

e. Divide each value by 5 and find the standard
deviation.

f Generalize the results of parts b through e.

g. Compare these results with those in Exercise 35 of
Exercises 3—1.

Mean Deviation The mean deviation is found by using
this formula:

X — X]|
n

Mean deviation =
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where X = value is zero; when the distribution is positively skewed, it is
positive; and when the distribution is negatively skewed,
it is negative.

Using the formula, find the coefficient of skewness

X = mean

n = number of values

| | = absolute value for each distribution, and describe the shape of the
Find the mean deviation for these data. distribution.
5,9,10, 11, 11, 12, 15, 18, 20, 22 a. Mean = 10, median = 8, standard deviation = 3.
b. Mean = 42, median = 45, standard deviation = 4.
48. Pearson Coefficient of Skewness A measure to deter- ¢. Mean = 18.6, median = 18.6, standard
mine the skewness of a distribution is called the Pearson deviation = 1.5.
coefficient (PC) of skewness. The formula is d. Mean = 98, median = 97.6, standard deviation = 4.
3(X — MD) 49. All values of a data set must be within s\Vn — 1 of the
PC = s mean. If a person collected 25 data values that had a
mean of 50 and a standard deviation of 3 and you
The values of the coefficient usually range from —3 to saw that one data value was 67, what would you
+3. When the distribution is symmetric, the coefficient conclude?

AT  Step by Step

EXCEL Finding Measures of Variation

Step by Step Example XL3-2
Find the sample variance, sample standard deviation, and range of the data from Example 3-20.

9 10 14 7 8 3
1. On an Excel worksheet enter the data in cells A2—A7. Enter a label for the variable in
cell Al.
2. In a blank cell enter =VAR(A2:A7) for the sample variance.
3. In a blank cell enter =STDEV(A2:A7) for the sample standard deviation.

4. For the range, compute the difference between the maximum and the minimum values by
entering =Max(A2:A7)-Min(A2:A7).
Note: The command for computing the population variance is VAR.P and for the population
standard deviation is STDEV.P
These and other statistical functions can also be accessed without typing them into the
worksheet directly.

J

2. Select the Statistical category for statistical functions.
3. Scroll to find the appropriate function and click [OK].

A B C D
1 Strikes
2 9 Variance 13.1
3 10 Standard Deviation 3.619392214
4 14 Range 11
5 7
b

8
A
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3-3

Measures of Position

OBJECTIVE @

Identify the position of a
data value in a data set,
using various measures
of position, such as
percentiles, deciles, and
quartiles.

I Interesting Fact

The average number

of faces that a person
learns to recognize and
remember during his or
her lifetime is 10,000.

3-40

In addition to measures of central tendency and measures of variation, there are measures
of position or location. These measures include standard scores, percentiles, deciles, and
quartiles. They are used to locate the relative position of a data value in the data set. For
example, if a value is located at the 80th percentile, it means that 80% of the values fall
below it in the distribution and 20% of the values fall above it. The median is the value
that corresponds to the 50th percentile, since one-half of the values fall below it and one-
half of the values fall above it. This section discusses these measures of position.

Standard Scores

There is an old saying, “You can’t compare apples and oranges.” But with the use of
statistics, it can be done to some extent. Suppose that a student scored 90 on a music test
and 45 on an English exam. Direct comparison of raw scores is impossible, since the
exams might not be equivalent in terms of number of questions, value of each question,
and so on. However, a comparison of a relative standard similar to both can be made. This
comparison uses the mean and standard deviation and is called a standard score or
z score. (We also use z scores in later chapters.)

A standard score or z score tells how many standard deviations a data value is above
or below the mean for a specific distribution of values. If a standard score is zero, then the
data value is the same as the mean.

A z score or standard score for a value is obtained by subtracting the mean from
the value and dividing the result by the standard deviation. The symbol for a stan-
dard score is z. The formula is

_ value — mean
standard deviation

For samples, the formula is
X—-X
s

z =
For populations, the formula is
X—p

(o

Z =

The z score represents the number of standard deviations that a data value falls
above or below the mean.

For the purpose of this section, it will be assumed that when we find z scores, the data
were obtained from samples.

EXAMPLE 3-27 Test Scores

A student scored 65 on a calculus test that had a mean of 50 and a standard deviation
of 10; she scored 30 on a history test with a mean of 25 and a standard deviation of 5.
Compare her relative positions on the two tests.

SOLUTION

First, find the z scores. For calculus the z score is

:X—X:@s—soz
s 10

z 1.5
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For history the z score is

30 — 25
z= 5 =1.0

Since the z score for calculus is larger, her relative position in the calculus class is higher
than her relative position in the history class.

Note that if the z score is positive, the score is above the mean. If the z score is 0, the
score is the same as the mean. And if the z score is negative, the score is below the mean.

EXAMPLE 3-28 Test Scores

Find the z score for each test, and state which is higher.

TestA X=38 X =40 =
Test B X=094 X =100 =10
For test A,
X—-X 38-40
7= = =—-04
s 5
For test B,
94 — 100
=——=-06
. 10

The score for test A is relatively higher than the score for test B.

When all data for a variable are transformed into z scores, the resulting distribution
will have a mean of 0 and a standard deviation of 1. A z score, then, is actually the num-
ber of standard deviations each value is from the mean for a specific distribution. In
Example 3-27, the calculus score of 65 was actually 1.5 standard deviations above the
mean of 50. This will be explained in greater detail in Chapter 6.

Percentiles

Percentiles are position measures used in educational and health-related fields to indicate
the position of an individual in a group.

Percentiles divide the data set into 100 equal groups.

Percentiles are symbolized by
PI,PZ’P3’---9P99

and divide the distribution into 100 groups.

Smallest Largest
data data
value P, P, P, Py Pog Py value
: 1 1 1 ° ° ° : 1 1 ]

1% 1% 1% 1% 1% 1%
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I
I Interesting Facts TABLE 3-3 Percentile Ranks and Scaled Scores on the Test of English
as a Foreign Language*

The highest recorded
temperature on earth Section 2: Section 3:
was 136°F in Libya Section 1: Structure Vocabulary Total
in 1922. The lowest Scaled Listening and written and reading scaled Percentile
score comprehension expression comprehension score rank
recorded temperature
on earth was —129°F 68 99 98
in Antarctica in 1983. 66 98 96 98 660 99
64 96 94 96 640 97
62 92 90 93 620 94
60 87 84 88 600 89
—58 81 76 81 580 82
56 73 68 72 560 73
54 64 58 61 540 62
52 54 48 50 520 50
50 42 38 40 500 39
48 32 29 30 480 29
46 22 21 23 460 20
44 14 15 16 440 13
42 9 10 11 420 9
40 5 7 8 400 5
38 3 4 5 380 3
36 2 3 3 360 1
34 1 2 2 340 1
32 1 1 320
30 1 1 300
Mean 51.5 52.2 514 517 Mean
S.D. 7.1 7.9 7.5 68 S.D.

*Based on the total group of 1,178,193 examinees.

Source: Reprinted by permission of Educational Testing Service, the copyright owner. However, the test question and any
other testing information are provided in their entirety by McGraw-Hill Companies, Inc. No endorsement of this publication
by Educational Testing Service should be inferred.

In many situations, the graphs and tables showing the percentiles for various mea-
sures such as test scores, heights, or weights have already been completed. Table 3-3
shows the percentile ranks for scaled scores on the Test of English as a Foreign Language.
If a student had a scaled score of 58 for section 1 (listening and comprehension), that stu-
dent would have a percentile rank of 81. Hence, that student did better than 81% of the
students who took section 1 of the exam.

Figure 3-5 shows percentiles in graphical form of weights of girls from ages 2 to 18.
To find the percentile rank of an 11-year-old who weighs 82 pounds, start at the 82-pound
weight on the left axis and move horizontally to the right. Find 11 on the horizontal axis
and move up vertically. The two lines meet at the 50th percentile curved line; hence, an
11-year-old girl who weighs 82 pounds is in the 50th percentile for her age group. If the
lines do not meet exactly on one of the curved percentile lines, then the percentile rank
must be approximated.

Percentiles are also used to compare an individual’s test score with the national norm.
For example, tests such as the National Educational Development Test (NEDT) are taken
by students in ninth or tenth grade. A student’s scores are compared with those of other

3-42



FIGURE 3-5
Weights of Girls by Age and
Percentile Rankings

Source: Distributed by Mead
Johnson Nutritional Division.
Reprinted with permission.

Section 3-3 Measures of Position 151

— 90
190
95th — |
180 b B
— 80
170 .
160 -/ 90th — |
y 4 = — 70
150 » |
/ 7/ ]
140 . 75th :
I/ — 60
130 yimw (50th ) —1
120 - ==
A 25th —
— y.4 - =
2 A A | — 50 £
= 110 — — =
= N/ > / 10th : -05.),
= 100 ya =
y i / ——
4 /1 5th— |
90 - 7 V4 - L 40
y Ay A 4 / |
@ # 4 1{ y Ammy 4
v 4 71/ /
/
70 — }‘I —
/ /— 1/ — 30
y.4 |
60 ‘I -
7 7
A " 4 =
50 4 A — 7 B
> .
y o — 20
40 ~ - >
> —
o
30 1754 B
20 10

2 3 4 5 6 7 8 9 10 (1D 12 13 14 15 16 17 18
Age (years)

students locally and nationally by using percentile ranks. A similar test for elementary
school students is called the California Achievement Test.

Percentiles are not the same as percentages. That is, if a student gets 72 correct an-
swers out of a possible 100, she obtains a percentage score of 72. There is no indication of
her position with respect to the rest of the class. She could have scored the highest, the low-
est, or somewhere in between. On the other hand, if a raw score of 72 corresponds to the
64th percentile, then she did better than 64% of the students in her class.

Percentile graphs can be constructed as shown in Example 3-29 and Figure 3-6. Per-
centile graphs use the same values as the cumulative relative frequency graphs described
in Section 2-2, except that the proportions have been converted to percents.

EXAMPLE 3-29 Systolic Blood Pressure

The frequency distribution for the systolic blood pressure readings (in millimeters of
mercury, mm Hg) of 200 randomly selected college students is shown here. Construct
a percentile graph.

3-43
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A B (H D
Class Cumulative | Cumulative

boundaries | Frequency | frequency percent
89.5-104.5 24
104.5-119.5 62
119.5-134.5 72
134.5-149.5 26
149.5-164.5 12
164.5-179.5 4
200

SOLUTION

Step 1 Find the cumulative frequencies and place them in column C.

Step 2  Find the cumulative percentages and place them in column D. To do this
step, use the formula

. cumulative frequency
Cumulative % = . - 100

For the first class,

Cumulative % = 24 - 100 = 12%

200
The completed table is shown here.
A B C D
Class Cumulative | Cumulative
boundaries Frequency frequency percent
89.5-104.5 24 24 12
104.5-119.5 62 86 43
119.5-134.5 72 158 79
134.5-149.5 26 184 92
149.5-164.5 12 196 98
164.5-179.5 4 200 100
200

Step 3  Graph the data, using class boundaries for the x axis and the percentages for
the y axis, as shown in Figure 3-6.

Once a percentile graph has been constructed, one can find the approximate corre-
sponding percentile ranks for given blood pressure values and find approximate blood
pressure values for given percentile ranks.

For example, to find the percentile rank of a blood pressure reading of 130, find
130 on the x axis of Figure 3—6 and draw a vertical line to the graph. Then move horizon-
tally to the value on the y axis. Note that a blood pressure of 130 corresponds to approxi-
mately the 70th percentile.

If the value that corresponds to the 40th percentile is desired, start on the y axis at
40 and draw a horizontal line to the graph. Then draw a vertical line to the x axis and read
the value. In Figure 3-6, the 40th percentile corresponds to a value of approximately 118.
Thus, if a person has a blood pressure of 118, he or she is at the 40th percentile.

Finding values and the corresponding percentile ranks by using a graph yields only
approximate answers. Several mathematical methods exist for computing percentiles for
data. These methods can be used to find the approximate percentile rank of a data value



FIGURE 3-6
Percentile Graph for
Example 3-29
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or to find a data value corresponding to a given percentile. When the data set is large
(100 or more), these methods yield better results. Examples 3-30 and 3-31 show these
methods.

Percentile Formula

The percentile corresponding to a given value X is computed by using the following formula:

(number of values below X) + 0.5

Percentile = total number of values - 100

EXAMPLE 3-30 Test Scores

A teacher gives a 20-point test to 10 students. The scores are shown here. Find the
percentile rank of a score of 12.

18, 15,12, 6,8,2,3,5, 20, 10

Arrange the data in order from lowest to highest.
2,3,5,6,8,10, 12, 15, 18, 20
Then substitute into the formula.

(number of values below X) + 0.5
total number of values

Percentile = 100

Since there are six values below a score of 12, the solution is

6 + 0.5
10

Thus, a student whose score was 12 did better than 65% of the class.

Percentile = - 100 = 65th percentile

Note: One assumes that a score of 12 in Example 3-30, for instance, means theoreti-
cally any value between 11.5 and 12.5.

3-45



154

3-46

Chapter 3 Data Description

EXAMPLE 3-31 Test Scores

Using the data in Example 3-30, find the percentile rank for a score of 6.

SOLUTION

There are three values below 6. Thus,

+ 0.
Percentile = % - 100 = 35th percentile

A student who scored 6 did better than 35% of the class.

The steps for finding a value corresponding to a given percentile are summarized in
this Procedure Table.

Procedure Table

Finding a Data Value Corresponding to a Given Percentile
Step 1 Arrange the data in order from lowest to highest.

Step 2 Substitute into the formula
n-p
100

c =

where n = total number of values
p = percentile

Step 3A  If ¢ is not a whole number, round up to the next whole number. Starting at the
lowest value, count over to the number that corresponds to the rounded-up value.

Step 3B If ¢ is a whole number, use the value halfway between the cth and (¢ + 1)st values
when counting up from the lowest value.

Examples 3-32 and 3-33 show a procedure for finding a value corresponding to a
given percentile.

EXAMPLE 3-32 Test Scores

Using the scores in Example 3-30, find the value corresponding to the 25th percentile.

SOLUTION

Step1  Arrange the data in order from lowest to highest.

2,3,5,6,8,10, 12, 15, 18, 20

Step2 Compute

_np
‘7 100
where n = total number of values
p = percentile
Thus,
10 - 25
=00 2.5
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Step 3  Since c is not a whole number, round it up to the next whole number; in this
case, ¢ = 3. Start at the lowest value and count over to the third value, which
is 5. Hence, the value 5 corresponds to the 25th percentile.

EXAMPLE 3-33
Using the data set in Example 3-30, find the value that corresponds to the 60th percentile.

SOLUTION

Step1  Arrange the data in order from lowest to highest.
2,3,5,6,8,10, 12, 15, 18, 20
Step 2  Substitute in the formula.

n-p:10-60:
100 100

c= 6
Step 3 Since c is a whole number, use the value halfway between the ¢ and ¢ + 1
values when counting up from the lowest value—in this case, the 6th and 7th
values.
2,3,5,6,8,10, 12, 15, 18, 20
7N
6th value Tth value

The value halfway between 10 and 12 is 11. Find it by adding the two values and
dividing by 2.
10 + 12
2

Hence, 11 corresponds to the 60th percentile. Anyone scoring 11 would have
done better than 60% of the class.

11

Quartiles and Deciles

Quartiles divide the distribution into four equal groups, denoted by Q;, Q», Q3.
Note that Q; is the same as the 25th percentile; O, is the same as the 50th percentile,
or the median; Qs corresponds to the 75th percentile, as shown:

Lowest Highest
data MD data
value & @ 05 value

25% 25% 25% 25%

Quartiles can be computed by using the formula given for computing percentiles on
page 153. For Q; use p = 25. For 0, use p = 50. For Q3 use p = 75. However, an easier
method for finding quartiles is found in this Procedure Table.

Procedure Table

Finding Data Values Corresponding to Q4, Qo, and Qs

Step 1 Arrange the data in order from lowest to highest.

Step 2 Find the median of the data values. This is the value for Q,.

Step 3 Find the median of the data values that fall below Q,. This is the value for Q.
Step 4 Find the median of the data values that fall above Q,. This is the value for Q3.
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Example 3-34 shows how to find the values of Q;, Q», and Q5.

EXAMPLE 3-34

Find Q1, Q», and Q5 for the data set 15, 13, 6, 5, 12, 50, 22, 18.

SOLUTION

Step1  Arrange the data in order from lowest to highest.

5,6,12,13, 15,18, 22, 50
Step 2 Find the median (Q,).
5,6,12,13, 15,18, 22,50
T
MD
13+15
5 =
Step 3 Find the median of the data values less than 14.
5,6,12,13
T
0,
6+ 12
1 = 2 -

MD = 14

9

So Q) is 9.
Step 4 Find the median of the data values greater than 14.
15, 18, 22, 50
T

03

18 + 22

Here Q3 is 20. Hence, Q; = 9, O, = 14, and Q3 = 20.

20

In addition to dividing the data set into four groups, quartiles can be used as a rough meas-
ure of variability. This measure of variability which uses quartiles is called the interquar-
tile range and is the range of the middle 50% of the data values.

The interquartile range (IQR) is the difference between the third and first quartiles.
IQR = Q3 — Q4

EXAMPLE 3-35

Find the interquartile range for the data set in Example 3-34.

SOLUTION

First it is necessary to find the values of O and Q3. These values were found in
Example 3-34: O; = 9 and Q3 = 20. Next subtract the value of Q; from Q3 to get the
interquartile range.

IQR=0;—0,=20—-9=11

The interquartile range is equal to 11.



IUnusual Stat

Of the alcoholic
beverages consumed
in the United States,
85% is beer.
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Like the standard deviation, the more variable the data set is, the larger the value of the
interquartile range will be.

Deciles divide the distribution into 10 groups, as shown. They are denoted by Dy,
D, etc.

Lowest Highest
data data

value D D, Dy Dy Ds Dg Dy Dy Dy value

10% 10% 10% 10% 10% 10% 10% 10% 10% 10%

Note that D corresponds to Po; D, corresponds to P; etc. Deciles can be found by using
the formulas given for percentiles. Taken altogether then, these are the relationships
among percentiles, deciles, and quartiles.

Deciles are denoted by Dy, Dy, D3, . . ., Do, and they correspond to
P10, Py, P3, . . ., Poo.

Quartiles are denoted by Q;, 0>, O3 and they correspond to P,s, Psg, P7s.
The median is the same as Psg or Q, or Ds.

The position measures are summarized in Table 3—4.

TABLE 3-4 Summary of Position Measures

Measure Definition Symbol(s)
Standard score Number of standard deviations that a data value is above or below z
or zscore the mean
Percentile Position in hundredths that a data value holds in the P,
distribution
Decile Position in tenths that a data value holds in the distribution D,
Quartile Position in fourths that a data value holds in the distribution Q,
Outliers

A data set should be checked for extremely high or extremely low values. These values
are called outliers.

An outlier is an extremely high or an extremely low data value when compared with
the rest of the data values.

An outlier can strongly affect the mean and standard deviation of a variable. For
example, suppose a researcher mistakenly recorded an extremely high data value. This
value would then make the mean and standard deviation of the variable much larger than
they really were.

Since these measures (mean and standard deviation) are affected by outliers, they are
called nonresistant statistics. The median and interquartile range are less affected by
outliers, so they are called resistant statistics. Sometimes when a distribution is skewed or
contains outliers, the median and interquartile range can be used to more accurately
describe the data than the mean and standard deviation. Outliers can have an effect on
other statistics as well.

There are several ways to check a data set for outliers. One method is shown in this
Procedure Table.
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Procedure Table

Procedure for Identifying Outliers

Step 1 Arrange the data in order from lowest to highest and find Q; and Q5.
Step 2 Find the interquartile range: IQR = Q3 — Q.

Step3  Multiply the IQR by 1.5.

Step4  Subtract the value obtained in step 3 from Q; and add the value obtained in step 3
to Q.

Step 5 Check the data set for any data value that is smaller than Q; — 1.5(IQR)
or larger than Q3 + 1.5(IQR).

This procedure is shown in Example 3-36.

EXAMPLE 3-36 Outliers

Check the following data set for outliers.
5,6,12,13, 15, 18, 22, 50

The data value 50 is extremely suspect. These are the steps in checking for an outlier.

Step1 Find Q; and Q3. This was done in Example 3-34; Q) is 9 and Q3 is 20.
Step 2  Find the interquartile range (IQR), which is Q3 — Q;.
IQR=0;—-0,=20—-9=11
Step 3 Multiply this value by 1.5.
1.5(11) = 16.5

Step4  Subtract the value obtained in step 3 from Qj, and add the value obtained in
step 3 to Q5.

9—-165=-75 and 20 + 16.5 = 36.5

Step 5 Check the data set for any data values that fall outside the interval from —7.5
to 36.5. The value 50 is outside this interval; hence, it can be considered an
outlier.

There are several reasons why outliers may occur. First, the data value may have
resulted from a measurement or observational error. Perhaps the researcher measured the
variable incorrectly. Second, the data value may have resulted from a recording error. That
is, it may have been written or typed incorrectly. Third, the data value may have been
obtained from a subject that is not in the defined population. For example, suppose test
scores were obtained from a seventh-grade class, but a student in that class was actually
in the sixth grade and had special permission to attend the class. This student might have
scored extremely low on that particular exam on that day. Fourth, the data value might be
a legitimate value that occurred by chance (although the probability is extremely small).

There are no hard-and-fast rules on what to do with outliers, nor is there complete
agreement among statisticians on ways to identify them. Obviously, if they occurred as a
result of an error, an attempt should be made to correct the error or else the data value
should be omitted entirely. When they occur naturally by chance, the statistician must
make a decision about whether to include them in the data set.

When a distribution is normal or bell-shaped, data values that are beyond 3 standard
deviations of the mean can be considered suspected outliers.
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== Applying the Concepts 3-3

Determining Dosages

In an attempt to determine necessary dosages of a new drug (HDL) used to control sepsis, assume

you administer varying amounts of HDL to 40 mice. You create four groups and label them low

dosage, moderate dosage, large dosage, and very large dosage. The dosages also vary within each

group. After the mice are injected with the HDL and the sepsis bacteria, the time until the onset of

sepsis is recorded. Your job as a statistician is to effectively communicate the results of the study.
1. Which measures of position could be used to help describe the data results?

2.1f 40% of the mice in the top quartile survived after the injection, how many mice would
that be?

3. What information can be given from using percentiles?
4. What information can be given from using quartiles?

5. What information can be given from using standard scores?

See page 184 for the answers.

1

10.

. What is a z score?

. Define percentile rank.

. What is the difference between a percentage and a
percentile?

. Define quartile.

. What is the relationship between quartiles and
percentiles?

. What is a decile?
. How are deciles related to percentiles?

. To which percentile, quartile, and decile does the
median correspond?

. Vacation Days If the average number of vacation
days for a selection of various countries has a mean
of 29.4 days and a standard deviation of 8.6 days, find
the z scores for the average number of vacation days in
each of these countries.

Canada 26 days
Italy 42 days
United States 13 days

Source: www.infoplease.com

Age of Senators The average age of Senators in the
108th Congress was 59.5 years. If the standard deviation
was 11.5 years, find the z scores corresponding to the

11.

12.

13.

14.

oldest and youngest Senators: Robert C. Byrd (D, WV),
86, and John Sununu (R, NH), 40.

Source: CRS Report for Congress.

Driver’s License Exam Scores The average score on a
state CDL license exam is 76 with a standard deviation
of 5. Find the corresponding z score for each raw score.

a. 79 d. 65
b. 70 e. 77
c. 88

Teacher’s Salary The average teacher’s salary in a
particular state is $54,166. If the standard deviation is
$10,200, find the salaries corresponding to the follow-
ing z scores.

a. 2 d 2.5
b. —1 e. —1.6
c. 0

Which has a better relative position: a score of 75 on a
statistics test with a mean of 60 and a standard deviation
of 10 or a score of 36 on an accounting test with a mean
of 30 and a variance of 16?

College and University Debt A student graduated
from a 4-year college with an outstanding loan of
$9650 where the average debt is $8455 with a standard
deviation of $1865. Another student graduated from a
university with an outstanding loan of $12,360 where
the average of the outstanding loans was $10,326 with
a standard deviation of $2143. Which student had a
higher debt in relationship to his or her peers?
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15. Annual Miles Driven The average miles driven annu- e. 5500 g. 6500
ally per licensed driver in the United States is approxi- £ 7200 h. 8300
mately 14,090 miles. If we assume a fairly mound-
shaped distribution with a standard deviation of 19. Achievement Test Scores The data shown represent
approximately 3500 miles, find the following: the scores on a national achievement test for a group
a. 7z score for 16,000 miles of 10th-grade students. Find the approximate percentile
b, z score for 10,000 miles rank}s1 of these scores by constructing a percentile
c.  Number of miles corresponding to z scores of 1.6, graph.
_0.5’ and 0. a. 220 d 280
b. 245 e. 300
Source: World Almanac 2012.
c. 276
16. Which score indicates the highest relative position?
L= Score Frequency
a. A score of 3.2 on a test with X = 4.6 and
s=15 196.5-217.5 5
b. A score of 630 on a test with X = 800 and 217.5-238.5 17
s =200 238.5-259.5 22
o _ 259.5-280.5 48
c. Ascore of 43 on a test with X = 50 and s = 5 80.5-301.5 ”
301.5-322.5 6
17. Basketball Scores For the same data, find the approximate scores that
a. Shown are all the scores from the second round of correspond to these percentiles.
the NCAA Men’s Basketball Championships 2012. £ 15th i 65th
Rank all of the individual scores, and use this set of .
) . . g 29th J. 80th
data to find the percentile corresponding to each of o A3rd

the following scores: 78, 66, and 59.
72-65 70-64  77-54 78-59 73-49  79-70 20. Airplane Speeds The airborne speeds in miles per hour

65-59 6663 81-66 77-64 68-60 63-64 of 21 planes are shown. Find the approximate values
62-59  79-66  75-70  67-63 58-57 77-58 that correspond to the given percentiles by constructing
79-65 74-59 65-60 58-44 T72-69 65-50 a percentile graph.
58-41 88-68 69-62 75-68 61-54 89-67
71-45 86-84 Class Frequency
Using the same set of data, find the score corresponding 366—386 4
to each percentile value. 387-407 2
b. 90th percentile 408-428 3
c. 80th percentile 429-449 2
: 450-470 1
. h 1
d. 65th percentile 471491 5
18. College Room and Board Costs Room and board 492-512 3
costs for selected schools are summarized in this distri- 513-533 4
bution. Find the approximate cost of room and board 21
corresponding to each of the following percentiles. Source: The World Almanac and Book of Facts.
Costs (in dollars) Frequency a. 9th d. 60th
b. 20th e. 75th
3000.5-4000.5 5 c. 45th
4000.5-5000.5 6 Using the same data, find the approximate percentile
5000.5-6000.5 18 ranks of the following speeds in miles per hour (mph).
6000.5-7000.5 24 £ 380 mph 505 mph
7000.5-8000.5 19 ' P - p
8000.5-9000.5 8 8. 425 mph J. 525 mph
9000.5-10,000.5 5 h. 455 mph
a. 30th percentile 21. Average Weekly Earnings The average weekly
b. 50th percentile earnings in dollars for various industries are listed
¢. 75th percentile below. Find the percentile rank of each value.
d. 90th percentile 804 736 659 489 777 623 597 524 228

Source: World Almanac.
For the same data, what value corresponds to the 40th

Using the same data, find the approximate percentile percentile?
rank of each of the following costs. Source: New York Times Almanac.
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22,

23.

24.

25.

26.

31.

Test Scores Find the percentile rank for each test score
in the data set.

12,28, 35, 42,47, 49, 50
What value corresponds to the 60th percentile?
Hurricane Damage Find the percentile rank for

each value in the data set. The data represent the values
in billions of dollars of the damage of 10 hurricanes.

1.1,1.7,19,2.1,2.2,2.5,3.3,6.2,6.8,20.3

What value corresponds to the 40th percentile?
Source: Insurance Services Office.

Test Scores Find the percentile rank for each test score
in the data set.

5,12, 15, 16, 20, 21
What test score corresponds to the 33rd percentile?
Gasoline Taxes A random selection of state gasoline

taxes per gallon is given below. Find the first and third
quartile values for the data.

16 18 353 25 235 27.1
175 19 295 75 12
Source: World Almanac 2012.

325 16 22

Sheep Population The data show the number of sheep
in the top 12 major sheep-producing states. Find the first
and third quartiles for the data.

Another measure of the average is called the midquar-
tile; it is the numerical value halfway between Q; and
(03, and the formula is

O+ 03
2

Using this formula and other formulas, find Q;, Q», O3,
the midquartile, and the interquartile range for each data set.

a. 5,12, 16,25,32,38
b. 53,62,78,94, 96,99, 103

Midquartile =

GGG  Step by Step

TI-84 Plus
Step by Step

1. Enter data into L1.

2. Press STAT to get the menu.

27.

28.

29.

30.

33.
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Arizona 160,000 New Mexico 120,000
California 610,000 Oregon 225,000
Colorado 375,000 Texas 830,000
Idaho 220,000 Utah 290,000
Montana 255,000 Washington 60,000
Nevada 75,000 Wyoming 375,000

Source: U.S. Department of Agriculture.

Earthquakes Eleven major earthquakes had Richter
magnitudes as shown. Find the first and third quartiles
for the data.

7.0,6.2,7.7,8.0,64,6.2,7.2,54,6.4,6.5,7.2

Police Calls in Schools The number of incidents in
which police were needed for a sample of 9 schools in
Allegheny County is 7, 37, 3, 8, 48, 11, 6, 0, 10. Find
the first and third quartiles for the data.

Check each data set for outliers.

a. 16,18,22,19, 3,21, 17,20

b. 24,32,54,31, 16, 18, 19, 14, 17, 20

c. 321,343,350, 327, 200

Check each data set for outliers.

a. 88,72,97, 84, 86, 85, 100

b. 145,119, 122, 118, 125, 116

c. 14,16,27,18, 13, 19, 36, 15, 20

== Extending the Concepts

32.

An employment evaluation exam has a variance of 250.
Two particular exams with raw scores of 142 and 165
have z scores of —0.5 and 0.955, respectively. Find the
mean of the distribution.

A particular standardized test has scores that have a

mound-shaped distribution with mean equal to 125 and

standard deviation equal to 18. Tom had a raw score of

158, Dick scored at the 98th percentile, and Harry had a

z score of 2.00. Arrange these three students in order of

their scores from lowest to highest. Explain your reasoning.
|

Calculating Descriptive Statistics
To calculate various descriptive statistics:

3. Press — to move cursor to CALC; then press 1 for 1-Var Stats.

4. Press 2nd [L1], then ENTER.

The calculator will display
X sample mean
>x
s

sum of the data values

sum of the squares of the data values
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Sy sample standard deviation
o population standard deviation
n number of data values

minX smallest data value
0 lower quartile
Med  median

03 upper quartile
maxX largest data value

Example TI3-1
Find the various descriptive statistics for the teacher strikes data from Example 3-20: 9, 10,
14,7,8,3
Input Input Output
L1 Lz Lz 1| (1= 'u'ar* Stat= 1-Va- Stats
8 | oo | o =2.5 Th=&
i0 E:-: al mins=3
14 TxE=499 (1=
g 5::-: S.619392214 Med=2.5
h ®*=3. 384857354 Hz=1A
«Lr'u & maxs=14
LitPa= [ | [ |

Following the steps just shown, we obtain these results, as shown on the screen:

The mean is 8.5.

The sum of x is 51.

The sum of x? is 499.

The sample standard deviation S, is 3.619392214.
The population standard deviation o, is 3.304037934.
The sample size n is 6.

The smallest data value is 3.

QpisT.

The median is 8.5.

Qs is 10.

The largest data value is 14.

To calculate the mean and standard deviation from grouped data:

1. Enter the midpoints into L1.

2. Enter the frequencies into L2.

3. Press STAT to get the menu.

4. Use the arrow keys to move the cursor to CALC; then press 1 for 1-Var Stats.
5. Press 2nd [L1], 2nd [L2], then ENTER.

Example TI3-2

Calculate the mean and standard deviation for the data given in Examples 3-3 and 3-22.

Class Frequency Midpoint

5.5-10.5 1 8
10.5-15.5 2 13
15.5-20.5 3 18
20.5-25.5 5 23
25.5-30.5 4 28
30.5-35.5 3 33
35.5-40.5 2 38
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Input Input Output
L1 Lz Lz 1| 1=-Mar Stat=s Li.L||[1-Mar Stats
- 1 | A | =24, 5
1% o = =436
%g E =xe=1331H
i q Sx=8.287337 7
Iz x ax=g2.877r47211
8 & Lr=2
Li{a =2 [ |

The sample mean is 24.5, and the sample standard deviation is 8.287593772.

To graph a percentile graph, follow the procedure for an ogive (Section 2-2), but use the cumula-
tive percent in L2, 100 for ¥Ymax, and the data from Example 3-29.

Input Input Output
L1 Lz Lz z Flotz  Flot:
a7 12 | coeee 0ff
iiz i3 aFel o Bl
127 70 M- HIH |~
14z L 2 P
ic? LT Alistil
ire L Ylistil:z
------ Mark: B «
Lzi?) =
EXCEL Measures of Position

Example XL3-3
Find the z scores for each value of the data from Example 3-36.

5 6 12 13 15 18 22 50

Step by Step

. On an Excel worksheet enter the data in cells A2—-A9. Enter a label for the variable in cell Al.
. Label cell B1 as z score.

. Select cell B2.

. Select the Formulas tab from the toolbar and Insert Function .'{;‘ .

N A W N =

. Select the Statistical category for statistical functions and scroJIFI 1n the function list to
STANDARDIZE and click [OK].
In the STANDARDIZE dialog box:

6. Type A2 for the X value.
7. Type average(A2:A9) for the mean.
8. Type stdev(A2:A9) for the Standard_dev. Then click [OK].

9. Repeat the procedure above for each data value in column A.

Function Arguments i
STANDARDIZE

x A2

Mean average(A2:A%) &
Standard_dev | stdev(A2:A9) = 14.25219281

= -0.3858285
Returns ar ized value from a distribution characterized by a mean and standard deviation,

Standard_dev is the standard deviation of the distribution, a positive number.

Formula result = -0.8358286

Help on this function oK Cancel |
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Example XL3-4

Excel has two built-in functions to find the Percentile Rank corresponding to a value in a set of data.
PERCENTRANK.INC calculates the Percentile Rank corresponding to a data value in the
range O to 1 inclusively.
PERCENTRANK.EXC calculates the Percentile Rank corresponding to a data value in the
range 0 to 1 exclusively.

We will compute Percentile Ranks for the data from Example 3-36, using both
PERCENTRANK.INC and PERCENTRANK.EXC to demonstrate the difference between
the two functions.

5 6 12 13 15 18 22 50
. On an Excel worksheet enter the data in cells A2—-A9. Enter the label Data in cell Al.
. Label cell B1 as Percent Rank INC and cell C1 as Percent Rank EXC.
. Select cell B2.
. Select the Formulas tab from the toolbar and Insert Function ,ﬁﬂ .

Funtion

N A W N -

. Select the Statistical category for statistical functions and scroll in the function list to
PERCENTRANK.INC (PERCENTRANK.EXC) and click [OK].

In the PERCENTRANK.INC (PERCENTRANK.EXC) dialog boxes:

6. Type A2:A9 for the Array.

7. Type A2 for X, then click [OK]. You can leave the Significance box blank unless you
want to change the number of significant digits of the output (the default is 3 significant
digits).

8. Repeat the procedure above for each data value in the set.

The function results for both PERCENTRANK.INC and PERCENTRANK.EXC are shown
below.

Note: Both functions return the Percentile Ranks as a number between 0 and 1. You may convert
these to numbers between 0 and 100 by multiplying each function value by 100.

usme | WM PRgRLESUr  Fommumi Dath  Resdw  View  Aodint 3
';1 & y t:e: . - u_ = o ;- f.mn-n: | § Y z"-luslu.\ -- :- 9( L}&
e - Ay EEEE- 5% ¢ St {*‘ Delete = 3] L
= | HrleeAe EE B @3 = [ElFormat s | 3 Faer- Sefeet -
. Fond ol Rk | b " Editing
5 - o -
pemrpeey = - . T v ) T T 2
1 Data Percent Rank INC Percent Rank EXC
1 s [} oa1
3 8 [ REH] o
4 D 0285 0.333
3 1 0428 LR
& 15 osT 05558
7 18 0714 0.656
8B n ogsy o7
3 1 oAz

10
n
n
13
i1
15
16
17
3
1

n =
W 4k M| Shestl ‘Shastd Sheetd %3 L] S— E
Reagy | |[GHIEN D 100% (- { {#]

Descriptive Statistics in Excel
Example XL3-5
Excel Analysis Tool-Pak Add-in Data Analysis includes an item called Descriptive Statistics
that reports many useful measures for a set of data.
1. Enter the data set shown in cells A1 to A9 of a new worksheet.
12 17 15 16 16 14 18 13 10
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See the Excel Step by Step in Chapter 1 for the instructions on loading the Analysis Tool-Pak
Add-in.

2. Select the Data tab on the toolbar and select Data Analysis.

3. In the Analysis Tools dialog box, scroll to Descriptive Statistics, then click [OK].
4. Type A1:A9 in the Input Range box and check the Grouped by Columns option.
5. Select the Output Range option and type in cell C1.

6. Check the Summary statistics option and click [OK].

MesCrijlive STalierics

Below is the summary output for this data set.

Columnl

Mean 14.55555556
Standard Error 0.85165054-
Median 15
Mode 16

Standard Deviation  2.554951619
Sample Variance 6.527777778

Kurtosis -0.3943866
Skewness -0.51631073
Range 8
Minimum 10
Maximum 18
Sum 131
Count 9
MINITAB Calculate Descriptive Statistics from Data

Example MT3-1

1. Enter the data from Example 3-20 on teacher strikes into C1 of MINITAB. Name the column
Strikes.

2. Select Stat>Basic Statistics>Display Descriptive Statistics.

Step by Step

w

. The cursor will be blinking in the Variables text box. Double-click C1 Strikes.
4. Click [Statistics] to view the statistics that can be calculated with this command.

a) Check the boxes for Mean, Standard deviation, Variance, Coefficient of variation,
Median, Minimum, Maximum, and N honmissing.

Descriptive Statistics - Statistics

¥ Mean I~ Trimmed mean ¥ N nonmissing
[~ SE of mean ™ Sum " N missing
¥ Standard deviation ¥ Minimum I~ Ntotal
¥ Variance ¥ Maximum ™ Cumulative N
~ Coefficient of variation [~ Range ™ Percent
I~ Cumulative percent

I” First quartile [~ Sum of squares
¥ Median [~ Skewness
™ Third quartile ™ Kurtosis
™ Interquartile range I~ MSSD

Help i 0K | Cancel

b) Remove the checks from other options.
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5. Click [OK] twice. The results will be displayed in the session window as shown.

Descriptive Statistics: Strikes
Variable N  Mean StDev  Variance  CoefVar  Minimum Median Maximum
Strikes 6 8.50 3.62 13.10 42.58 3.00 8.50 14.00

Session window results are in text format. A high-resolution graphical window displays the
descriptive statistics, a histogram, and a boxplot.

6. Select Stat>Basic Statistics>Graphical Summary.

7. Double-click C1 Strikes.

8. Click [OK].

Summary for Strikes

Anderyon-Darlieg Normalty Test

Arfgquares o

ealon 0.782

Map B.5000

Sty 36184

— Veriance 131000

ol -\\ Sirwness  0.00000

Krtops 135882

. [ &

Mimsmum 30000

e IR Quartie 6,000

= Hadan 856

Jrd Quartie 10080

[ [ W n 1 iy 40000
3% Confence Irterval for Hen

[ l 4 12.2083
5% Confidence Intervsl for Medisn

4488 125714
85% Confidence Interval for SEDev

95% Confidence Intervals 2390 ST

e
Mesan
4 L] 8 1 7

The graphical summary will be displayed in a separate window as shown.

Calculate Descriptive Statistics from a Frequency Distribution

Multiple menu selections must be used to calculate the statistics from a table. We will use data
given in Example 3-22 on miles run per week.

Enter Midpoints and Frequencies
1. Select File>sNew>New Worksheet to open an empty worksheet.

2. To enter the midpoints into C1, select Calc>Make Patterned Data>Simple Set of
Numbers.

a) Type X to name the column.
b) Type in 8 for the First value, 38 for the Last value, and 5 for Steps.
c) Click [OK].

3. Enter the frequencies in C2. Name the column f.

Calculate Columns for f-X and f-X2
4. Select Calc>Calculator.
a) Type in fX for the variable and f*X in the Expression dialog box. Click [OK].
b) Select Edit>Edit Last Dialog and type in fX2 for the variable and f*X**2 for the expression.
¢) Click [OK]. There are now four columns in the worksheet.

Calculate the Column Sums
5. Select Calc>Column Statistics.
This command stores results in constants, not columns.
Click [OK] after each step.

a) Click the option for Sum; then select C2 f for the Input column, and type n for Store
result in.

b) Select Edit>Edit Last Dialog; then select C3 fX for the column and type sumX for storage.
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n

sumxX

sumx2

Row X
1 8
2 18
3 18
4 23
5 28
6 33
7 38

N WA 01 WN 2
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Calculator | Column Statistics

o e Store result in variable: |£X ila::lic

Exprezszion: i) C Mes

E' o X " Mean " Sun

| " Standard deviation ~ Nta

 Minimum T N

 Maximum T Nm

c) Edit the last dialog box again. This time select £ Range

C4 X2 for the column, then type sumX2 for ETEEE

storage.

. . . st e
To verify the results, navigate to the Project Manager et »

window, then the constants folder of the worksheet. Select
The sums are 20, 490, and 13,310. Help ok |

Calculate the Mean, Variance, and
Standard Deviation

6. Select Calc>Calculator.

a) Type Mean for the variable, then click in the box for the Expression and type sumX/n.
Click [OK]. If you double-click the constants instead of typing them, single quotes will
surround the names. The quotes are not required unless the column name has spaces.

b) Click the EditLast Dialog icon and type Variance for the variable.
¢) In the expression box type in

(sumX2-sumX**2/n)/(n-1)

Calculator

Store resull in variahle: IS

gi gz Expression:

c5 Hean sqrt ((sunk2-suni=*2/n)-(n-1))
Cé Variance

K1 n

K2 suni

K3 sun¥2

Functions.
i i i ] 1 1 -

d) Edit the last dialog box and type S for the variable. In the expression box, drag the mouse
over the previous expression to highlight it.

e) Click the button in the keypad for parentheses. Type SQRT at the beginning
of the line, upper- or lowercase will work. The expression should be
SQRT((sumX2-sumX**2/n)/(n-1)).

f) Click [OK].

Display Results
g) Select Data>Display Data, then highlight all columns and constants in the list.
h) Click [Select] then [OK].

The session window will display all our work! Create the histogram with instructions from

Chapter 2.
20.0000
Histogram of X
490.000 2
13310.0 '
4
X fX2 Mean Variance S
8 64 245 68.6842 8.28759 g 3
26 338
54 972 il
115 2645 4
112 3136
99 3267 - 8 13 1B 23 28 ] 33
76 2888 g
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3-4

Exploratory Data Analysis

OBJECTIVE @

Use the techniques

of exploratory data analysis,
including boxplots and
five-number summaries,

to discover various aspects
of data.

3-60

In traditional statistics, data are organized by using a frequency distribution. From this
distribution various graphs such as the histogram, frequency polygon, and ogive can
be constructed to determine the shape or nature of the distribution. In addition, various
statistics such as the mean and standard deviation can be computed to summarize
the data.

The purpose of traditional analysis is to confirm various conjectures about the nature
of the data. For example, from a carefully designed study, a researcher might want to know
if the proportion of Americans who are exercising today has increased from 10 years ago.
This study would contain various assumptions about the population, various definitions
such as the definition of exercise, and so on.

In exploratory data analysis (EDA), data can be organized using a stem and leaf
plot. (See Chapter 2.) The measure of central tendency used in EDA is the median. The
measure of variation used in EDA is the interquartile range Q3—Q). In EDA the data are
represented graphically using a boxplot (sometimes called a box and whisker plot). The
purpose of exploratory data analysis is to examine data to find out what information can
be discovered about the data, such as the center and the spread. Exploratory data analysis
was developed by John Tukey and presented in his book Exploratory Data Analysis
(Addison-Wesley, 1977).

The Five-Number Summary and Boxplots
A boxplot can be used to graphically represent the data set. These plots involve five
specific values:

1. The lowest value of the data set (i.e., minimum)

2. O
3. The median

4. 03

5. The highest value of the data set (i.e., maximum)

These values are called a five-number summary of the data set.

A boxplot is a graph of a data set obtained by drawing a horizontal line from the
minimum data value to Q1, drawing a horizontal line from Q3 to the maximum data
value, and drawing a box whose vertical sides pass through Q1 and Q3 with a vertical
line inside the box passing through the median or Q».

Procedure Table

Constructing a Boxplot
Step 1 Find the five-number summary for the data.

Step2  Draw a horizontal axis and place the scale on the axis. The scale should start on or
below the minimum data value and end on or above the maximum data value.

Step 3 Locate the lowest data value, Q;, the median, O3, and the highest data value; then
draw a box whose vertical sides go through Q; and Q3 Draw a vertical line
through the median. Finally, draw a line from the minimum data value to the left
side of the box, and draw a line from the maximum data value to the right side of
the box.
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EXAMPLE 3-37 Number of Meteorites Found

The number of meteorites found in 10 states of the United States is 89, 47, 164, 296, 30,
215, 138, 78, 48, 39. Construct a boxplot for the data.

Source: Natural History Museum.

SOLUTION

Step 1

Step 2

Step 3

Find the five-number summary for the data.
Arrange the data in order:

30, 39, 47, 48, 78, 89, 138, 164, 215, 296
Find the median.

30, 39, 47, 48, 78,T89, 138, 164, 215, 296

Median
+
Median = w = 83.5
Find Q.
30, 39, 47, 48, 78

T

01
Find Q3.

89, 138, 16?, 215, 296

03

The minimum data value is 30, and the maximum data value is 296.

Draw a horizontal axis and the scale.

0 100 200 300

Draw the box above the scale using Q; and Q3. Draw a vertical line through
the median, and draw lines from the lowest data value to the box and from
the highest data value to the box. See Figure 3-7.

FIGURE 3-7 Boxplot for Example 3-37

47 83.5 164

30 296

Information Obtained from a Boxplot

1. a.

o SR o

If the median is near the center of the box, the distribution is approximately
symmetric.

. If the median falls to the left of the center of the box, the distribution is positively

skewed.

. If the median falls to the right of the center, the distribution is negatively skewed.

. If the lines are about the same length, the distribution is approximately symmetric.
. If the right line is larger than the left line, the distribution is positively skewed.

. If the left line is larger than the right line, the distribution is negatively skewed.
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The boxplot in Figure 3-7 indicates that the distribution is slightly positively skewed.

If the boxplots for two or more data sets are graphed on the same axis, the distribu-
tions can be compared. To compare the averages, use the location of the medians. To com-
pare the variability, use the interquartile range, i.e., the length of the boxes. Example 3-38
shows this procedure.

EXAMPLE 3-38 Sodium Content of Cheese

A dietitian is interested in comparing the sodium content of real cheese with the sodium
content of a cheese substitute. The data for two random samples are shown. Compare
the distributions, using boxplots.

Real cheese Cheese substitute
310 420 45 40 270 180 250 290
220 240 180 90 130 260 340 310
Source: The Complete Book of Food Counts.
Step 1  Find the five-number summary for each data set. For real cheese
40 45 90 180 220 240 310 420
) ) )
01 MD 03
+ +
1245290267.5 MD=1802220=200
240 + 31
0, = 240+ 310_ oo
2
For cheese substitute
130 180 250 260 270 290 310 340
T 0 )
o] MD 0;
180 + 2 260 + 2
= 180£250 55 yp = 2601270 s
2 2
290 + 31
0, = 90 + 310 — 300
2
FIGURE 3-8 Boxplots for Example 3—-38
Real cheese
67.5 200 275
40 420
& °
Cheese substitute
215 265 300
130 340
e e
(I) 1(I)0 2(I)0 3(I)0 4(30 560
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Step 2 Draw the horizontal axis and the scale.

Step 3 Draw the boxplots. See Figure 3—8. Compare the plots. It is quite apparent
that the distribution for the cheese substitute data has a higher median than
the median for the distribution for the real cheese data. The variation or
spread for the distribution of the real cheese data is larger than the varia-
tion for the distribution of the cheese substitute data.

A modified boxplot can be drawn and used to check for outliers. See Exercise 19 in
Extending the Concepts in this section.

In exploratory data analysis, hinges are used instead of quartiles to construct
boxplots. When the data set consists of an even number of values, hinges are the same as
quartiles. Hinges for a data set with an odd number of values differ somewhat from quar-
tiles. However, since most calculators and computer programs use quartiles, they will be
used in this textbook.

Table 3—5 shows the correspondence between the traditional and the exploratory data
analysis approach.

TABLE 3-5 Traditional versus EDA Techniques

Traditional Exploratory data analysis
Frequency distribution Stem and leaf plot
Histogram Boxplot

Mean Median

Standard deviation Interquartile range

== Applying the Concepts 3-4

The Noisy Workplace

Assume you work for OSHA (Occupational Safety and Health Administration) and have
complaints about noise levels from some of the workers at a state power plant. You charge the
power plant with taking decibel readings at six different areas of the plant at different times of
the day and week. The results of the data collection are listed. Use boxplots to initially explore
the data and make recommendations about which plant areas workers must be provided with
protective ear wear. The safe hearing level is approximately 120 decibels.

Area 1 Area 2 Area 3 Area 4 Area 5 Area 6
30 64 100 25 59 67
12 99 59 15 63 80
35 87 78 30 81 99
65 59 97 20 110 49
24 23 84 61 65 67
59 16 64 56 112 56
68 94 53 34 132 80
57 78 59 22 145 125

100 57 89 24 163 100
61 32 88 21 120 93
32 52 94 32 84 56
45 78 66 52 99 45
92 59 57 14 105 80
56 55 62 10 68 34
44 55 64 33 75 21

See page 184 for the answers.
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172 Chapter 3 Data Description

For Exercises 1-6, identify the five-number summary and 4. 147,243, 156, 632, 543, 303
find the interquartile range.
1. 8,12,32, 6,27, 19, 54 5. 14.6, 19.8, 16.3, 15.5, 18.2
2. 19, 16, 48,22, 7 6.97,46,2.2,3.7,6.2,9.4,3.8

3. 362, 589, 437, 316, 192, 188

For Exercises 7-10, use each boxplot to identify the maximum value, minimum value, median, first quartile, third quartile,
and interquartile range.

7.
e e
3 4 5 6 7 8 9 10 11 12
8.
L —— — e
200 225 250 275 300 325
9.
e e
50 55 60 65 70 75 80 85 90 95 100
10.
e e
1000 2000 3000 4000 5000 6000

11. Earned Run Average Construct a boxplot for the following data and comment on the shape of the distribution
representing the number of games pitched by major league baseball’s earned run average (ERA) leaders for the past
few years.

30 34 29 30 34 29 31 33 34 27 30 27 34 32

Source: World Almanac.

3-64



12. Innings Pitched Construct a boxplot for the following
data which represent the number of innings pitched by
the ERA leaders for the past few years. Comment on
the shape of the distribution.

192 228 186 199 238 217 213 234 264 187
214 115 238 246

Source: World Almanac.

13. Teacher Strikes The number of teacher strikes
over a 13-year period in Pennsylvania is shown.
Construct a boxplot for the data. Is the distribution
symmetric?
20 18 7 13

7 14 5 9

9 9 10 17
15

Source: Pennsylvania School Boards Association.

14. Visitors Who Travel to Foreign Countries Construct
a boxplot for the number (in millions) of visitors who
traveled to a foreign country each year for a random
selection of years. Comment on the skewness of the

distribution.

4.3 0.5
0.4 3.8

0.6
1.3

0.8
0.4

0.5
0.3

15. Protein Contest of Energy Bars The numbers of
grams of protein in a random selection of granola and

protein bars are listed below. Construct a boxplot for

the data.
14 15 11 4 26 10 24
15 12 15 27 8 10 10

Compare your results to a boxplot for the amount of
protein found in single servings of various high-protein
drinks, as shown below.

18 42 40 40
15 20 21 42

15
20

10
34

15

16.

17.

18.
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Size of Dams These data represent the volumes

in cubic yards of the largest dams in the United States
and in South America. Construct a boxplot of the data
for each region and compare the distributions.

United States South America

125,628 311,539
92,000 274,026
78,008 105,944
77,700 102,014
66,500 56,242
62,850 46,563
52,435
50,000

Source: New York Times Almanac.

Graduation Rates The graduation rates of several
large state schools are shown below. Identify the five-
number summary and the interquartile range, and draw
a boxplot.

59.0 64.0 48.0 404 69.0 400 70.0 60.0
770 60.0 77.0 78.0 59.0 85.0

Number of Tornadoes A four-month record for the

number of tornadoes in 2003-2005 is given here.
2005 2004 2003

April 132 125 157

May 123 509 543

June 316 268 292

July 138 124 167

a. Which month had the highest mean number of
tornadoes for this 3-year period?

b. Which year has the highest mean number of
tornadoes for this 4-month period?

c¢. Construct three boxplots and compare the
distributions.

Source: NWS, Storm Prediction Center.

== Extending the Concepts

19. Unhealthy Smog Days A modified boxplot can be
drawn by placing a box around Q; and Qs and then
extending the whiskers to the highest and/or lowest
values within 1.5 times the interquartile range

Extreme
outliers o,

(that is, Q3 — Q1). Mild outliers are values greater than
03 + 1.5(IQR) or less than Q; — 1.5(IQR). Extreme
outliers are values greater than Q3 + 3(IQR) or less than

Q1 — 3QR).

Mild

I outliers |
%,—J

1.5(1QR)

For the data shown here, draw a modified boxplot
and identify any mild or extreme outliers. The data
represent the number of unhealthy smog days for a
specific year for the highest 10 locations.

[<—IQR—>!

Extreme
0y outliers
Mild
I outliers |
1.5(1QR)
97 39 43 66 91
43 54 42 53 39

Source: U.S. Public Interest Research
Group and Clean Air Network.
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174 Chapter 3 Data Description

ERETONGIGLIYA  Step by Step

TI-84 Plus
Step by Step

EXCEL
Step by Step

3-66

Constructing a Boxplot
To draw a boxplot:

1. Enter data into L.

2. Change values in WINDOW menu, if necessary. (Note: Make X,,;, somewhat smaller than the
smallest data value and X;,,x somewhat larger than the largest data value.) Change Yy, to O
and Y. to 1.

. Press [2nd] [STAT PLOT], then 1 for Plot 1.

. Press ENTER to turn on Plot 1.

. Move cursor to Boxplot symbol (fifth graph) on the Type: line, then press ENTER.
. Make sure Xlist is L;.

. Make sure Freq is 1.

. Press GRAPH to display the boxplot.

. Press TRACE followed by <— or — to obtain the values from the five-number summary on
the boxplot.

o 0 NN &N Ut AW

To display two boxplots on the same screen, follow the above steps and use the 2: Plot 2 and L,
symbols.

Example TI3-3

Construct a boxplot for the data values:

33,38, 43, 30, 29, 40, 51, 27, 42, 23, 31

Input Input Output
W IHDOL Flatz  Flats Fi:Li
amin=20 ﬁ off ; El !
AMax=a0 gpel b L i
necl=5 . L1
Ymin=A wlistild
Ymax=1 Freq:l
Y=izl=1
ares=1 Hed=33

Using the TRACE key along with the <— and — keys, we obtain the five-number summary. The
minimum value is 23; Q; is 29; the median is 33; Q3 is 42; the maximum value is 51.

Constructing a Stem and Leaf Plot and a Boxplot
Example XL3-6

Excel does not have procedures to produce stem and leaf plots or boxplots. However, you may
construct these plots by using the MegaStat Add-in available on your CD or from the Online
Learning Center. If you have not installed this add-in, refer to the instructions in the Excel Step
by Step section of Chapter 1.

To obtain a boxplot and stem and leaf plot:

1. Enter the data values 33, 38, 43, 30, 29, 40, 51, 27, 42, 23, 31 into column A of a new Excel
worksheet.

2. Select the Add-Ins tab, then MegaStat from the toolbar.

3. Select Descriptive Statistics from the MegaStat menu.

4. Enter the cell range A1:A11 in the Input range.
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5. Check both Boxplot and Stem and Leaf Plot. Note: You may leave the other output options
unchecked for this example. Click [OK].

‘Descriptive statistice

[ aran by = Topuit e |
Select Defaulls | Sebert e Al o
[ tean ™ sum, sum of sauares, 55% _caxd_|
[ Sample yariance and standard daviati ™ Standard of the mean Hedpt
I Wi, ez, g | I Popudation vesianees sl ol sl devisdion
[ Megdan, quartiles, mods, outhers I—l:urﬂ:lememvdim vl
¥ poxplot I empinical ruls
I~ Dottt (Maxdots: awto. 4] » [ I lolerance nkerval
¥ Stem and Leat Plot ([ Soit stem) 1™ Sewmess, kurtosis, OV
[ Rurs Pl 1 Suggested inlervel wiclth fo fresuecy didrilntion
I Harmal curve goodness of i

The stem and leaf plot and the boxplot are shown below.

S —
leal unit = 1
Frequency Stem Leaf i:l:l
3 2 319 L EHA L U 0 B S T L S T !
4 3 Gias 20 25 30 3 40 45 50 55
3 4 023 i1
TR e ]
1
MINITAB Construct a Boxplot
Step by Step 1. Type in the data 89, 47,164, 296, 30, 215, 138, 78, 48, 39. Label the column Meteorites.

2. Select Stat>EDA>Boxplot.
Note: Choose simple Y if all data is in one column.

3. Double-click Meteorites to select it for the graph variable.

4. Click on [Labels].
a) In the Title 1: of the Title/Footnotes folder, type Number of Meteorites.
b) Press the [Tab] key and type Your Name in the text box for Subtitle 1:.

5. Click [OK] twice. The graph will be displayed in a graph window.

Number of Meteorites Found
Student's Name

250

150+

Mebeorites

100+

Compare Two Distributions Using Boxplots

A sample of real cheese and another sample of a cheese substitute are tested for their sodium
levels in milligrams. The data are used in Section 3—4, Example 3-38 of the text.
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176 Chapter 3 Data Description

Step1 Type the data into C1 and C2 of a Minitab work-
sheet as shown. s | 61 | C2- .
a. Select Stat>EDA>Boxplot then Multiple Y’s Sl SuBsig
and Simple. Graph>Boxplot is an alternative 2 420 180
menu command. 3 45 250
Note: Choose Multiple Y’s when each column 4| 40 290
contains a different variable or group. Choose d | 220 130
Simple if all data are in one column. Choose 6 240 260
Simple with Groups if one column contains all the 3| 180 340
data and a second column identifies the group. 8 90 310
Step 2 Drag the mouse over C1 Real and C2 Substitute, 9

and then click the button for [Select].

Step 3 Click on the button for [Labels]. Then in the Title dialog box type Comparison of
Sodium in Real vs Substitute Cheese and next click [OK].

Step 4 Click the button for [Scale].
a. Click the tab for Gridlines as shown.
b. Check the box for Y major ticks.

Step 5 Click [OK] twice. Hover the mouse over the box to see the details. The quartiles may not
be the same as those calculated in the text. The method varies by technology. The values
will be similar.

Boxplot - Scale B #: Boxplot of Real, Substitute j =10l x|

_ T —— e — e —— L]
Axes and Ticks Gridlines i Reference Lines] Comparison of Sodium in Real vs Substitute Cheese
Show Gridlines For:
: 400 4
™ ¥ minar ticks
3004
I X major ticks
= Variable: Real o
5 5ol Q1 = 56.25
Median = 200
03=2925
IQRange = 236.25
1004 Whiskers to: 40, 420
N=28
—'—J
D_ T T
Real Substitute
n - »

The boxplots show there is greater variation in the sodium levels for the real cheese. The
median level is lower for the real cheese than the median for the sodium in the cheese substitute.
The longer whisker for the real cheese indicates the distribution is skewed right. The sodium
levels for the substitutes are more symmetrical and not as spread out.

The Session window will contain the descriptive statistics for sodium for each cheese type as
shown. The mean amount of sodium for real cheese is 193.1 milligrams compared to 253.8 for
the substitute. Even though the mean is smaller for the real group, the standard deviation is
almost double, indicating greater variation in the sodium levels for the real cheese.

Descriptive Statistics: Sodium

Variable  Group N N* Mean SEMean StDev Minimum Q1 Median Q3  Maximum
Sodium  RealCheese 8 0 193.1 471 133.2 40.0 56.3 200.0 292.5 420.0
Substitute 8 0 253.8 24.3 68.6 130.0 1975 265.0 305.0 340.0

|
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== Summary

 This chapter explains the basic ways to summarize data.
These include measures of central tendency. They are
the mean, median, mode, and midrange. The weighted
mean can also be used. (3—1)

¢ To summarize the variation of data, statisticians use
measures of variation or dispersion. The three most
common measures of variation are the range, variance,
and standard deviation. The coefficient of variation can
be used to compare the variation of two data sets. The
data values are distributed according to Chebyshev’s
theorem or the empirical rule. (3-2)

== Important Terms

* There are several measures of the position of data values
in the set. There are standard scores or z scores, per-
centiles, quartiles, and deciles. Sometimes a data set
contains an extremely high or extremely low data value,
called an outlier. (3-3)

Other methods can be used to describe a data set. These
methods are the five-number summary and boxplots.
These methods are called exploratory data analysis. (3—4)

The techniques explained in Chapter 2 and this chapter
are the basic techniques used in descriptive statistics.

bimodal 116
boxplot 168
Chebyshev’s theorem 140

coefficient of variation 138

mean 112
median 115
midrange 118
modal class 117
mode 116

multimodal 116

data array 115
decile 157
empirical rule 142

exploratory data
analysis (EDA) 168

five-number summary 168

negatively skewed or left-
skewed distribution 122

nonresistant statistic 157

interquartile range (IQR) 156

outlier 157 statistic 111

parameter 111 symmetric

percentﬂe 149 distribution 122

positively skewed or right- unimodal 116

skewed distribution 121 variance 134

quartile 155 weighted mean 120

z score or standard
score 148

range 129
range rule of thumb 139
resistant statistic 157

standard deviation 134

== Important Formulas

Formula for the mean for individual data:

Sample Population
- 22X X
X=— = —

n K N

Formula for the mean for grouped data:

Xv = Ef. Xm
n
Formula for the weighted mean:
- 2wX
X=——
3w

Formula for the midrange:

_ lowest value + highest value

MR 2

Formula for the range:

R = highest value — lowest value

Formula for the variance for population data:

2 _ 3(X — p)?
N

Formula for the variance for sample data (shortcut formula
for the unbiased estimator):

g

2 _ n(ZX?) - (3X)*
a n(n — 1)
Formula for the variance for grouped data:

o nEf-Xp) = (3f - X,)°

n(n —1)
Formula for the standard deviation for population data:
\/ (X - p)?
7= N
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Formula for the standard deviation for sample data
(shortcut formula):

=  [nCEX?) - (3X)
nn —1)

Formula for the standard deviation for grouped data:

o \/n(Ef- Xz) = (3f - X,
n(n — 1)

Formula for the coefficient of variation:

g

CVar=—-100 or CVar=2-100
X n

Range rule of thumb:

__ range

4

Expression for Chebyshev’s theorem: The proportion of
values from a data set that will fall within k standard
deviations of the mean will be at least
1
1=
where k is a number greater than 1.

Formula for the z score (standard score):
Sample

X-X
z:

Population

or =
N g

Formula for the cumulative percentage:

cumulative

frequency

Cumulative % = - 100

n
Formula for the percentile rank of a value X:

number of values

low X + 0.
Percentile = —be ow 0.5 - 100
total number

of values

Formula for finding a value corresponding to a given
percentile:

_n-'p
~ 100

Formula for interquartile range:

IQR =03 - 01

= Review Exercises

Section 3-1

1. Net Worth of Wealthy People The net worth (in
billions of dollars) of a sample of the richest people in
the United States is shown. Find the mean, median,
mode, and midrange for the data.

59 52 28 26 19
19 18 17 17 17

Source: Forbes magazine.
2. Shark Attacks The number of shark attacks and deaths

over a recent 5-year period is shown. Find the mean,
median, mode, and midrange for the data.

Attacks 71 64 61 65 57
Deaths 1 4 4 7 4

3. Battery Lives Twelve batteries were tested to see how
many hours they would last. The frequency distribution
is shown here.

Hours Frequency

1-3 1

4-6 4

7-9 5
10-12 1
13-15 1

Find the mean and modal class.

4. SAT Scores The mean SAT math scores for selected
states are represented. Find the mean class and modal
class.

3-70

Score

478-504
505-531
532-558
559-585
586-612

Source: World Almanac.

Frequency

NI NS (S Be I S

5. Households of Four Television Networks A
survey showed the number of viewers and number
of households of four television networks. Find the
average number of viewers, using the weighted
mean.

Households 1.4 0.8 0.3 1.6
Viewers (in millions) 1.6 0.8 0.4 1.8

Source: Nielsen Media Research.

6. Investment Earnings An investor calculated these
percentages of each of three stock investments with
payoffs as shown. Find the average payoff. Use the
weighted mean.

Stock Percent Payoff
A 30 $10,000
B 50 3,000
C 20 1,000



Section 3-2

7.

10.

11.

12.

13.

14.

Tornado Occurrences The data show the number

of tornados recorded for each month of a specific year.
Find the range, variance, and standard deviation for
the data.

33 10 62
26 138

Source: Storm Prediction Center.

132 123 316 123 133 18 150

. Tallest Buildings The number of stories in the 13 tallest

buildings in Houston are shown. Find the range, variance,
and standard deviation for the data.

75 71 64 56 53 55 47 55 52 50 50
50 47

Source: World Almanac.

. Rise in Tides Shown here is a frequency distribution

for the rise in tides at 30 selected locations in the United
States. Find the variance and standard deviation for the
data.

Rise in tides (inches) Frequency
12.5-27.5 6
27.5-42.5 3
42.5-57.5 5
57.5-72.5 8
72.5-87.5 6
87.5-102.5 2

Fuel Capacity The fuel capacity in gallons for
randomly selected cars is shown here. Find the variance
and standard deviation for the data.

Class Frequency
10-12 6
13-15 4
16-18 14
19-21 15
22-24 8
25-27 2
28-30 1

50

If the range of a data set is 24, find the approximate value
of the standard deviation, using the range rule of thumb.

If the range of a data set is 56, find the approximate
value of the standard deviation, using the range rule of
thumb.

Textbooks in Professors’ Offices If the average
number of textbooks in professors’ offices is 16, the
standard deviation is 5, and the average age of the
professors is 43, with a standard deviation of 8, which
data set is more variable?

Magazines in Bookstores A survey of bookstores
showed that the average number of magazines carried is
56, with a standard deviation of 12. The same survey
showed that the average length of time each store had
been in business was 6 years, with a standard deviation

15.

16.

17.

18.

19.

20.

21.

179

Review Exercises

of 2.5 years. Which is more variable, the number of
magazines or the number of years?

Cost of Car Rentals A survey of car rental agencies
shows that the average cost of a car rental is $0.32 per
mile. The standard deviation is $0.03. Using
Chebyshev’s theorem, find the range in which at least
75% of the data values will fall.

Average Earnings of Workers The average earnings
of year-round full-time workers 25-34 years old with a
bachelor’s degree or higher were $58,500 in 2003. If the
standard deviation is $11,200, what can you say about
the percentage of these workers who earn.

a. Between $47,300 and $69,700?

b. More than $80,900?

c. How likely is it that someone earns more than
$100,000?

Source: New York Times Almanac.

Labor Charges The average labor charge for
automobile mechanics is $54 per hour. The standard
deviation is $4. Find the minimum percentage of data
values that will fall within the range of $48 to $60. Use
Chebyshev’s theorem.

Costs to Train Employees For a certain type of job, it
costs a company an average of $231 to train an employee
to perform the task. The standard deviation is $5.

Find the minimum percentage of data values that will
fall in the range of $219 to $243. Use Chebyshev’s
theorem.

Commuter Times The mean of the times it takes a
commuter to get to work in Baltimore is 29.7 minutes.
If the standard deviation is 6 minutes, within what
limits would you expect approximately 68% of the
times to fall? Assume the distribution is approximately
bell-shaped.

Exam Completion Time The mean time it takes a
group of students to complete a statistics final exam is
44 minutes, and the standard deviation is 9 minutes.
Within what limits would you expect approximately
95% of the students to complete the exam? Assume the
variable is approximately normally distributed.

High Temperatures The reported high temperatures of
23 cities of the United States in October are shown.
Find the z values for

a. A temperature of 80°
b. A temperature of 56°

62 72 66 79 83 61 62 8 72 64 74 71
42 38 91 66 77 90 74 63 64 68 42
Section 3-3

22. Exam Grades Which of these exam grades has a better

relative position? -
a. A grade of 82 on a test withX =85 and s = 6

b. A grade of 56 on a test withX = 60 and s = 5

3-71




180 Chapter 3 Data Description

23. NFL Salaries The salaries (in millions of dollars) for a. Construct a percentile graph.
29 NFL teams for the 1999-2000 season are given in b. Find the 20th, 50th, and 70th percentiles.
this frequency distribution. c. Find the percentile values of 5, 10, and 14.
Class limits Frequency 25. Check each data set for outliers.
39.9-42.8 2 a. 506,511,517, 514, 400, 521
42.9-45.8 2 b. 3,7,9,6,8, 10, 14, 16, 20, 12
45.9-48.8 5

48.9-51.8 26. Check each data set for outliers.

5
51.9-54.8 12 a. 14,18,27,26,19,13,5,25
54.9-57.8 3 b. 112,157,192, 116, 153, 129, 131

Source: www.NFL.com

) Section 3-4
a. Construct a percentile graph.

b. Find the values that correspond to the 35th, 65th, and 27. Top Movie Sites The number of sites at which the top
85th percentiles. nine movies (based on the daily gross earnings) opened
¢. Find the percentile of values 44, 48, and 54. in a particular week is indicated below.

3017 3687 2525
2516 2820 2579

24. Printer Repairs The frequency distribution shows the
3211 3044 2330

number of days it took to fix each of 80 computer’s

printers. Construct a boxplot for the data.
Class limits Frequency 28. Hours Worked The data shown here represent the
1-3 7 number of hours that 12 part-time employees at a toy
4-6 9 store worked during the weeks before and after
7-9 32